
IDEAS® Image Data Exploration and

Analysis Software User's Manual

   

Technical Support

Telephone: 512-381-4397

North America Toll Free: 1-877-785-2323

International Toll Free: + 800-2939-4959

Email: support@luminexcorp.com

www.luminexcorp.com

 Luminex Corporation

645 Elliott Ave W

Seattle, WA 98119

U.S.A.



Table of Contents

Chapter 1: Introduction 1

Welcome to IDEAS® 6.2 1

What's New in IDEAS® 6.2 2

Setting Up the IDEAS® Application 3

Chapter 2: Overview of IDEAS® 9

Overview of the IDEAS® Application 9

Comparing the FlowSight® basic, Quantitative Imaging and ImageStream® data files 10

Understanding the Data Analysis Workflow 10

Overview of the Data File Types 12

Chapter 3: Getting Started with IDEAS® 15

Getting Started with the IDEAS® Application 15

Guided Analysis 16

Building Blocks 36

Advanced Analysis 39

Opening Data Files 39

Saving Data Files 44

Overview of Compensation 45

Merging Data Files 57

Creating New Data Files 58

Viewing Sample Information 59

Batch Processing 60

Overview of the Data Analysis Tools 64

Using the Image Gallery 65

Overview of the Mask Manager 74

Overview of the Analysis Area 83

Using the Feature Manager 102

Using the Population Manager 112

Creating Tagged Populations 115

Using the Region Manager 117

ii



Creating Reports and Exporting Data 118

Reporting Images and Graphs 128

Reporting Statistics 132

Exporting Data 136

Creating TIFs From Population for Export 138

Printing Data 139

Chapter 4: Features and Masks 141

Understanding the IDEAS® Features and Masks 141

Overview of the IDEAS® Features and Masks 142

Understanding the Size Features 157

Understanding the Location Features 164

Understanding the Shape Features 173

Understanding the Texture Features 180

Understanding the Signal Strength Features 197

Understanding the Comparison Features 207

Understanding the System Features 212

About Masks 213

iii



Chapter 1: Introduction

Welcome to IDEAS® 6.2

Welcome to the IDEAS® version 6.2 application documentation for ImageStream® and FlowSight® data analysis.

How to use this manual

This manual provides instruction for using the Amnis® IDEAS® application to analyze data files from the Amnis 

ImageStream® and FlowSight® cell analysis systems.

The intuitive user interface of the IDEAS application makes it easy for you to explore and analyze data. The application 

can quantify cellular activity by performing statistical analyses on thousands of events and, at the same time, permit 

visual confirmation of any individual event. Furthermore, you can operate the application in a batch processing mode and 

store specific analysis templates for either repeated use or sharing with colleagues. 
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The fastest way to put the IDEAS application to work is to first skim through this manual—becoming familiar with the 

application’s structure, compensation, file types, and analysis tools—and then use the application wizards on some 

sample experimental data to begin exploring the power that the application provides. This manual has been integrated 

into the IDEAS application to provide searchable and context sensitive help. Typing F1 while in the application opens the 

help files.

What's New in IDEAS® 6.2

IDEAS® 6.2 offers numerous improvements for analyzing data from anyImageStream® or FlowSight® instrument. Please 

refer to the web site for the latest improvements and updates to this manual.

Feature values in IDEAS are now being saved in binary format to reduce the file size and facilitate faster analysis. There-

fore, daf files generated using IDEAS 6.2 cannot be opened using previous versions. The .daf files created by previous 

versions of IDEAS may be opened by IDEAS 6.2.  However, if the  files are edited and saved, they will no longer be able to 

be opened by previous versions.

Workflow Enhancements

 l Statistics reports can now be viewed in IDEAS®.

 l The ability to segment .rif files is now available in both single file load and batch mode.

 l Acquisition analysis can be carried into IDEAS: Analysis performed on the instrument (feature defin-

itions/regions/populations and analysis area plots) can now be carried over to IDEAS. This means that the 

user can now choose to use the acquisition analysis as a custom default template for every .rif file.

 l Region definitions in a template now have the property that can be set to preserve regions in .daf files. This 

means that when a template with a region thus defined is applied to a daf file, the region co-ordinates will be 

taken from the existing ones in the daf and not from the template when the new daf is created. If no region 

with the same name exists in the daf file, the template definition will be applied. See the section 'Using the 

region manager' in chapter 3 for more information.

 l Processed batches can be selected for re-processing. This is especially useful when the batches contain many 

files from different folders. 

 l Daf file batching now allows for updating existing dafs with additional features/masks as well as modifications 

to the analysis area. In the event that the template contains features that are not already present in the daf, 

only these features are computed. Previously, new feature creation only occurred from the cif to daf pro-

cessing.

 l Acquisition analysis performed during acquisition may now be used when opening a .rif file in IDEAS both indi-

vidually and during batching. This allows the carry-over of the graphs, regions, and populations set up in 

INSPIRE™ for analysis in IDEAS.

Masks and Features

 l There are four new masks: LevelSet, AdaptiveErode, Watershed and Component.

 l The Spot Mask was modified to take a lower radius value for the tophat operation.

 l The Object mask was modified to not mask pixels outside of the main object.

 l The Spot Count feature has a new parameter that is used to determine if spots are connected. This is helpful 

for spots that are on the diagonal. See the Spot Count feature definition in chapter 4 for more information. 
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Reporting

 l In version 6.2 and later additional information has been added to the printed report to assist users in tracking 

changes that may have been made in the files. This includes file names, laser information, compensation mat-

rix and region coordinates.

Setting Up the IDEAS® Application

This chapter describes the hardware and software requirements for the application, which includes the procedures for 

installing, removing, and upgrading the application. 

Hardware and Software Requirements

This section states the minimum and the recommended hardware and software requirements for running the IDEAS® 

application.

Hardware Requirements

The minimum hardware requirements are 4 GB of RAM and a dual core Intel processor. However, due to the large size 

of the image files that the ImageStream® cell analysis system creates, a larger amount of RAM will prevent paging and 

thus increase performance.

Software Requirements

IDEAS® 6.2 64 bit version requires that the Windows® 7 or 8 operating system be installed on your computer. IDEAS 32 

bit version requires Windows XP, Windows 2000 or later version of the operating system. The latest service pack and 

any critical updates for the operating system must be included. You must also install the Microsoft® .NET Framework 2.0, 

which requires Microsoft Internet Explorer 5.01 or later.

NOTE: If the software requirements are not met, Setup will not block installation nor provide any warnings. 

NOTE: Service packs and critical updates are available from the Microsoft Security Web Site.

Installing the IDEAS® Application

If the IDEAS® application has previously been installed, the previous version will be removed during installation.

To install IDEAS software:

1.   Download the application Setup file from your account at www.luminexcorp.com.

2.    View the contents in My Computer or Windows® Explorer.

3.    Double-click Setup.exe.

4.    Follow the instructions until the installation process has completed.

5.    MadCap help viewer is installed and opened during installation or upgrade.

6.    Select the language and check box to not show this dialog again.

7.    An icon appears on the desktop and IDEAS Application appears on the All Programs menu.
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Setting Your Computer to Run the IDEAS® Application

Setting the Screen Resolution

Confirm that the screen resolution is adequate for the IDEAS® application. To be able to view the entire application win-

dow, you must set the width of the screen resolution to a minimum of 1024 pixels.

To set the screen resolution:

1.   From the Start menu, select Control Panel, and then click Display.

2.    Click the Settings tab to set the screen resolution.

Viewing File Name Extensions

When loading a file, the IDEAS® application uses the file name extension to determine the file type. It will be easier for 

you to distinguish raw image files, compensated image files, and data analysis files from each other if Windows Explorer 

does not hide the extensions.

To view file name extensions:

1.   In Windows® Explorer, go to Tools > Folder Options.

2.    Click the View tab, and make sure that the Hide extensions for known file types check box is not selected.

3.    Click OK.

Copying the Example Data Files

Copy data files to a single directory on your hard drive. Sample data files are available on your workstation or at www.lu-

minexcorp.com for customers with an  account.

To copy the example data files:

1.   Copy the data files.

2.    Right-click the directory that contains the data files, and click Properties.

3.    Clear the Read-only check box.

4.    Click OK.
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Viewing and Changing the Application Defaults

1.   To view or change these defaults, choose Application Defaults from the Options menu. Each tab allows you to view 

or change the default settings.

 l The Directories tab contains the default Data, Template, Batch or Compensation Matrix file directories.
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 l The Populations tab contains the default color or symbol for populations. To change the default settings, click 

on the color to or choose a default symbol from the list. 

 l The Masks tab contains the default mask color. To change the color of the mask click on the color button.

 l The Graph Display tab contains the default settings for graphs in the analysis area including graph size, font 

sizes and the default list of statistics shown for a graph. Check the box next to the statistic to have it show 

below the graphs when statistics are shown for a graph.  The settings may be updated on all or selected graphs 

in the analysis area.
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 l The Graph Export tab contains the default settings  for exporting graphs including the graph size, font size, 

options to include legend, cursor sample name and statistics. Select the Defaults button to use the graph 

export settings when exporting graphs or select the Graph button to use the settings as they appear in the ana-

lysis area for the graph.
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 l The Image Export tab contains the default settings  for image export when copying and pasting from IDEAS® 

for reporting into other programs.

 l The Colors tab contains the mapping of dark and light mode colors.
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Chapter 2: Overview of IDEAS® 

Overview of the IDEAS® Application

This chapter provides an overview of the IDEAS® application user interface, the files that the IDEAS application creates 

and uses, the recommended directory organization and an overview of the workflow.

 l For more information, see Understanding the Data Analysis Workflow.

Overview of Compensation, Analysis Tools, and File Structure

The Amnis® cell analysis systems possess unique capabilities that neither flow cytometry nor microscopy alone can 

deliver. The IDEAS® application provides an image gallery to view every cell in the data file along with linked graphical 

data for confident gating and image confirmation. The application contains powerful algorithms that facilitate and 

quantify the image analysis of ImageStream® and FlowSight® QI data. Examples include the analysis of molecule co-loc-

alization and translocation, the analysis of cell-to-cell contact regions and signaling interactions, the detection of rare 

molecules and cells, and a comprehensive classification of large numbers of cells. The IDEAS application acquires data 

from INSPIRE™, compensates the images, and allows the user to evaluate images with data analysis tools. For more 

information, see Comparing the FlowSight® basic, Quantitative Imaging and ImageStream® data files..
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NOTE: Feature values in IDEAS 6.2 and later versions are now being saved in binary format to reduce the file size 

and facilitate faster analysis. Therefore, daf files generated using IDEAS 6.2 cannot be opened using previous ver-

sions. The .daf files created by previous versions of IDEAS may be opened by IDEAS 6.2.  However, if the  files are 

edited and saved, they will no longer be able to be opened by previous versions.

Comparing the FlowSight® basic, Quantitative Imaging 

and ImageStream® data files

There are three types of instruments that collect data for Image Analysis in IDEAS®: The FlowSight® without Quantitative 

Imaging (QI), The FlowSight with the QI upgrade and the ImageStream®. There are some differences in the available 

features and analysis that can be done. The table below outlines these differences.

Table 1. Data Comparison

  FlowSight® - basic FlowSight® - QI ImageStream®

Default template
INSPIRE™ features and acquis-

ition analysis

IDEAS® default feature set - 

analysis

IDEAS® default feature set - 

no analysis

Default compensation 

matrix
INSPIRE™ matrix No compensation No compensation

New feature cal-

culation
Combined features only Unlimited Unlimited

User defined masks No Yes Yes

Default mask
INSPIRE™ mask calculated during 

acquisition

Default (Object) mask com-

puted in IDEAS®

Default (Object) mask com-

puted in IDEAS®

Wizards
Open File, Display Properties and 

Begin Analysis 
Complete set Complete set 

Building blocks All All All

Merging files No Yes Yes

Compensation Intensity and Images only All features and Images All features and Images

Create new files from 

populations
No Yes Yes

Understanding the Data Analysis Workflow

Data analysis in IDEAS® begins with opening a raw image file (.rif) that was collected and saved using INSPIRE™. Then, 

an existing compensation matrix or a new compensation matrix is applied to the .rif file and two additional files are cre-

ated, the .cif (compensated image file) and .daf (data analysis file).
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A compensation matrix performs fluorescence compensation, which removes fluorescence that leaks into other chan-

nels. For more information, see Overview of Compensation. A compensated image can accurately depict the correct amount 

of fluorescence in each cell image. Compensation is defined as the correction of the fluorescence crosstalk. When cre-

ating the .cif the IDEAS application also automatically performs corrections to the raw imagery using values saved from 

the instrument at the time of data collection. These corrections include flowspeed normalization, brightfield gains, and 

spatial registry.

A template is used to define the features, graphs, image display properties and analysis for the .daf.  Within the .daf file, 

the user can perform many analyses using the tools and wizards within the application and save the results as a tem-

plate file (.ast). 

The IDEAS application then calculates feature values and shows the data as specified by the selected template. 

Once a data analysis file (.daf file) or compensated image file (.cif file) is saved, it can be opened directly for data ana-

lysis. You would only open a .cif if you wanted to change the template or a .rif file to change the compensation. 

The diagram on the next page displays this workflow. 
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Overview of Data Analysis Workflow

 l Create a compensation matrix using the single color control files. Open an experimental .rif file or from the 

Compensation menu choose Create New Matrix.

 l A .cif and .daf file are automatically created. Analyze the experimental file using data analysis tools in the .daf 

file to create an analysis template. 

 l Create a statistics report table within the .daf file and save the data file, as an analysis template. 

NOTE: This is usually done on the positive and negative controls to create the appropriate analysis and then 

applied to the rest of the experimental files in the next step.

 l Perform batch processing, applying compensation and template files created above.

Overview of the Data File Types

Data from the Amnis® cell analysis systems are collected and managed using three types of data files: raw image file 

(.rif), compensated image file (.cif), and data analysis file (.daf).

This section describes each file type and the table summarizes the features of each file. 

Raw Image File (.rif)

The INSPIRE™ application saves the digital image data, pixel intensities and location that were acquired by the instru-

ment to a .rif file. 

A .rif file contains:

 l Pixel intensity data (counts and location)  collected for each object that the instrument detected.

 l Instrument settings that were used for data collection.

 l Calibration values from ASSIST.

 l Compensation matrix if used while acquiring  data.

Compensated Image File (.cif)

The IDEAS® application creates a .cif file when the user opens a .rif file and applies a compensation matrix. The seg-

mentation algorithm automatically defines the boundaries of each object, creating a mask that is used for calculating fea-

ture values. The applied compensation matrix performs pixel-by-pixel fluorescence compensation prior to segmentation. 

During the creation of the .cif file, the application makes corrections to the imagery. These corrections include:

 l Removal of artifacts from variability in the flow speed, camera background, and brightfield gains. 

 l Alignment of the objects to sub-pixel accuracy, which allows the viewing of compensated imagery, composite 

imagery and the calculation of multi-image feature values, such as the Internalization value.

 l Coincident objects are cut apart to place into individual image frames. Note that this will increase the number 

of objects in the file.

Multiple .cif files can be created from a single .rif file by applying a different fluorescence compensation matrix or cor-

rection each time a .rif file is opened and choosing a unique name for the .cif file. Similarly, you can create a new .daf file 

from a single .cif file by creating a new name and applying a different analysis template. 
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Data Analysis File (.daf)

The IDEAS® application creates a .daf file while it is loading a .cif file into a template file (.ast). The .daf file is the inter-

face to visualize and analyze the imagery that the .cif file contains and must reside in the same directory as the cor-

responding .cif file. 

The .daf file contains:

 l Feature definitions

 l Population definitions 

 l Calculated feature values 

 l Image display settings 

 l Definitions for graphs and statistics 

 l Feature definitions

 l Population definitions 

 l Calculated feature values 

 l Image display settings 

 l Definitions for graphs and statistics 

Loading a .daf file restores the application to the same state it was in when the file was saved, i.e., with the same views, 

graphs, and populations. In IDEAS versions 3.0 or later, a .daf file may be used as a template. 

NOTE: When a .daf file is opened, the .cif file must be located in the same directory as the .daf file since the .daf file 

points to images used for analysis that are stored in the associated .cif file.

Template (.ast)

The IDEAS® application saves the set of instructions for an analysis session in a .daf file to a template (.ast file). Note 

that a template contains no data; it simply contains the structure for the analysis. This structure includes definitions for:

 l Features

 l Graphs 

 l Regions

 l Populations 

The .ast also contains settings for:

 l Image viewing

 l Image names

 l Statistics

The \templates subdirectory (under the directory where the IDEAS application was installed) contains the default 

template, named defaulttemplate.ast. Because a template is required for loading a .cif file, you must use the default tem-

plate to create the first .daf file. After you save a custom template, you can use it for any subsequent loads of .cif files.

NOTE: The default template may change between releases of the IDEAS application software. In IDEAS versions 3.0 

or later, a .daf file may be used as a template. The default template contains over 200 calculated features per object. 

An expanded template is also available that includes over 600 calculated features per object. The FlowSight® without 

the Quantitative Imaging upgrade has a limited set of features available. 
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Compensation Matrix File (.ctm)

The IDEAS® application saves the compensation values that are created and saved during the spectral compensation of 

control files to a compensation matrix file (.ctm file). This file has no associated object data; it is created and saved to be 

applied to experimental files. The compensation matrix can be created inIDEAS using single color control files after 

acquisition or during acquisition. See the INSPIRE™ or FlowSight® manual for more information.

Review of Data File Types

Table 2. Review of Data File Types

File 

Acronym 

and Name                     

File Creation                     Description

.rif 

Raw Image 

File

Created in INSPIRE™

Contains instrument setup data, pixel intensity data, and uncorrected image 

data from the INSPIRE™ application. The IDEAS® application uses the .rif file to 

create a compensated image file (.cif file).

.cif

Compensated 

Image File

User creates a .cif from 

the .rif and .ctm

Contains imagery that has been corrected for variations in the camera back-

ground, camera gains, flow speed, and vertical and horizontal positioning 

between channels.

Serves as a database of images used for feature-value calculations and 

imagery display. 

The IDEAS® application also performs fluorescence compensation, if neces-

sary, when creating a .cif file. 

The IDEAS® application loads the .cif file into a template to create a data ana-

lysis file (.daf file)

.daf

Data Analysis 

File

References the .cif
The main working data file that contains the calculated feature values, the 

graphs, and the statistics used for analysis. The .daf file references the .cif. 

.ast

Template File

Created from the .daf

This file contains no data; it contains the structure for the analysis, such as, 

definitions for features, graphs, regions, and populations; image viewing set-

tings; image names; and statistics settings.

.ctm

Compensation 

Matrix File

User creates new .ctm 

when opening a .rif or 

during acquisition

Contains compensation values that are created and saved during the spectral 

compensation of control .rif files. This file has no associated object data; it is 

created and saved to be applied to experimental .rif files.

Note about Case Sensitivity: Even though Windows® does not treat file names as case sensitive, the IDEAS® application 

depends on the case-sensitive .rif, .cif, and .daf file name extensions to identify the file types. Avoid the use of illegal char-

acters for file names such as: “\/:*?<>!”.
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Chapter 3: Getting Started with IDEAS®

Getting Started with the IDEAS® Application

This chapter is divided into two sections.  First, guided analysis is described using the analysis wizards and second, 

advanced analysis with more detailed instructions  that describe how to open, compensate, merge, save, and create data 

files without using the wizards.  Building blocks are also discussed which provide a short cut method to building com-

monly used graphs.

Guided analysis makes it easy to start analyzing your data. Once you are familiar with the basic analysis available you 

may want to perform more advanced analysis.

Note that data files from FlowSight® without the Quantitative Imaging upgrade have a limited feature set and limited wiz-

ard analysis. 

General Outline of Data Analysis

NOTE: These steps apply to any type of data analysis whether you use a wizard or not.

1.   Open one data file (the + or - control).

2.    Create and save a compensation matrix for the experiment.
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3.    Using an application wizard or the begin analysis wizard:

 l Select focused cells.

 l Select single cells (or conjugates).

 l Select channels for sub-population markers and gate to define sub-populations.

 l Gate on positive cells for the channels you wish to use for morphological analysis.

4.    By using an application wizard evaluate the feature for your analysis and refine as needed. Or follow the feature 

finder wizard to find the feature that separates your populations. Note that if the morphological differences are in 

separate files this may require merging both a  + and - control before beginning step 1.

5.    Refine the analysis and save the template.

6.    Perform batch analysis on all data files in the experiment using the compensation matrix and analysis template.

Guided Analysis

Data analysis always begins with opening a data file. The Start Analysis button will step you through opening a file, set-

ting the image display mapping and choosing an analysis wizard.

Application wizards are available to guide you through an analysis. The wizards can be accessed from the Guided Ana-

lysis menu or the wizard tool  or at the end of the Start Analysis routine.

16

IDEAS® Image Data Exploration and Analysis Software User's Manual



The following wizards are available:

Application Wizards

General:

 l Open File Wizard

 l Guides you through the process of opening a data file and setting image display mapping in the 

image gallery.

 l Display Properties Wizard:

 l Sets image display mapping in the image gallery.

 l Begin Analysis Wizard:

 l Guides you through finding focused, single, positive cells.

 l Feature Finder Wizard:

 l Guides you through finding focused, single, positive cells.positive cells.and exploring features that sep-

arate chosen truth populations.

Application specific:

 l Apoptosis Wizard

 l Guides you through the process of creating the features and graphs for analyzing apoptosis.

 l Cell Cycle - Mitosis Wizard

 l Guides you through the process of creating the features and graphs for analyzing the cell cycle and 

enumerating mitotic events.

 l Co-localization Wizard

 l Guides you through the process of creating the features and graphs for analyzing  the co-localization 

of 2 probes.
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 l Internalization Wizard

 l Guides you through the process of creating the features and graphs for analyzing the internalization 

of a probe.

 l Nuclear Localization Wizard

 l Guides you through the process of creating the features and graphs for analyzing the nuclear loc-

alization of a probe.

 l Shape Change Wizard

 l Guides you through the process of creating the features and graphs for analyzing  the circular shape 

of a cell using a surface stain or brightfield image.

 l Spot Wizard

 l Guides you through the process of creating the mask, feature and graphs for analyzing fluorescently 

labeled spots in images.

The wizard window is organized so that the instructions for each step are written in the left side of the window, the step-

wise progress through the wizard is shown in the list on the right side and there may be tips provided at the bottom of 

the window. Click Next to progress through the wizard or Exit to stop at any time. Some steps are optional and a Skip but-

ton is provided. Follow the instructions in the wizard to complete an analysis. 

Open File Wizard

This wizard will guide you through the opening of a data file and setting the image display mapping. Use this wizard to 

open a file if you are not using one of the application specific wizards.

To begin, double-click on the Start Analysis button: 

1.   Select the data file to open. Click on the folder and navigate to the file you wish to open.

NOTE: You can limit the view to specific file types (.daf, .cif or .rif) by using the drop-down menu ‘Files of type:’ in 

the Select Data File window.

18

IDEAS® Image Data Exploration and Analysis Software User's Manual



A .daf file will open directly without further input, a .cif file will require a template and a .rif file will require a template 

and a compensation matrix. If the template or compensation matrix boxes are left blank, the default template and/or 

matrix will be applied. For more information, see Open File Wizard.

2.    Apply compensation. This step occurs when opening a .rif. Choose a compensation matrix or create one.  Click Next.

3.    Apply analysis template. This step occurs when opening a .rif or .cif. Choose a template file if one exists or leave 

blank to use the default template. Click Next.

4.    Name your files. It is recommended that you keep the default names.

5.    Select a wizard to begin analysis. Select a wizard to begin analysis or manually create your analysis template.

NOTE: Every wizard begins the same with set of graphs for choosing focused, single, positive events. The specific 

application wizards will also create special features and or masks specific to the application.

Display Properties Wizard

This wizard is automatically run when you use the other analysis wizards or the Open File wizard. It is also available to 

run in any open data file from the Guided Analysis menu or from the wizard icon. This wizard will set the image display 

mapping for the channel images you select and create a view of selected images. Brightfield and scatter images will be 

automatically selected.  

To begin, select wizards from the Guided Analysis menu or click the wizard icon in the analysis area toolbar. 
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The Wizards window opens.

Double-click on the Display Properties option and follow the instructions.

The Display Properties adjusts the mapping of the pixel intensities to the display range for optimizing the display and cre-

ates a view that includes the chosen channels. This is for display only and does not effect the pixel values. For more inform-

ation, see Setting the Image Gallery Properties. 

Begin Analysis Wizard

This wizard is available once a data file is open and will guide you through choosing the focused cells, then single cells, 

then choosing subsets of fluorescent positive cells for phenotypic analysis before progressing on to a morphological ana-

lysis.

The wizards selection screen will display once the data file is open. If you have an open data file and want to access this 

wizard, choose Wizards from the Guided Analysis menu or click on the wand tool.

To begin, double-click on Begin Analysis: 

1.   Gate cells in best focus. A histogram of the brightfield channel Gradient RMS values for the 'All' population  has 

been added to the analysis area. Click on the bins in the histogram to view the images in each bin. The cells with bet-

ter focus have higher Gradient RMS, values. Begin your region at the bin after the Gradient RMS value you wish to 

exclude and continue the region to the maximum in the plot. You may choose an already existing population.
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2.    Gate single cells. A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in step one has 

been added to the analysis area. Single cells will have an intermediate Area value and a high Aspect Ratio. Click on 

the dots to view the image associated with that dot. Note that the image is surrounded by a light green line and the 

image next to it in the image gallery is not it's neighbor in the plot. The images are presented in the order defined 

by the drop-down menu above the image gallery.You may choose an already existing population.

3.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot to the analysis area. Click Skip if you do not wish to use this step. Draw 

regions in the scatter plot to identify as many populations as you want. This step will be repeated until you choose 

Skip or Finish. 

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.

Feature Finder Wizard

The feature finder wizard will guide you through the process of choosing a feature for morphological analysis when a 

specific application wizard is not appropriate. This wizard is available once a data file is open and will guide you through 

choosing the focused cells, then single cells, then choosing subsets of fluorescent positive cells for phenotypic analysis 

before progressing on to choosing a feature for morphological analysis.

Open a data file that contains images of both phenotypes you wish to separate.Note that it may be necessary to merge 

two files together if the populations are in separate files. Open the data file using the Start Analysis button or by choos-

ing Wizards from the Guided Analysis menu. The wizards selection screen will appear once the data file is open. If you 

have an open data file and want to access this wizard, choose Wizards from the Guided Analysis menu or click the wand 

icon.

To begin, double-click on Feature Finder:

1.   Gate cells in best focus. A histogram of the brightfield channel Gradient RMS values for the 'All' population  has 

been added to the analysis area. Click on the bins in the histogram to view the images in each bin. The cells with bet-

ter focus have higher Gradient RMS, values. Begin your region at the bin after the Gradient RMS value you wish to 

exclude and continue the region to the maximum in the plot. You may choose an already existing population. Click 

Next.

2.    Gate single cells. A scatter plot of the brightfield Area versus Aspect Ratio for the population chosen in step one has 

been added to the analysis area. Single cells will have an intermediate Area value and a high Aspect Ratio. Click on 

the dots to view the image associated with that dot. Note that the image is surrounded by a light green line and the 

image next to it in the image gallery is not it's neighbor in the plot. The images are presented in the order defined 

by the drop-down menu above the image gallery.You may choose an already existing population.Click Next.

3.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity and include the channel(s) you are going to use for morphological analysis. Click Next to add the scatter 

plot to the analysis area. Click Skip if you do not wish to use this step. Draw regions in the scatter plot to identify as 

many populations as you want. This step will be repeated until you choose Skip or Finish.
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4.    Assign truth populations. Choose two truth populations of cells that represent one morphological phenotype dif-

ference you wish to separate. Use the tagging tool icon to hand-tag images or select pre-existing gated pop-

ulations. Note: If there are more than one phenotypic differences,  repeat the process for each with new truth 

populations.

5.    Select channels and feature categories. Choose the channel and feature category you wish to explore. Multiple 

rows may be entered. The features in the table below will be created and calculated. All of the default features, 

newly created features and user defined features in the chosen categories will be evaluated for their ability to sep-

arate  the truth populations. The three highest ranking features for each category will be saved and available for 

evaluation.

6.    Results. The top ranking features are listed in the table with their category and channel. A Statistics table is added 

to the analysis area that lists the features with the RD Mean for the truth populations. RD is the Fischer's dis-

criminant ratio which is the difference in the means divided by the sum of the standard deviations for the two pop-

ulations. The larger the RD value, the better the separation afforded by the feature. A scatter plot is added to the 

analysis area of the truth populations for the top two features. 

It may be necessary to refine your results. Visually verify the morphology and separation for the features listed. Addi-

tional features may be quickly plotted by selecting them in the list and clicking 'Plot Features'. To return to the truth pop-

ulation assignment step click 'Refine populations'. To choose different channels or categories click 'Change Category'.

You may also wish to make new masks and features using these masks manually if they are not in the table below. 

Table 3. List of additional features (beyond default) that are created and explored in the Feature Finder wizard 
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Feature 

Category
Feature Name Mask Used

Location
Location Features are in X,Y pixel coordinates from an origin in the upper left 

corner, pixels or contour
 

 

Centroid Features

The distance between the Centroids of the intensity weighted and non-intensity 

weighted image

channel mask

Shape Shape Features define the mask shape and have units that vary with the feature.  

 

Aspect Ratio Feature

The ratio of the Minor Axis divided by the Major Axis.

Object

 

Circularity Feature

The degree of the mask’s deviation from a circle.

Object

  Describes the density of intensities within the object. Object

 

Elongatedness Feature

The ratio of the Height/Width which use the bounding box.

Object

 

Lobe Count Feature

The number of lobes in a cell. (For more information, see Symmetry 2, 3, 4 Features.

Object

 

Shape Ratio Feature

The ratio of Thickness Min/Length features.

Object

 

Symmetry 2, 3, 4 Features

These three features measure the tendency of the object to have a single axis of 

elongation, a three-fold and a four-fold variation of the shapes. See also Lobe Count 

Feature.

Object

Size Size-based Features are in microns.  

 

Height Feature

Based on a bounding rectangle, the Width is the smaller side and the Height is the 

longer side of the rectangle.

 

 

Length Feature

Measures the longest part of the mask.

 

 

Major Axis and Minor Axis Features

Describes the widest part of the mask and the narrowest part of the mask, respect-

ively.

Object
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Feature 

Category
Feature Name Mask Used

 

Perimeter Feature

Describes circumference of the mask.

Object, Threshold 

30,50,70 %

 

Thickness Max Feature

Describes the longest width of the mask.

Object

 

Thickness Min Feature

Describes the shortest width of the mask.

Object

 

Width Feature

Based on a bounding rectangle, the Width is the smaller side and the Height is the 

longer side of the rectangle.

Object

Texture
Texture features measure pixel or regional variation and indicate the granularity or 

complexity of the image. 
 

 

Contrast Feature

Enumerates changes of pixel values in the image to measure the focus quality of an 

image.

Morphology, Object

 

H Texture Features

Measures Haralick texture features. Granularity settings 1,5,15,19

Channel mask

 

Modulation Feature

Measures the intensity range of an image, normalized between 0 and 1.

Morphology, Object

 

Spot Count Feature

Enumerates the number of spots. 

See also Spot Distance Min Feature, Spot Area Min Feature, and Spot Intensity Min 

and Spot Intensity Max Features.

Channel mask

 

Std Dev Feature

Describes the overall distribution of pixel intensities. 

Morphology, Object

Signal 

Strength
Signal Strength Features are measured in pixel values.  

 

Intensity Feature

The sum of the pixel intensities in the mask, background subtracted.

Morphology, Object, 

Threshold 30,50,70 

%
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Featu-

re Cat-

egory

Feature Name Mask Used

Location
Location Features are in X,Y pixel coordinates from an origin in the upper left corner, 

pixels or contour
 

 

Centroid Features

The distance between the Centroids of the intensity weighted and non-intensity 

weighted image

channel mask

Shape Shape Features define the mask shape and have units that vary with the feature.  

 

Aspect Ratio Feature

The ratio of the Minor Axis divided by the Major Axis.

Object

 

Circularity Feature

The degree of the mask’s deviation from a circle.

Object

  Describes the density of intensities within the object. Object

 

Elongatedness Feature

The ratio of the Height/Width which use the bounding box.

Object

 

Lobe Count Feature

The number of lobes in a cell. (For more information, see Symmetry 2, 3, 4 Features.

Object

 

Shape Ratio Feature

The ratio of Thickness Min/Length features.

Object

 

Symmetry 2, 3, 4 Features

These three features measure the tendency of the object to have a single axis of elong-

ation, a three-fold and a four-fold variation of the shapes. See also Lobe Count Feature.

Object

Size Size-based Features are in microns.  

 

Height Feature

Based on a bounding rectangle, the Width is the smaller side and the Height is the 

longer side of the rectangle.

 

 

Length Feature

Measures the longest part of the mask.

 

 

Major Axis and Minor Axis Features

Describes the widest part of the mask and the narrowest part of the mask, respectively.

Object
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Featu-

re Cat-

egory

Feature Name Mask Used

 

Perimeter Feature

Describes circumference of the mask.

Object, Threshold 

30,50,70 %

 

Thickness Max Feature

Describes the longest width of the mask.

Object

 

Thickness Min Feature

Describes the shortest width of the mask.

Object

 

Width Feature

Based on a bounding rectangle, the Width is the smaller side and the Height is the 

longer side of the rectangle.

Object

Texture
Texture features measure pixel or regional variation and indicate the granularity or 

complexity of the image. 
 

 

Contrast Feature

Enumerates changes of pixel values in the image to measure the focus quality of an 

image.

Morphology, Object

 

H Texture Features

Measures Haralick texture features. Granularity settings 1,5,15,19

Channel mask

 

Modulation Feature

Measures the intensity range of an image, normalized between 0 and 1.

Morphology, Object

 

Spot Count Feature

Enumerates the number of spots. 

See also Spot Distance Min Feature, Spot Area Min Feature, and Spot Intensity Min and 

Spot Intensity Max Features.

Channel mask

 

Std Dev Feature

Describes the overall distribution of pixel intensities. 

Morphology, Object

Signal 

Strength
Signal Strength Features are measured in pixel values.  

 

Intensity Feature

The sum of the pixel intensities in the mask, background subtracted.

Morphology, Object, 

Threshold 30,50,70 

%

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.
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Apoptosis Wizard

The apoptosis wizard will guide you through the process of creating the features and graphs to measure apoptosis using 

the images of the nuclear dye and brightfield. Begin by opening a data file and then choosing the Apoptosis wizard.

To begin, double-click on Apoptosis:

1.   Select the nuclear image channel. From the drop-down menu pick the nuclear channel image.

2.    Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.

3.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.

5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

6.    Gate sub-populations. Draw regions in the scatter plot or histogram to identify as many populations as you want. 

This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Optional - Select additional sub-population marker(s) OR. Gate nucleated cells. A histogram of the nuclear channel 

Intensity is added to the analysis area. Gate on the positive events.

27

IDEAS® Image Data Exploration and Analysis Software User's Manual



8.    Gate apoptotic cells. The nucleated cells scatter plot of the brightfield Contrast versus the Area of the thresholded 

nucleus is added to the analysis area. Gate on the apoptotic cells with low nuclear area and high brightfield con-

trast.          

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.

Cell Cycle - Mitosis Wizard

The cell cycle - mitosis wizard will guide you through the process of creating the features and graphs to analyze the cell 

cycle and identify mitotic events using the images of a nuclear dye.

To begin, double-click on Cell Cycle - Mitosis:

1.   Select the nuclear image channel. From the drop-down menu pick the nuclear channel image.

2.    Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.

3.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.
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5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

6.    Gate sub-populations. Draw regions in the scatter plot or histogram to identify as many populations as you want. 

This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Optional - Select additional sub-population marker(s) OR. Gate G2/M cells. A histogram of the nuclear channel 

Intensity is added to the analysis area. Gate on the G2/M population with 2n DNA.

8.    Gate cells with condensed DNA. The G2/M cells scatter plot of the threshold Area  versus Bright Detail Intensity of 

the nuclear image is added to the analysis area. Gate on the cells with condensed nuclear that have low nuclear 

area and high Bright Detail Intensity values These will include apoptotic cells which you can remove in the next step.

9.    Gate mitotic cells. The condensed DNA cells scatter plot of the brightfield Contrast versus the Area of the threshol-

ded nucleus is added to the analysis area. Gate on mitotic events with low brightfield Contrast.

The final 3 plots are shown below:

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.

Co-localization Wizard

The co-localization wizard will guide you through the process of creating the features and graphs to measure the co-loc-

alization of two probes with punctate staining in any population of cells you identify. 
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To begin, double-click on Co-localization:

1.   Select the co-localization image channels. From the drop-down menus pick the two image channels that contain the 

co-localizing probes.

2.    Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.

3.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.

5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

6.    Gate sub-populations. Draw regions in the scatter plot or histogram to identify as many populations as you want. 

This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Gate double positives. A scatter plot of the last gated (or selected) population of the Intensity values for the co-loc-

alization channels is added to the analysis area. Draw a region around the double positive cells for the co-localizing 

probes.

8.    Gate co-localized events. A histogram of Bright Detail Similarity R3 for the double positive population is added to 

the analysis area. Draw a region to gate on co-localized events. 

For more information, see Bright Detail Similarity R3 Feature.

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.
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Internalization Wizard

This wizard will create an analysis template for measuring the internalization of a probe in any population of cells you 

identify. 

To begin, double-click on Internalization:

1.   Step 1. Select the internalization image channels. From the drop-down menus pick the cell image, the channel that 

defines the cell surface, and the internalizing probe channel.

2.    Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.

3.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.

5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

6.    Gate sub-populations. Draw regions in the scatter plot or histogram to identify as many populations as you want. 

This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Next Step. Optional - Select additional sub-population marker(s) OR. Gate internalization positives. A scatter plot of 

Max Pixel versus Intensity for the internalizing probe is added to the analysis area. Draw a region to include the pos-

itive cells.
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8.    Next Step. Gate internalization events. A histogram of the Internalization feature for the positive cells is added to 

the analysis area. Draw a region to include the cells with high internalization. The example below shows the intern-

alization of labeled CpG (red).

For more information, see Internalization Feature..

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.

Nuclear Localization Wizard

This wizard will create an analysis template for measuring the nuclear localization of a probe in any population of cells 

you identify. 

To begin, double-click on Nuclear Localization:

1.   Step 1. Select the translocation image channels. From the drop-down menus pick the nuclear image channel and the 

translocating probe image channel.

2.    Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.
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3.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.

5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

6.    Gate sub-populations. Draw regions in the scatter plot or histogram to identify as many populations as you want. 

This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Next Step. Gate double positives. A scatter plot of the last gated (or selected) population of the Intensity values for 

the nuclear image and the translocating probe image is added to the analysis area. Draw a region around the 

double positive cells.

8.    Next Step. Gate translocated events. A histogram of Similarity of the double positive cells is added to the analysis 

area. Draw a region to include the cells with translocation. Note that for a normally distributed population you may 

want to report the RD of the double positive population in a treated versus untreated sample instead of the per-

centage gated.

Nuclear localization of a probe is measured using the Similarity feature in the final graph presented in the wizard. The 

example shown here is of THP1 cells stimulated with 1 ug LPS for 90 minutes and stained with DRAQ5 (red) and NFkB 

(green) to measure the nuclear localization of the NFkB.

 

For more information, see Similarity Feature.

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.
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Shape Change Wizard

This wizard will create an analysis template for measuring the shape (circularity) of  any population of cells you identify. 

To begin, double-click on Shape Change.

1.   Step 1. Select the cell morphology image channel. From the drop-down menu pick the  channel for the cell image.

2.    Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.

3.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

4.    Optional. Answer Yes if you want to define sub-populations in your experiment.

5.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

6.    Gate sub-populations. Draw regions in the scatter plot or histogram to identify as many populations as you want. 

This step will be repeated until you choose Skip.

NOTE: Step number sequence is dependent on the number of times the sub-population marker step is taken.

7.    Next Step. Gate fluorescence positives. A histogram of the last gated (or selected) population of the Intensity value 

for the cell image is added to the analysis area. Draw a region around the double positive cells. Note that this step is 

skipped if the cell image channel chosen is brightfield.

8.    Next Step. Gate shape-changed events. A histogram of Circularity of the last gated population is added to the ana-

lysis area. Draw a region to include the cells with low circularity scores.
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Shape change is measured in the final graph presented in the wizard. Cells with low circularity scores have a highly vari-

able radius. In this example monocytes in whole blood were stained with CD14 (green). 

For a more thorough explanation of the Circularity feature see Circularity Feature.

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.

Spot Wizard

This wizard will create an analysis template for measuring texture based on spot counting. If the low and high spot count 

data are in separate data files merge the files together before beginning.

To begin, double-click on Spot:

1.   Gate cells in best focus. A Gradient RMS histogram of the All population has been added to the analysis area. Click 

on the bins in the histogram to view the images in each bin. The cells with better focus have higher Gradient RMS, 

values. Begin your region at the bin after the Gradient RMS value you wish to exclude and continue the region to the 

maximum in the plot. You may choose an already existing population.

2.    Gate single cells. A scatter plot of Area versus Aspect Ratio has been added to the analysis area. Single cells will 

have an intermediate Area value and a high Aspect Ratio. Click on the dots to view the image associated with that 

dot. Note that the image is surrounded by a light green line and the image next to it in the image gallery is not it's 

neighbor in the plot. The images are presented in the order defined by the drop-down menu above the image gal-

lery.

3.    Optional. Answer Yes if you want to define sub-populations in your experiment.
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4.    Select sub-population marker(s). Choose one or two channels you wish to use to identify populations based on 

Intensity. Click Next to add the scatter plot or histogram to the analysis area. Click Skip if you do not wish to use this 

step. 

5.    Gate sub-populations step number sequence is dependent on the number of times the sub-population marker step 

is taken. Draw regions in the scatter plot or histogram to identify as many populations as you want. This step will be 

repeated until you choose Skip.

6.    Select the spot image channel. From the drop-down menu choose the image channel for the spot counting.

7.    Assign truth populations. From the drop-down menus select two truth populations, one with high and one with low 

spot count. To create the truth populations, either use the tagging tools or gate the cells of interest.

8.    Gate spot events. A histogram of the Spot Count feature for the last gated population is added to the analysis area. 

Regions have been drawn that include the truth populations. Adjust the regions as necessary. Note that you may 

want to adjust your truth populations and repeat the wizard after looking at the images and validating the spot 

counts.

The statistics Count and Percent Gated are added to the Population Statistics table in the analysis area and a statistics 

definition is added to the template. To view the definition choose Define Statistics Report from the Reports menu.

Building Blocks

Building blocks may be used to create a graph for finding single cells, focused cells or positive cells based on Intensity. 

The building blocks are shortcuts to creating a graph that provide a limited list of relevant features with set X and Y axis 

scales set for the graph. For more information, see Creating Graphs.
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Table 4. Building blocks

Building Block X axis Features Y axis Features

Fluorescence Positives - one 

color

Intensity_MC_ChX 

(for all channels)

 

Fluorescence Positives - two 

color

Intensity_MC_ChX 

(for all channels)

Intensity_MC_ChX 

(for all channels)

Focus

Gradient RMS_MX_ChX 

(for all channels)

Note: Gradient RMS of brightfield is 

default

 

Single Cell

Area_brightfield (default)

Area_scatter

Intensity_MC_ChX 

(for all channels)

Aspect Ratio_brightfield (default)

Aspect Ratio Intensity_MX_ChX (for all fluorescence 

channels)

Intensity_scatter

Single Cell Default Area_brightfield Aspect Ratio_brightfield

Size/SSC Area_brightfield Intensity scatter

To begin, choose Building Blocks from the Guided Analysis Menu or click on the Building Blocks icon in the analysis area 

toolbar. 

The Building Blocks window opens. This window is used to define a graph with a specified set of features available 

depending on the purpose of the graph.

1.   Choose the specific Building Block from the drop-down menu.
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2.    Choose the population(s) to graph.

3.    Choose the X Axis Feature and the Y Axis feature, if applicable.

4.    Click OK.

The graph is added to the analysis area.
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Advanced Analysis

For more information, see Opening Data Files.

For more information, see Saving Data Files.

For more information, see Overview of Compensation.

For more information, see Creating a New Compensation Matrix File.

For more information, see Viewing Sample Information.

For more information, see Merging Data Files.

For more information, see Creating New Data Files From Populations.

For more information, see Batch Processing.

Opening Data Files

Viewing File Name Extensions

When loading a file, the IDEAS® application uses the file name extension to determine the file type. It will be easier for 

you to distinguish raw image files, compensated image files, and data analysis files from each other if Windows Explorer 

does not hide the extensions.

To view file name extensions:

1.   In Windows® Explorer, go to Tools > Folder Options.

2.    Click the View tab, and make sure that the Hide extensions for known file types check box is not selected.

3.    Click OK.

Use the File menu, which is shown in the following figure, to open, save, and close image and analysis files and to quit 

the IDEAS application.  Alternatively, you may open a data file by drag and drop into an open IDEAS window. Multiple 

data files can be open in one instance of the IDEAS application. 

Opening a .rif file

A .rif file is opened when there is new data and the IDEAS® application needs to apply corrections. When opening a .rif 

file, the IDEAS application corrects each image for the spatial alignment between channels, camera background nor-

malization, flow speed, and bright field gain normalization. If you want fluorescence compensation to correct for spectral 

overlap, you must create or choose a compensation matrix at this time by using the control files that were collected for a 

particular experiment. If a FlowSight® data file was acquired with a compensation matrix, that matrix will be used by 

default. For more information on compensation see Creating a New Compensation Matrix File. The application performs the 

corrections by using calibration information that was saved to the .rif file during acquisition. 
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To open a .rif file. To use a wizard to do this see Open File Wizard, otherwise:

1.   From the File menu, choose Open or drag the file into the IDEAS window.

2.    Select the .rif file that you want in the Select File To Load window.

NOTE: While browsing for the file to open you can limit the type of file shown in the window to .rif files.

In the next window you will:

 l Choose or create a compensation matrix.

 l Choose a template.
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3.    If you have already created a compensation matrix for this data then Click the folder next to Select a compensation 

matrix. Note the file types that may contain a compensation matrix. (.ctm, .rif, .cif, .daf) If you leave it blank, the 

default compensation matrix will be used which does not contain any fluorescence corrections. This is not recom-

mended unless you do not want to compensate your data. 

a.   If a compensation matrix for the experiment has not been made, click New Matrix. For more information on cre-

ating a compensation matrix  see Creating a New Compensation Matrix File. 

4.    In the Select a template or data analysis file (.ast, .daf) field, select a template file to load by clicking the folder and 

browsing for the file. If left blank, the Default template with the basic features, masks, and settings will be used. 

Note that FlowSight® basic files use the acquisition template as the default.

5.    Optional: Check the box 'Use acquisition analysis' if you wish to use the acquisition analysis performed on the instru-

ment which includes feature definitions/regions/populations and analysis area plots.

6.    Optional: If you wish to load a subset of objects or change the .cif and .daf file names to be created, Click the 

Output File Options button.

In this window you may:                                     

 l Change the name of the .cif and .daf files to be created. It is recommended to keep the default names.

 l Choose to load a subset of objects. Tip: you can select a smaller number than the maximum if you have a large 

number of objects to load. This helps save time for creating a template file. The objects can be chosen ran-

domly or sequentially. 

7.    Click OK. The application then creates the .cif and .daf files and the .daf file is loaded into the Image Analysis area.

NOTE: Most often, the defaults will be adequate. For some older data files, you may need to provide control files 

for certain settings. For assistance call Luminex Technical Support.
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a.   To view the corrections that will be applied to the .rif file, click Advanced within the Output File Options window. 

The Opening file window appears.

b.   Make any changes to the corrections that you need, and then click OK. 

Opening a .cif file

A .cif file is generated when corrections are applied to a .rif file, as described, see Overview of the Data File Types. When 

opening a .cif file, the IDEAS® application calculates feature values and creates a .daf file to display images and graphs.

When opening a .cif file, an analysis template is selected. The template provides the initial characteristics of the analysis. 

Opening the .cif file causes the IDEAS application to calculate feature values and to use populations, graphs, and image 

viewing settings to display the cells as defined by the template.

To open a .cif file. To use a wizard to do this see Open File Wizard, otherwise:

1.   From the File menu, choose Open or drag the file into the IDEAS window.
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a.   Select the .cif file that you want in the Select File To Load window.

NOTE: While browsing for the file to open you can limit the type of file shown in the window to .cif.

2.    Choose a template.

3.    Name the output file.

4.    Click the folder next to Select a template or data analysis file (.ast, .daf) and choose the template to use for analysis. 

If left blank, the IDEAS application will use a default template. However, it is useful to create and save your own tem-

plates for specific experimental procedures. 

5.    Change the Data analysis file name, if necessary. The default name matches the name of the .cif. 

6.    Click OK. During the opening of a .cif file, the IDEAS application calculates the values of the features that are 

defined in the template you selected. The progress is shown by a progress bar. After the application has suc-

cessfully opened the .cif file, the .daf file is saved. 

For more information, see Saving Data Files.

Opening a .daf file

A .daf file contains the calculated feature values so that they will not need to be recalculated, as described, see Overview 

of the Data File Types. 

To open a .daf file, the IDEAS® application requires the .cif file to reside in the same directory. The .daf file does not con-

tain any image data, so you can think of the .cif file as the database that contains the imagery. Because all of the feature 

values have been saved in it, the .daf file should open quickly.
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To open a .daf file. To use a wizard to do this see Open File Wizard, otherwise:

1.   From the File menu, choose Open or drag the file into the IDEAS window.

2.    Select the .daf file that you want in the Select File To Load window.

NOTE: While browsing for the file to open you can limit the type of file shown in the window to .daf.

The progress is shown by a progress bar. The state of the IDEAS application is restored to what it was when the .daf file 

was saved.

Saving Data Files

Data files are saved at several stages of analysis. Raw image files are saved during data acquisition, by merging multiple 

.rif files or by creating new files from populations. Compensated image files and Data analysis files are saved when open-

ing .rif files, merging multiple .cif files, or when running a batch analysis. The IDEAS® application also saves other types 

of files that are used for data correction and presentation. Template files (.ast) save the structure of an analysis and com-

pensation matrix files (.ctm) save the compensation matrices. 

Application Defaults are set that direct the files into specific folders and can be viewed or changed by the user. For more 

information, see Viewing and Changing the Application Defaults.

Saving a Data Analysis File (.daf)

A .daf file contains a snapshot of an analysis as described, see Overview of the Data File Types. Saving the analysis as a 

.daf file allows you to recall that analysis simply by opening the file. When you quit the IDEAS® application, you are 

always prompted to save changes to a .daf file. You can also save changes from the File menu. Remember that the .daf 

file does not contain image information, so opening the .daf file requires the related .cif file to reside in the same dir-

ectory. 
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To save a .daf file:

1.   On the File menu, click Save as Data Analysis File (.daf).

2.    Enter a file name. 

NOTE: The default directory is the one where the .cif file was saved.

3.    If you select an existing file name, a warning appears that asks you to verify the overwriting of the existing file. 

4.    Click Save. The data is now ready for analysis. You can create graphs, view imagery, and display feature values and 

statistics. After you have defined an analytical procedure in the .daf file, you can save the file as a template, which 

allows you to use the procedure for analyzing other files. For more information, see Overview of the Data Analysis Tools.

5.    Option: Saving a data analysis file with only the feature values used. When you want to reduce the size of a data 

analysis file you may save the .daf with only the features that are used for analysis of statistics or graphs. 

6.    On the File menu, click Save as Data Analysis File - Used Features Only. and follow the instructions 2-3 above.

Saving a Compensated Image File (.cif)

The IDEAS® application creates and saves a .cif file when a .rif file is opened. By default, the application names the .cif 

file with the same name that the .rif file has, replacing the .rif extension with .cif. The application also places the .cif file in 

the same directory as the .rif file. The .cif file will be larger than the .rif file because the .cif file contains masking inform-

ation as well as corrected and/or compensated images.

Saving a Template (.ast)

Saving an analysis as a template allows you to apply the structure of the analysis to other .cif files. Save a template file 

after saving a .daf file. A template includes all graph definitions, Image Gallery settings, feature definitions, and statistics 

settings. No data are saved in a template. Therefore, selected images and populations that are dependent on specific 

objects, such as tagged populations, are not saved.

To save a template:

1.   On the File menu, click Save As Template File (.ast). A Save File dialog box appears.

2.    Enter the name of the file to save.

3.    Click Save. If you select an existing file name, a warning appears that asks you to verify the overwriting of the exist-

ing file.             

NOTE: You can change the default template directory in the menu Analysis > Application Defaults.             

Overview of Compensation

Spectral compensation corrects imagery for fluorescence that leaks into nearby channels so that you may accurately 

depict the correct amount of fluorescence in each cell image. 

For example, the light from one fluorochrome may appear primarily in channel 3, but some of the light from this fluoro-

chrome may appear in channel 4 as well, because the emission spectrum of the probe extends beyond the channel 3 

spectral bandwidth. The light from a second fluorochrome may appear primarily in channel 4 but, unless you subtract 

the light emitted by the first fluorochrome into channel 4, you cannot generate images that accurately represent the dis-

tribution of the second fluorochrome. 
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Emission Spectra for two fluorochromes:

Below is an example of cells stained with four fluorochromes independently and run together as one sample. Intensity 

scatter plots for two fluors and images for the four fluors are shown uncompensated and compensated. Image com-

pensation is performed on a pixel by pixel basis.

The IDEAS® application builds a matrix of compensation values by using one or more control files. A control file contains 

cells stained with one fluorochrome. Because it is critical that matrix values be calculated from intensities derived from a 

sole source of light, control files are collected without brightfield illumination, or scatter. The brightfield compensation is 

performed automatically. The process of creating the compensation matrix is described in the next section.
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Creating a New Compensation Matrix File

The compensation matrix is a table of coefficients. The IDEAS® application uses this table to place the detected light that 

is displayed in each image into the proper channels, on a pixel-by-pixel basis. The coefficients are normalized to 1. Each 

coefficient represents the normalized amount of the leakage of the fluorochrome into the other channels. Compensation 

is performed during the creation of a .cif file from a .rif file.

The default matrix, which is used if no compensation matrix is chosen, is the identity matrix, shown below. 

To generate a new compensation Matrix file

1.   Start the Compensation Wizard in one of two ways:

 l Click the New Matrix button when opening a .rif file 

 l OR select Compensation>Create New Matrix. 

The compensation wizard opens to Step 1: 

2.    Add compensation control files by clicking Add Files and browsing for the control files for the experiment. The files 

will have the suffix no-BF. Hold down the control key to select multiple files at once.

A note about compensation files. It is important to collect only single color positive cells or beads to use for com-

pensation files. Collect 500-1000 positive events for each file. Collecting more events or including negative and 

very dim cells is not recommended since the compensation calculations expect only positive events.

3.    When all of the control files for the experiment have been added to the list, click Next. The control file(s) are 

merged and loaded. 
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4.    Verify the channels for each control in the experiment by checking the channel boxes.

The following tables are provided as a guide for each instrument configuration. 

Table 5. First generation ImageStream® (IS100)

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6

470-500nm 400-470nm 500-560nm 560-595nm 595-660nm 660-735nm 

Scatter DAPI FITC PE 7-AAD PE-Cy5

Table 6. ImageStreamX - 1 camera

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6

435-505nm 505-560nm 560-595nm 595-642nm 642-745nm 745-780nm 

DAPI FITC PE PE-TexasRed AF647 APC-Cy7

Table 7. ImageStreamX - 2 camera

Ch 1 Ch 2 Ch3 Ch 4 Ch 5 Ch6

435-480nm 480-560nm 560-595nm 595-642nm 642-745nm 745-780nm 

 BF FITC PE PE-TexasRed PE-Cy5 PE-Cy7

Ch 7 Ch 8 Ch9 Ch 10 Ch 11 Ch 12 

435-505nm 505-570nm 570-595nm 595-642nm 642-745nm 745-780nm 

DAPI Pacific Orange BF Texas Red AF647 APC-Cy7

5.    Background and spatial offset corrections are performed, the imagery is displayed, bivariate plots of adjacent chan-

nels Intensity are added to the analysis area and the compensation matrix values are computed and displayed in a 

table.
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Example:

The Positive Control Populations are shown in the graphs below.

6.    Choose one of two methods for calculating the coefficients. 
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 l The Best Fit method is used for objects such as cells where intensities vary.

 l The Means method is used for objects such as beads that have only slight variations in intensity and therefore 

do not produce a linear .correlation.

 l The compensation files are merged and each object is scrutinized for it's peak channel emission. For each 

fluorochrome, the application automatically identifies a positive control population, excluding the brightest and 

dimmest objects, and assigns it to the proper channel. 

 l Inspect the matrix values in the table of coefficients. 

Coefficients should always be less than 1, and decrease from the assigned channel. In other words, leakage 

should be greater in the channel nearest to the assigned channel. Fluorescence always extends in the long-

wavelength direction from the exciting light. 

 l Verify that no coefficients are larger than 1.                                     Verify that, in a column corresponding to a fluorochrome, the coef-

ficients decrease from the assigned channel. 

 l Verify that the coefficient is greater in the channel below the 1 in the table than the value above the 1 in the 

table. 

 l Verify that these coefficients also decrease in subsequent channels below the 1. 

Verify that there are no changes from the identity matrix in the columns where there are no fluorochromes, 

including the scatter and brightfield channels. If necessary, the column can be set to the identity values by 

double-clicking on the heading.

 l Check for coefficients in red text. These coefficients have errors of 1% or more to the best fit line. This means 

you should inspect the graphs for these coefficients and if possible reduce the error by eliminating outliers or 

choosing the population manually. The purpose of making these coefficients red is to point out the coefficients 

that may need attention but it may be that the error will remain above 1% and remain red. 

 l Inspect the coefficients in the matrix by double-clicking on the coefficient.

A graph representing the coefficient appears. The population potted in the graph is the positive control pop-

ulation of the column of the coefficient. The X Axis represents the intensity in the assigned channel of the 

fluorochrome. The Y Axis represents the intensity in the channel of leakage. The coefficent value and error are 

also displayed.
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 l You can use the automatically generated control populations as they are, or you can refine them and create different 

populations by using the region tools. See the option below to remove objects from the population. By default, the pop-

ulations are named 3_Positive, 5_Positive, and so on. You can view the populations in the Image Gallery. Some pop-

ulations may be empty. 

 l To choose a different population, use the arrow and select the population from the list. The hierarchical relationship is 

shown in the population list. Assign populations only to the channels that correspond to the fluorochromes used in the 

experiment.

 l If you want to clear a column, double click on the channel heading. 

 l If needed, you can create new scatter plots by using the Analysis Area toolbar. For example, a 4_Intensity versus 5_

Intensity plot may be useful. See For more information, see Creating Graphs. for more information. 

 l The slope of the line on the plot is the coefficient in the matrix.

If objects in the population exist that are outliers, they should most likely be removed from the positive population within 

the compensation matrix by the following optional steps.

 l The slope of the line on the plot is the coefficient in the matrix.

Optional: Remove Objects from the Population
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1.   Within the compensation wizard, double-click the coefficient to display the intensity plot. 

If you notice outliers, click Add Graph to Analysis Area. The plot populates in the Analysis Area.

Return to the Analysis Area and use the region tools to draw a new region on the plot that defines a new positive control 

population, excluding the outliers. For more information, see Creating Regions on Graphs.

 l Create a new region to exclude outliers.

Click the Resize  and Zoom  buttons on the graph toolbar to more clearly see the population of 

interest. Using one of the region buttons on the toolbar, draw a region that contains only the cells you want to 

use for determining compensation. You can click a point on the graph and view the image to help you decide 

where the region boundaries should be. 

 l In the example below, the Polygon Region tool was selected to draw a border around a selection of cells. Click-

ing within the graph anchors the line and double-clicking completes the region. 

For more information, see Creating Regions on Graphs.
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1.   Assign the new population to the appropriate channel by using the Positive Control Populations list for that channel.

2.    The coefficient value is automatically recalculated when a new population is selelcted.

3.    Repeat these steps as required to redefine the coefficients. 

4.    Click Preview Images to view individual objects with corrections applied. Double click on an image to add it to the 

preview window. 

NOTE: The corrections are only applied to on-camera channels. For example, if the object is brightest in channel 3 

on the first camera, only channels 1-6 are shown corrected for that object. 

5.    When the matrix appears satisfactory, click Finish.
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6.    Enter a name for the compensation matrix file (.ctm) and click Save.

NOTE: The matrix is saved as a compensation matrix file (.ctm file). This file contains the compensation values and 

can be opened later for editing. To provide the values for fluorescence compensation, you select a .ctm file when 

opening a .rif file.
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Working with Compensation Matrix Files

Preview and Edit a Compensation Matrix

A compensation matrix can be applied to a population or .rif file in a preview mode for editing a matrix.

To open a compensation Matrix:         

1.   Select View/Edit Compensation Matrix from the Compensation menu to view, edit or preview the matrix on image 

data. Select the data file by clicking on the folder and then click Open. The matrix values are displayed in a table and 

may be edited.

2.    To preview the matrix on image data, browse for a file or select a population from the current file to preview and 

click Preview.

Troubleshooting compensation

Sometimes an applied matrix produces poorly compensated data. This can happen for a number of reasons: 1) mis-

calculation of the compensation matrix by inclusion of inappropriate events (such as doublets, saturated pixel events, or 

artifacts), 2) controls used for matrix calculation differ significantly from the experimental samples (different cell type, 

different probe), or 3) cells exhibit substantial auto-fluorescence. This protocol describes a method for manually adjust-

ing and validating a compensation matrix for difficult samples. 

To troubleshoot and repair a compensation matrix:

1.   Create a population of cells that are miscompensated using the tagging tool. For more information, see Creating 

Tagged Populations.. Choose single cells that are exhibiting crosstalk. Choose a range of intensities from negative to 

bright but not saturated, preferably single color. If single color cells are not available, choose cells with a distinct 

staining pattern in the peak channel. 

2.    Create Intensity scatter plots of adjacent channels in order to observe the over- or under-compensation. 
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3.    Identify the matrix values that need adjusting by inspecting the scatter plots and images. Each column contains the 

coefficients for the peak channel into the corresponding crosstalk channels (rows). For example the crosstalk of 

channel 2 (green) into channel 3 is highlighted in the matrix below.

 l Undercompensation (crosstalk coefficient is too low):

Plots: Intensity mean for the single color positive population is higher than the unlabeled population in the 

crosstalk channel or the intensity in the crosstalk channel trends diagonally upwards.

 l Images: the crosstalk channel contains an apparent fluorescent mirror-image.

 l Overcompensation (crosstalk coefficient is too high):

Plots: Intensity mean for the single color positive population is lower than the unlabeled population in the 

crosstalk channel or the intensity in the crosstalk channel trends diagonally downwards.

Images: the crosstalk channel contains dark spots corresponding to the bright spots in the fluorescent channel of 

interest.

1.   In the Compensation menu choose View/Edit Matrix and manually change the incorrect crosstalk matrix values 

identified above. Start with changes of ~.1 or ~.05 and use smaller and smaller increments as you refine the matrix.

2.    Click Preview and choose the tagged population to view the results of the changed coefficient.

3.    Repeat steps 4 and 5 until the matrix is corrected. 

4.    Click Save, append manual to the matrix name, then click OK. 

5.    Open the .cif file and use the new matrix to create a new .daf file. 
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Merging Data Files

Merging Raw Image Files

You can merge .rif files together for analysis.This option is not available for basic FlowSight files without the Quantitative 

Imaging (QI) upgrade.

To merge .rif files:

1.   On the Tools menu, click Merge .rif Files. The Merge Raw Image Files window displays. 

2.    To select the .rif files to merge, click Add Files.

3.    The .rif file names appear in the list.

4.    If you want to remove a file from the list, select it and then click Remove File.

5.    When the merge list is complete, click OK.

6.    The Save Merged Raw Image (.rif) File dialog box appears.

7.    Type a unique file name.

8.    Click Save. The Creating merged .rif file window appears

 

9.    When the merge is complete, the Merged .rif Created message displays.

10.   Click OK.

Notes: 

 l The sample information will contain information for the first file in the merge list. 

 l For ISX non-MKII files, the classifier is turned off when a merged file is loaded. To turn the classifier on manu-

ally, go to the Advanced panel on the open .rif window when opening an ISX non-MKII merged file. ISX-MKII 

and FlowSight® do not use classifiers.

 l When opening a merged .rif file, an easy method for gating the separate files is to create a scatter plot of the 

Object Number versus Time. Each population will fall on a differnt line.
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Merging Compensated Image Files

You can merge .cif files together for analysis.This option is not available for basic FlowSight files without the Quantitative 

Imaging (QI) upgrade.

To merge .cif files:

1.   On the Tools menu, click Merge .cif Files. The Load Multiple .cif Files window appears.

2.    To select the .cif files to merge, click Add Files. The .cif file names appear in the list.

3.    If you want to remove a file from the list, select it and then click Remove File.

4.    Type a unique name for the output files.

5.    Select a template.

6.    Click OK. The merged files are created and the new .daf file is loaded with a population created from each file.

Creating New Data Files

Creating New Data Files From Populations

To further analyze a population or merge it with other data when working in a .daf, you can save it to a new data file. 

This  is useful if your data file contains a large number of objects that are not pertinent to your experiment. Decreasing 

the data file size results in better performance by the IDEAS® application, as described, see Creating Regions on Graphs. 

NOTE: You cannot create a new .cif or .rif when multiple data files are open. This option is not available for basic 

FlowSight files without the Quantitative Imaging (QI) upgrade.
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To create data files from populations

1.   On the Tools menu, click Create Data File from Populations.The Create .cif and/or .rif From Populations window dis-

plays.

 

2.    In the Select populations list, select the populations that you want to include in the new data file(s). Ctrl click to 

select multiple populations.

3.    To create a .rif file, select the New Raw Image File (.rif) check box, the population name is used as a default. You 

may enter a new name.

4.    To create a .cif file, select the New Compensated Image File (.cif) check box, the population name is used as a 

default. You may enter a new name.

5.    Click OK. If you created a new .cif file, you can choose to load it. When loading the .cif file, the application will 

prompt you for the template. 

Viewing Sample Information

All of the information associated with an IDEAS® file, such as the collection information, camera settings and corrections, 

is saved  and can be viewed in the Sample Information window.

To open the Sample Information window:

1.   Go to Tools > Sample Information to open the window. Information for the open data file will be loaded. You can 

browse for a different data file by clicking on the folder. You can open the Sample Information Window for any of 

three file types: .rif, .cif, or .daf.

2.    Select a Tab to see the information for each heading.

59

IDEAS® Image Data Exploration and Analysis Software User's Manual



3.    Click Print to print a report of all of the sample information. 

NOTE: You may click on the folder and browse for a file to view the sample information for any file without loading 

the file.

 l Acquisition tab: File names, software version numbers, date acquired, number of objects, sample name.             

 l Corrections tab: Camera background, alignment offsets (from ASSIST).

 l Focus/Fluidics tab: Core information and sample volume.

 l Detection tab:IS100 and ImageStreamX only. Cell classifier settings during acquisition.

 l Population tab: FlowSight and ImageStreamX MKII only. Lists the populations and number acquired.

 l Camera Settings tab: Bin mode, magnification and sensitivity settings.

 l Illumination tab: Brightfield and laser information.

 l EDF tab: View kernels used for deconvolution of EDF imagery.

 l Compensation tab: View the compensation matrix.

 l Channels tab: Lists channels collected.

Batch Processing

Batch processing allows you to automatically analyze a group of files with one template when a compensation matrix 

has already been generated for the experiment.

To perform batch processing:
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1.   On the Tools menu, select Batch Data Files. The Batches window displays. It lists a record of all batches you have 

processed. 

2.    Click Add Batch. The Define a Batch window displays.

3.    To select the files for the batch, click Add Files. Navigate to the files and select by clicking on the file. Select multiple 

files to add by holding down the Ctrl key while selecting the files. 

a.   To remove files from the Files to Process list, click Remove Files.

4.    Select a compensation matrix from a file (.ctm, .cif, or .daf). Compensation is applied to .rif files only.

5.    Select a template file (.ast or .daf). Leave blank to use the Default template or check 'Use acquisition analysis for .rif 

files' if this is desired. 

NOTE: If a template is entered it will over-write the acquisition analysis.

6.    Set the output files options.

7.    If the template contains a statistics report definition, the Preview Statistics Report button will display. Click on Pre-

view Statistics Report to review the report or re-order the files as you wish them to be reported. To reorder the files 

select a file with a left-click, then right-click in the desired position and select ‘move here’.  For more information, see 

Reporting Statistics. 
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Optional: If you have a large rif file you may want to segment the file into multiple smaller files.

 l Click on the Segment .rif Files button.

 l Choose the segment size. The number of files that will be created is updated depending on the segment size 

chosen and the number of objects in the file as shown in this example. The segmented files will include the seg-

ment number and size in their names.

 l Click OK when done.

8.    Click OK in the batch definition window. The Define a Batch window closes. The batch appears in the Batches win-

dow.

The Batches window offers the following options:

 l Add Batch: If you want to create another batch to add to the list.

 l Remove Batch: If you want to remove a batch from the Batches to Run list.

 l Edit Batch: If you want to edit a batch in the Batches to Run list.
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9.    When you are satisfied with the Batches to Run list, click Submit Batches. The files to process are listed and the pro-

gress is displayed in the Processing Batch window. Once you have started processing batches, it may use up a fair 

amount of your computer’s processing power.

NOTE: To cancel the batch processing at any time, click Cancel Batch. The IDEAS® application will confirm can-

cellation and complete the file it is working on. When the batch processing is complete, the IDEAS application 

saves the .rif, .cif, and .daf files in the batch results directory. In the Batches window, a list of processed batches 

appears in the Processed Batches list. If a batch did not successfully complete, it will appear in red. 

NOTE: To display the error that occurred during processing, double-click the batch.
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After a batch is run it will appear in the processed batches list. You may get a report or rerun a batch from the list.

If you wish to rerun a batch, highlight the batch name and Click Add at the bottom of the window. This will move the 

batch into the run list where it may be edited.

If you want a batch report, double-click the batch name or highlight and click Details.

 l The Batch Results window appears.

 l In the Batch Results window, click Print.

 l In the Batch Results window, click Close.

 l In the Batches window, click Close. 

Overview of the Data Analysis Tools

The IDEAS® application provides a powerful tool set that allows you to explore and analyze data. The rich feature set lets 

you create hundreds of your own features to differentiate objects and statistically quantify your results.
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As shown in the following figure, the application window is divided into two panels— the Image Gallery and Analysis 

Area—which each provide the corresponding tools that you can use for data analysis. The layout can be changed to side 

by side or top and bottom with re-sizable panels.

You can create populations of objects by tagging hand-selected images, drawing regions on graphs, and using Boolean 

logic to combine existing populations.  After you have created a population, you can view it in the Image Gallery or plot it 

on a graph. You can view the statistics for populations or objects in tables placed in the analysis area.

Graphs show data plotted with one or two feature values, and tools are provided that allow you to draw regions for the 

purpose of generating new populations. You can show any population on a plot.

Every image is linked to the feature data. Selecting an individual data point in a graph allows you to view it in the Image 

Gallery or look at its feature values in the Statistics Area. Any object that is selected in the Image Gallery is also shown 

on the plots in the Analysis Area. Images may be ordered in the Image Gallery by feature value.

Using the Image Gallery

This section contains the following subsections, which describe how to view populations of objects in various ways, view 

masks, customize the Image Gallery display, and hand-select objects for a population:

 l see Using the Image Gallery

 l see Setting the Image Gallery Properties

 l see Working with Individual Channel Images

 l see Creating Tagged Populations

Overview of the Image Gallery

The Image Gallery displays the imagery and masks of any population of objects.
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A toolbar is provided in the upper-left corner of the panel, as shown in the following figure. The Image Gallery also 

makes different viewing modes available for the imagery. The default template contains the viewing modes which 

allows you to view all channel images in grayscale or color, or each channel image individually. 

NOTE: You can build custom viewing modes as shown in this example. For more information, see Setting the Image 

Gallery Properties..

Image Gallery Tools

Table 8. Image Gallery Tools

Tool Description

 Tagging Mode Tool
Allows you to create a population of hand-picked objects. For more information, see Creat-

ing Tagged Populations..

 Image Gallery Properties 

Tool

Provides custom display features. For more information, see Setting the Image Gallery Prop-

erties..

 Show/Hide Mask Tool Displays masks on the imagery. For more information, see To show or hide masks..

 Show/Hide Color Tool Sets the Image Gallery color. For more information, see To show or hide color..

Show/Hide Saturated 

Pixels Tool

Click on the tool and it will show any saturated pixels will turn red. For more information, 

see To show saturation..

Zoom Tools

Zoom in or out and reset zoom on the image gallery. For more information, see To zoom on 

the image gallery.

To view the imagery for a population

1.   In the Population drop-down menu of the Image Gallery, click the population that you want. (The list includes all the 

populations as well as the currently selected bin from a histogram.) For more information, see Creating Tagged Pop-

ulations.. 
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2.    To select an individual image, click on it. A thin, green frame indicates the selected object. 

 l The object’s feature values are displayed in a table if an object is selected and a table is added to the Analysis 

Area.

 l The selected object is identified in each scatter plot graph with a green cross.

 l The objects are presented in the Image Gallery in  object number order by default. To order the objects by 

another feature choose the feature in the drop-down menu.

 l The image can be placed in the Analysis area by right click > Add Image to Analysis Area.

NOTE: Conversely in any scatter plot in the analysis area, clicking a graphical point causes the Image Gallery to 

highlight and display the corresponding object.

To change the order of the images in the view

 l In the Order by drop-down menu of the Image Gallery, select a feature you wish to order the cells by and 

choose ascending or descending values.

NOTE: You can show the feature values on the images when creating the view in the Image Gallery Properties 

tool.

To change the viewing mode

 l In the View drop-down menu of the Image Gallery, select a specific view. The imagery display changes accord-

ing to the new view. To make a new view use the Image Properties tool.

To show or hide masks

 l Click the Show/Hide Masks toolbar button to toggle between showing and hiding the selected masks for all 

images in the Image Gallery .

The mask is shown as a transparent layer over each image. The mask displayed is selected in the Image 

Gallery Properties View tab. The color of the overlayed mask can be changed in the Applications Defaults 

under the Options menu.

 l NOTE: To hide the mask for a specific channel only, set the individual channel mask to None in the view tab of 

the Image Properties dialog.

 l To show or hide color

 l Click the Show/Hide Color toolbar button to toggle between showing and hiding the colors for all images in the 

Image Gallery. For more information, see Setting the Image Gallery Properties. 
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To zoom on the image gallery

 l Click the Zoom In toolbar button to view the images in the gallery closer and the Zoom Out or Reset Zoom to 

reverse the zoom.

To show saturation

 l Click the Show/Hide Saturated Pixels toolbar button. 

Saturated pixels in images, if any, appear in red. 

To show the mask or feature being used for the view

 l Hover over the channel name and the mask or feature being used for this view will be displayed.

Setting the Image Gallery Properties

When a new data file opens in the default template, you might find it difficult to clearly see cell morphology because the 

Image Gallery display properties have not yet been properly adjusted for the data set. 

To optimize the display you may use the wizard, see Display Properties Wizard  to set the pixel intensity mapping to the dis-

play range. Manual adjustment and other settings are described below.

Clicking the Image Gallery Properties toolbar button opens the Image Gallery Properties window, which contains the fol-

lowing tabs:

 

 l Display Properties—Allows you to define the name, color, and display intensity mapping for each image. 

Allows adjustment of the image size for the image gallery.

 l Views—Allows you to customize the views for the Image Gallery. 

 l Composites—Allows you to create composites and adjust the amount of color from a channel that is included 

in a composite image.
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To customize the Image Gallery display properties:

1.   Click the Image Gallery Properties toolbar button to begin. 

The Image Gallery Properties window appears with the Display Properties tab displayed. 

To change the size of the panels in the image gallery:

 l Display Width and Display Height can be specified or changed to Auto Fit in the lower left section of this win-

dow.

To change the name or color for each image:

1.   Select an image in the list of images on the Display Properties tab of the Image Gallery Properties window. 

2.    On the right side of the window you can type a new, unique name for the selected image. Note that each image is 

provided with a default name and the image names appear near the top of the Image Gallery.

3.    Click the colored square for the selected image. 

4.    Click the color that you want in the color palette.

5.    Click OK to close the palette.

NOTE: The grayscale image in each channel is assigned a default color for image display in the gallery. Setting the 

color to white is equivalent to using the original grayscale image. The colors are also used to build composite 

images.
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To fine-tune the image display intensity for an image:

1.   On the Display Properties tab of the Image Gallery Properties window, select an image by clicking the image name 

in the list. The graph for the currently selected image is shown in the window and updates as the changes are 

made. Select and image in the image gallery that has intensities for the image channel you are adjusting.

NOTE: You will adjust the Display Intensity settings on the graph (the Y Axis), the value of the display to (the X 

axis), the range of pixel intensities. The range of pixel intensities will depend on the instrument and the collection 

mode set during acquisition. The display range is 0–255; the range of intensities from the camera is 0-4095 for the 

ImageStream®X or 0-32,767 for EDF mode collection. The IS100 first generation instrument has a 10 bit camera 

and therefore the range of pixel intensities is  0–1023. The limits of the graph enable you to use the full dynamic 

range of the display to map the pixel intensities of the image.

 l At each intensity on the X Axis of the graph, the gray histogram shows the number of pixels in the image. This 

histogram provides you with a general sense of the range of pixel intensities in the image. The dotted green 

line maps the pixel intensities to the display intensities, which are in the 0–255 range.

Manual setting is done by Click-dragging the vertical green line on the left side (crossing the X Axis at 0) 

allows you to set the display pixel intensity to 0 for all intensities that appear to the left of that line. Doing so 

removes background noise from the image.

Click-dragging the vertical green line on the right side allows you to set the display pixel intensity to 255 for all 

intensities that appear to the right of that line.

2.    From the Image Gallery window, select the object to use for setting the mapping. It appears in the Image Gallery 

Properties window. 

NOTE: You might need to select different objects for different channels because an object might not fluoresce in all 

channels.

3.    To adjust the pixel mapping for display, click-drag the vertical green line by clicking near it (but not near the yellow 

cross). 

NOTE: For fluorescence channels, set the vertical green line that appears on the left side to the right of the large 

peak of background pixel intensities as shown above and set the right vertical green line to the right of the brightest 

pixel intensities. Click 'Set Linear Curve' to make the transformation linear. For the brightfield channel, set the ver-

tical lines to about 50 counts to the right and left of the histogram to produce an image with crisp brightfield con-

trast.

 l To change the mapping curve to be logarithmic or exponential, click-drag the yellow cross.

 l To restore the mapping to a linear curve, Click Set Linear Curve.
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 l To see the full scale for the X Axis Click Full Scale.

 l To set the display mapping of the X Axis to the lowest and highest values for a selected object, Click Set Range 

to Pixel Data.

 l To set the scale of the X Axis to the range of the vertical green lines or of all the pixel intensities for the selec-

ted object—whichever is larger—Click Autoscale.

 l You may enter values manually by selecting the Manual tab.

4.    If you want to preview the changes in the Image Gallery, click Preview Changes in Gallery.

5.    Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.

To customize the Image Gallery views images and masks:

1.   Within the Image Gallery Properties window, click the Views tab.

NOTE: The Image Gallery view can be customized to view any combination of channel images or composites. The 

default view All Channels is a view that displays all image channels that were included during acquisition of the file 

with their associated default masks. This mask may be changed for the default view however, the images in this 

view cannot be changed. The list of existing views is shown on the left.

2.    To create a new view, Click New. The new view is automatically added to the list on the left.

3.    In the right section of the window, type in a name for the view.

4.    Click Add Column.
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5.    Define the column by selecting an image and a mask or a composite from the drop-down menu.

6.    To show a feature value on an image check the box and choose the  feature.

7.    Repeat the previous 2 steps until finished adding columns to the view. A column will be added under the column cur-

rently selected. To insert a column click on the image above insertion point.

8.    Columns may be removed by clicking on Remove Column.

9.    A view may be edited at any time by selecting the view and following the same procedures. 

10.   If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears. 

11.    If you want to preview any new changes in the Image Gallery, return to the Image Gallery and choose your new 

view in the View drop-down menu. Then return to the Image Gallery Properties window and click Preview Changes 

in Gallery.

12.   Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.

To create a composite:

1.   Within the Image Gallery Properties window, click the Composites tab. The list of existing composites is shown on 

the left.

2.    In the right section of the window, type a name for the composite or leave blank to allow the name to be built auto-

matically from the image names added to the composite.

3.    Click Add Image. The selected image appears in the Object box. Change the Percent if desired. The percent spe-

cifies the percentage of  the image to include in the composite.

NOTE: As you make the changes, the image in the Object box updates accordingly. If you want to preview any new 

changes in the Image Gallery, return to the Image Gallery and select the View drop-down menu to your new view. 

Then return to the Image Gallery Properties window and click Preview Changes in Gallery.

4.    Continue to add images as desired.

5.    To remove and image from the composite, click Remove Image.

6.    The composite is automatically added to the list on the left.
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7.    A composite can be removed from the list by clicking Delete. 

8.    Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.

Working with Individual Channel Images

You can work with individual images in the Image Gallery. You can zoom in or out on the images. You can add a larger 

version of an image to the Analysis Area for further analysis, show or hide masks for a single image in the Image 

Gallery, and copy one or more images to the Clipboard.

To manipulate individual images:

1.   In the Image Gallery, right-click an image that you are interested in. A menu displays.

 l To place the image in the Analysis Area, click Add Image to Analysis Area. (For more information, see Ana-

lyzing Individual Images.)

 l To show or hide the masks for the object image, click Show Masks or Hide Masks, respectively. (One or the 

other will appear depending on the current state.)

 l To turn the colors on or off for the object image, click Color On or Color Off, respectively.(One or the other will 

appear depending on the current state.)

 l To show or hide the saturation color for the object image, click Show or Hide Saturation Color respectively.

(One or the other will appear depending on the current state.)

To copy or save images for use in reports:

1.   In the Image Gallery, right-click an image that you are interested in. A menu displays.
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 l To copy or save the single channel image to the Clipboard, choose   Copy/Save Image

 l To copy or save all of the channel images of one object, choose   Copy/Save Object Images.

 l To copy or save the single channel image for all of the displayed images to the Clipboard, choose   Copy/Save 

Gallery Column.

 l To copy or save all the visible images in the Image Gallery choose Copy/Save Gallery.

Overview of the Mask Manager

This section contains the following subsections, which describe how to create, edit, and delete a mask.

For more information, see About Masks.

Overview of the Mask Manager

A mask defines a specific area of an image to use for feature-value calculations. The IDEAS® application contains a 

Mask Manager for viewing existing masks and creating new ones. This option is not available for basic FlowSight files 

without the Quantitative Imaging (QI) upgrade.

When the IDEAS application loads a .rif file, the application creates a segmentation mask for each channel image and 

stores the mask along with the image in the .cif file. The masks, labeled M01 through M12, contain pixels that are detec-

ted as brighter than the background. In addition, the application generates a Combined Mask, named MC and a Not 

Combined Mask, Not MC for each object. A combined mask consists of the union of the masks of all the channels of the 

object. A Not Combined Mask is all of the pixels with no intensities above background.

You might need to adjust the masks or create new ones that include only a specific area of a cell, such as the nucleus. 

You can combine masks by using Boolean logic, or you can adjust them by applying functions.

Creating New Masks with the Mask Manager

There are two ways to work with new masks in the Mask Manager. First, masks can be created by using functions, 

which allows you to choose an input mask and, if needed, adjust the channel and scalar input. Alternatively, masks can 

be created by combining masks through Boolean logic. This option is not available for basic FlowSight files without the 

Quantitative Imaging (QI) upgrade.

To create a new mask using Functions:

1.   Select Analysis > Masks. The Mask Manager opens with a list of existing masks on the left.
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2.    Click New. The right side of the window is enabled to define a new mask.

3.    Click Function. The Define Mask Function window appears with 19 available masks to use. See About Masks for 

mask definitions.

 l AdaptiveErode

 l Component

 l Dilate

 l Erode

 l Fill

 l Inspire

 l Intensity

 l Interface

 l LevelSet

 l Morphology

 l Object

 l Peak

 l Range

 l Skeleton

 l Spot

 l System

 l Threshold

 l Valley

 l Watershed
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4.    Select a function and choose the input mask(s), channel and scalar parameters as needed. The right side of the win-

dow adjusts the display and view of the channel image. 

 l To view a different object in the file, select it in the Object list or type it's number.

 l To view a different image for the object, select it from the  list.

5.    The Link inputs checkbox is checked by default. To modify a mask with different inputs clear this box.

6.    Click OK.  The new function is added to the mask definition.

7.    Click OK. The new mask name will display in the list of Masks on the left side. 

To create a new combined mask:

1.   Select Analysis > Masks.

2.    Click New.

3.    Use the Masks list on the left and the Definition toolbar to build a new mask using the definitions of existing masks 

with Boolean logic explained in the table below.  
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Table 9. Mask Tasks and Toolbar

Task Toolbar

Add a mask to the definition.

Double-click the feature in the Masks list. 

Or, single click the feature in the Masks list and click the leftmost down-

arrow button on the toolbar.

Combine two masks.

Use the Boolean AND or OR operator. 

Use the AND operator to include only the pixels that are in both of the 

original masks. 

Use the OR operator to include the pixels that are in either one of the ori-

ginal masks.

Select all pixels that are not in the ori-

ginal mask. 

Use the Boolean NOT operator. 

The NOT operator specifies which mask will not be used.

Affect the order of operations.

Use the parentheses toolbar buttons.

 

Remove an item from the end of the 

definition.

Click the left-arrow button on the toolbar.

4.    Add masks and Boolean logic to the definition as needed. 

5.    Click OK to add the definition to the Masks list.

6.    Click Close.
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Viewing and Editing a Mask

To view a mask definition:

1.   Select Analysis > Masks. The Mask Manager window appears. 

2.    Click a mask in the Masks list to view the definition in the Definition area.

3.    Click Close.

To edit a mask function:

1.   In the Mask Manager window, select the mask that contains the function you want to edit.

2.    Click Edit.

3.    Remove the definition for the combined mask using the back arrow tool as needed.

4.    Or click the Function button on the toolbar for a function mask. The Define Mask Function window displays.

5.    Click OK when finished.
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To view masks in the image gallery:

After creating masks in the Mask Manager you may wish to view them in the image gallery for evaluation.

1.   Click the Image Gallery Properties toolbar button to begin.

The Image Gallery Properties window appears with the Display Properties tab displayed. Click on the Views tab.

2.    Click New.

3.    Type a name for the view.

4.    Click Add Column.

5.    Choose the Image and Mask from the drop-down menus.

6.    Continue to add columns until done. In this example the view will contain a Ch02 image with the Morphology mask, 

default mask and no mask followed by a Ch11 image with the Morpholog, default, no mask. 
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7.    To view the masks in the image gallery choose the view in the Image Gallery drop-down menu and turn the masks 

on by selecting the icon.

Example of Creating a Function Mask and a Combined Mask

Here is an example of creating a mask of the cytoplasm. Similar operations could be done for the cell surface.

In this example, cells were stained with a green intracellular marker (in Channel 2) and a red nuclear dye (in Channel 

11). You can generate a cytoplasm-specific mask by first refining the intracellular and nuclear masks and then removing 

the nuclear mask pixels from the intracellular mask.

1.   Observe the default masks in the Image Gallery. Since the default masks are designed to capture all the light in an 

image, they tend to include light that exists beyond the perceived boundaries of the images. In this case, both the 

intracellular and nuclear masks need to be refined. Start by creating morphology masks for both channel images 

because the Morphology mask is designed to conform to the shape of the image. 

NOTE: The Object mask function may also be used in place of the Morphology mask function. 
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2.    Select Analysis > Masks.

3.    Click New.

4.    Click on the Function toolbar button to adjust the mask that will define the whole cell. The Define Mask Function win-

dow displays.

5.    Select Morphology in the Function list. It will be important to have an appropriate cell selected. You can change the 

object number by typing in the box. Some functions are iterative, in which case you can change the mask selection.  

For example, dilate a morphology mask.

6.    Select a starting Mask.

7.    Select Channel 2 (intracellular marker) on the left side of the window. 

8.    Click OK. 
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9.    Click OK to add this mask to the list. 

The default names are ideal for recall.   The new mask will be defined in the list of masks on the left panel.  The mask 

definition can be recalled in the definition box by selecting the mask in the left panel.

10.   To make the Morphology(Nuclear) mask, repeat steps 3–9 using Channel 11.

11.    Click Close. 

12.   To view the resulting morphology masks, open the Image Display Properties window and, if necessary, select the 

new mask(s) for the channel.

 

13.   Next, you will subtract the nuclear morphology mask from the intracellular mask using boolean logic. In the Mask 

Manager window, click New.

14.   Double-click the Morphology(M02,Ch02) mask in the list.

15.   Click the AND button on the toolbar.

16.   Click the NOT button on the toolbar.
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17.   Double-click Morphology(M11,Ch11) mask in the list.

18.   The default name may be very long, edit as desired.

19.   Click OK to add this mask to the list.

20.   Click Close.

To view the resulting masks, open the Image Display Properties window and create a new view with the masks showing. 

For more information, see To customize the Image Gallery views images and masks:..

Overview of the Analysis Area

The Analysis Area provides display space for individual images, plots of cellular feature values, tables of population stat-

istics, tables of object feature values, and text annotations. You can select different layouts for the IDEAS® window and 

placement of the analysis area and expand the Analysis Area by dragging it’s boundaries.

The graphs are created into panels of a default size and can be re-sized by dragging a corner or using the size tool. The 

position of the panels is automatically adjusted to fit in the available display space. A vertical scroll bar appears when the 

number of panels exceeds the space available on the window. The panels can be re-tiled using the arrange analysis 

area tool.
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As illustrated by the following figure, the Analysis Area can contain several types of panels: histogram, histogram over-

lay, scatter plot, tables of population statistics or object feature values, channel image, composite image, and text. Each 

panel will contain its own toolbar and context menu. To move a panel click on the name at the top of the graph and drag 

it to a new location. A graph may be selected and then a right click in a blank space in the work area allows you to 

choose paste in the new location.

A toolbar is visible at the top of the Analysis Area. The following table describes the function for each tool.

Analysis Area Tools

Table 10. Analysis Area Tools
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Tool Description

 Pointer Tool

Provides the normal mode of interaction with the graphs. Clicking a point on a scatter-

plot graph causes the IDEAS® application to display the corresponding image in the 

Image Gallery (if the population that is currently displayed in the Image Gallery contains 

that point). 

Click the bin in a histogram to select the bin. In the Image Gallery, you can view images 

of cells in the bin by choosing the Selected Bin population. 

Click Pointer Tool while drawing a region on a graph to cancel the creation of a region.

Tagging Tool

Allows you to create a population of hand-picked objects. For more information, see Creat-

ing Tagged Populations.

 New Histogram Tool Creates a new histogram.

 New Scatter Plot Tool Creates a new scatter plot.

Populations Statistics 

table

Creates a table to display population statistics.

Object Feature Values 

table

Creates a table to display selected object feature values.

 Text Tool
Allows user to add text notes to the Analysis Area. For more information, see Adding Text to 

the Analysis Area..

 Line Region Tool

Draws a horizontal line on a histogram to define a region.

 Rectangle Region Tool Draws a rectangular region on a scatter plot. 

 Oval Region Tool Draws an oval region on a scatter plot. 

 Polygon Region Tool
Draws a polygon region on a scatter plot graph. Each click starts a new segment in the 

polygon until the entire image is double-clicked to complete the region. 

 Wizards Tool
Short-cut to using Wizards for guided analysis.

 Building Blocks Tool
Short-cut to using Building Blocks for guided analysis.

Select All Tool Selects all panels in the analysis area.
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Tool Description

 Tile Graphs Tool

Tiles graphs in the analysis area after changing the size of the analysis area to fit all 

graphs to the new space.

Layout Tools Switches the layout of the image gallery and analysis area.

 Graph Bkgd Tool
Changes the background of the graphs to black or white.

Graph sizing 
Tools

Changes the size of selected graphs to small, medium or large.

Creating Graphs

You can add two types of graphs to the Analysis Area:

 l Histogram—Graphs a single feature.

 l Scatter Plot—Graphs two features.

Note that building blocks are available that will help you to create graphs for finding single, focused, fluorescent positive 

events or a size versus scatter plot. For more information, see Building Blocks.

To create a graph without using a building block:

1.   Click the New Histogram or New Scatter Plot toolbar button.

The New Histogram or New Scatter plot window appears, respectively.

2.    Select the one or more populations to graph by clicking them. To select more than one population, use the Ctrl key.

The title defaults to the selected population. You can edit the title.

3.    In the X Axis Feature drop-down menu, select the feature that you want to graph on the X Axis.

4.    If you want to change the label for the X axis, edit the text in the X Axis Label field. The label defaults to the name of 

the selected feature. 

5.    If you are creating a scatter plot, select a feature and a label for the Y Axis. If you are creating a histogram you can 

choose to normalize the Y axis frequency and change the bin count.

6.    The default font sizes are used, you may change them by clicking Font Sizes.

7.    Assign colors by Population (default) for dot plots or by Density for density plots.
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8.    Set the scaling for each axis of the graph. (The default is Auto, which allows the application to automatically scale 

the graph.)

9.    To set minimum and maximum values for an axis, select Manual.

10.   Select Linear or Log and enter Maximum and Minimum limits.

11.    If you selected Log, enter the X > value.

NOTE: You can scale the X Axis of a graph or the Y Axis of a scatter plot in one of two modes: Linear or Log. The 

Linear mode is the default.

The Log mode allows you to logarithmically scale a section of the graph or scatter plot. Selecting this mode causes 

the IDEAS® application to perform bi-exponential plotting. The > X value defines the linear portion of the graph as -

X through X. The application plots the values outside of these limits on a logarithmic scale. You can plot negative 

values as well as positive ones on a logarithmic scale by adjusting the limits.

Take care not to split a population such that it appears to be two separate populations. This splitting is especially 

likely when negative values exist due to compensation or corrections on the imagery. The graph on the left side 

was plotted on a linear scale; the ones in the center and on the right side were plotted on logarithmic scales. The 

graph on the right side split the population because the change from a linear to a logarithmic scale occurred in the 

middle of the population. In general the >X value should be 1000 for 40 and 60X data and 100 for 20X data.

12.   The font sizes can be changed for an individual graph.
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13.   Click OK.

NOTE: Right-click in the graph to bring up the context menu.  Graph Properties will open the same window that you 

used to create the graph will reappear, and you can then make any changes that you want.

To show selected statistics for a graph:

1.   You can show and hide statistics by clicking the Statistics toolbar button in the panel that contains the graph.
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2.    Or, right-click anywhere on the graph and click Statistics on the graph context menu that appears. The Statistics win-

dow appears.

3.    Select the statistics that you want to display. Check the View statistics box and the box next to the statistic to be dis-

played for each population on the graph. The statistics that are supported are the Count, Percent Total, Percent 

Gated, Percent, Concentration (count/sample volume), Mean, Median, Standard Deviation, MAD (Median Average 

Deviation) RD -Mean, RD -Median, CV, Minimum, Maximum, Geometiric Mean, Mode, variance, and NaN (not a 

number).

4.    When finished, click Close.

To show the legend for a graph:

1.   Right-click anywhere on the graph, and click Show/Hide Legend on the graph context menu that appears.

If the legend was hidden, it appears on the graph. If the legend was shown, it disappears from the display.

NOTE: The legend contains an entry for each population on the graph. If the graph is a scatter plot, the legend 

shows the population and its associated point style and color. If the graph is a histogram or overlay histogram, the 

legend shows the population name, associated color, and line type. 

 l To move the legend, click and drag it. (You cannot drag the legend past the boundary of the graph panel.)

To order the plots on a graph or change the fill and lines for a histogram:

 l Right-click anywhere on the graph and choose Plot Order and Properties on the graph context menu that 

appears. The Display Properties dialog appears.
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Moving a Graph

 l With any graph in the Analysis Area, you can move it to another location by clicking in the center of the graph 

and dragging it. 

 l Alternatively, select the graph, right-click in the a blank space in the analysis area choose cut and then right-

click where you would like to move the graph and choose past.

Creating Regions on Graphs

Regions may be drawn on graphs to create new populations, based on the physical location of objects on a graph, and to 

compute statistics. Tools for drawing regions are found on the Analysis Area toolbar. A line region may be drawn only 

on a histogram. All other types of regions may be drawn only on a scatter plot. 

A region can be copied to another graph in the same file or other open files. Regions may also be copied from one 

instance of the IDEAS® application to another.

When you draw a region on a histogram or scatter plot, you create a population of objects defined by the region that 

may be viewed in the Image Gallery or on other graphs. 

For more information, see Using the Region Manager.

To draw a region on a Scatter Plot:

On the Analysis Area toolbar, click either the:

 l Rectangle Region, or 

 l Oval Region, or

 l Polygon Region button on the Analysis Area toolbar. 

1.   The Rectangle and Oval tools work by clicking on the graph at the point where you would like to start the region, 

and drag to the region endpoint.

2.    The region grows as you drag.

 

3.    Click again to complete the region.                If you are drawing a region on a histogram or scatter plot, the Create a Region 

window appears. 
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4.    Name the region.             

5.    Click the colored box to select an alternate color.              

6.    Select Use for statistics only if you do not want to create a population from this region.             

7.    Click OK.The region appears on the graph with the name and color that you selected.

Polygon Tool Option:

1.   The Polygon tool works by clicking the scatter plot at the point where you would like to start the polygon.

2.    Click once for each vertex of the polygon.

3.    Double-click to complete the drawing of the region. A window appears that allows you to name the population cre-

ated by the polygon region and to assign the region’s display properties.

4.    Click OK. The region appears on the graph with the name and color that you selected.

NOTE: Before you click OK, you can click Cancel or you can click the Pointer button on the Analysis Area toolbar if 

you decide not to create the region.

To Draw a region on a Histogram:

1.   On the Analysis Area toolbar, click the Line Region tool. 

2.    Drag the line across the histogram.
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To move or resize a region on a graph:

1.   Click the Move/Resize Region toolbar button on the graph panel toolbar.

2.    Click the region that you would like to move or resize. When the region is selected, squares that can be moved 

appear at the vertices and the label.

3.    The first time that you drag the region, the entire region and label move.

4.    Dragging a specific vertex or label moves only that vertex or label.

5.    To finish moving or resizing the regions on the graph, click the Move/Resize Region toolbar button again to deac-

tivate the tool.

The populations and statistics are updated, and the Move/Resize Region toolbar button is deactivated.

NOTE: The recalculation of statistics and populations may take a moment if the data file is large or if many pop-

ulations are dependent on the regions that are being moved or resized.

To zoom in on the scale of a graph:

1.   Click the Scaling toolbar button on the graph panel toolbar. 

2.    Click and drag to define a rectangular region for rescaling.

The Zoom Out Scaling toolbar button appears in the graph panel toolbar, next to the Scaling toolbar button. 

3.    Click the Zoom Out Scaling toolbar button to automatically scale the graph.

The Zoom Out Scaling toolbar button is removed from the graph panel toolbar.

To resize a graph:

 l Select the graph(s) to be resized and then click the sizing button tool small, medium or large.

 l A graph may be resized by dragging the right, bottom or lower,right corner. 

NOTE: Select multiple graphs to make them all the same size.

To copy and paste a region to another graph:

1.   Right-click anywhere on a graph, and click Copy Region to Clipboard on the graph context menu that displays.

The Copy a Region to the Clipboard window displays.

2.    Click the region to copy in the list, and click OK.

3.    Right-click on the graph where you want to paste the region, and click Paste Region from Clipboard on the graph 

context menu that displays.

4.    If the region already exists (in other words, you are copying it within the same instance of the application), the 

Create a Region window displays. 
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5.    Rename the region and set the display properties for the resulting new population, and click OK.

NOTE: When you copy a region, the scale is copied and is no longer associated with the feature from which it was 

originally drawn. Therefore, the region might not fit on the new graph.

To Apply or Remove a region on a graph:

1.   Right-click anywhere on the graph, and click Apply/Remove Region on the graph context menu that displays. The 

Apply Graph Regions window displays.

2.    Select the regions that you want to appear on the graph.

3.    Clear the regions that you want to remove from the graph.

4.    Click OK.

To show or hide a population on a scatter plot:

1.   Click Show/Hide Populations on the graph context menu. The Show/Hide Populations window displays.

2.    Select the populations that you want to appear on the graph.

3.    Clear the populations that you want to remove from the graph.
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4.    Click OK.

NOTE: On a scatter plot, you may show or hide any population on the graph—regardless of the features on the 

axes. Each scatter plot has an original, or base, population. When you show a population on a scatter plot, only 

those objects that are also in the base population will be shown. To aid in the identification of the populations 

shown, change the characteristics of the population(s)  in the population manager.

Analyzing Individual Images

To analyze an image in more detail, place the image in the Analysis Area to view pixel positions and intensities as well 

as generate statistics for an area of the image. You can also show the Measurement tool for the image.

Image panels, which are shown in the following figure, each contain a toolbar in the upper-right corner and a context 

menu that appears when you right-click an image. An image in the Analysis Area is three times the size of an image in 

the Image Gallery.

To add an image panel to the Analysis Area: 

 l Right-click an image in the Image Gallery or Analysis Area, and click Add Image to Analysis Areaon the context 

menu that appears. The image panel appears in the Analysis Area.
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To view the individual pixel intensities of a single channel image:

 l Move the mouse pointer across the image. The pixel positions and intensities appear under the image. (The 

pixel (0, 0) is positioned at the upper left of the image.)

To display the Measurement tool in an image panel:

 l Right-click the image panel, and click Show Measurement Tool on the context menu that displays.

The 10-micron bar displays.
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To examine a line profile or the statistics for an area of an image:

 l Click on the red line tool in the image tools to open , click and drag to create a boxed area on the image.

The Image Statistics are shown in the image panel. The statistics are calculated for the area that is defined by 

the box. The line profile (the wavy line in the image panel) represents the pixel intensity at each position along 

the red line of the box.

 l Click on the red line tool in the image tools to open , click and drag to create a boxed area on the image.

The Image Statistics are shown in the image panel. The statistics are calculated for the area that is defined by 

the box. The line profile (the wavy line in the image panel) represents the pixel intensity at each position along 

the red line of the box.

96

IDEAS® Image Data Exploration and Analysis Software User's Manual



To change the display properties of an image

1.   Click the Channel Display Properties button on the image panel toolbar.

The Display Properties window displays.

 l For single channel image, you can change the displayed mask and adjust the display intensity mapping. 
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 l For a composite image, you can change the images in the composite and adjust the percent contribution of 

each image. For more information, see Setting the Image Gallery Properties.

2.    Click OK.

To show or hide the mask for a single channel image:

 l Click the Mask button on the image panel toolbar, or right-click the image and then click Show/Hide Mask on 

the image context menu.

The mask appears as a transparent overlay on the image.

To turn the color on or off: 

 l Click the Color button on the image panel toolbar, or right-click the image and then click Color Off or Color On.

98

IDEAS® Image Data Exploration and Analysis Software User's Manual



Viewing the Object Feature Values

The Object Feature Values table, which is shown in the following figure, displays a selected set of feature values for 

selected objects. For each feature, the name, value, and description are shown.

To view and customize the features shown in the Object Data table:

1.   Click the Object Feature Values tool. 

2.    Right-click anywhere in the table area to open the menu.

3.    Choose Select Features.
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4.    The Select Object Features window displays.

5.    Select the features to view. Multiple features may be chosen by holding down the Ctrl key.

6.    Click OK. The features appear in the Object Data table.

7.    To add selected objects to the table right-click and choose Add Current Object.

To export or copy feature values:

 l Right-click in the table and choose Copy feature values to clipboard. 

Adding Text to the Analysis Area

To add text to the Analysis Area: 
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1.   Click the Text button on the Analysis Area toolbar.

A text panel is added to the analysis area.

2.    Enter a title and text.

Population Statistics

The Population Statistics table displays selected statistics for chosen populations. The statistics that are supported are 

the Count, Percent Total, Percent Gated, Percent, Concentration (count/sample volume), Mean, Median, Standard Devi-

ation, MAD (Median Average Deviation) RD -Mean, RD -Median, CV, Minimum, Maximum, Geometric Mean, Mode, 

variance, and NaN (not a number).  

To view and customize the population statistics:

1.   Click the Populations Statistics tool. 

2.    Click the + next to the population to expand the list of populations.

3.    Columns can be moved by click-dragging.

4.    Right-click in the gray area in the table or on a column heading and the menu opens.
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5.    Edit Statistic Table opens a Statistics Properties window to enable changes to multiple column statistics.

6.    To add a single statistic column select Insert Column.

7.    Select Edit Column to make a change.

8.    To delete a single column right-click on that column and select Delete Column.

9.    Select Delete All Columns to clear all statistics.

10.   Order Columns places the columns in default order.

11.    Copy Statistics copies the selected rows of the table in a text format that can be pasted into other programs such as 

Excel.

12.   Copy Statistics - Transposed copies the selected rows of the table and transposes the data so that when pasted 

into other programs such as Excel the rows become columns.

Using the Feature Manager

This section describes how to create and delete features and to create multiple features by selecting categories. The 

only new feature options for FlowSight® basic files without QI are combined features. The following subsections cover 

this information:

 l see Viewing feature definitions

 l see Creating New Features with the Feature Manager

 l see Creating Multiple Features and Ranking Features by Discriminating Power

Overview of the Feature Manager

The IDEAS® application defines a set of base features that you can use to create features for each object. To do so, you 

use the object’s mask and/or its channel images. After a feature has been created and its value calculated for all cells, 

you can plot the feature values or view them as statistics for any population. For more information, see Features and Masks.

When the IDEAS application opens a .cif or .rif file, the application calculates the values of features as defined by the 

selected template. You can refine your template so that it includes only those features of interest for your experiment. 

You use the Feature Manager to examine existing features and to define new ones. To gain access to the Feature Man-

ager, select Analysis > Features or select it from one of the context menus that are available in the histogram and scat-

ter plot panels with a right-click. While the Feature Manager is open, all calculations for creating graphs and statistics 

are disabled. However, you may view images and change the population and channel views. When you close the Feature 

Manager, any changes to feature names, definitions, and values are reflected in any currently displayed graphs and stat-

istics. The values of newly created features are also calculated at this time.

You can create single features and combined features. You create a single feature by selecting a base feature, such as 

Area or Intensity, along with a mask and/or an image. This option is not available for basic FlowSight files without the 

Quantitative Imaging (QI) upgrade. You can create a combined feature by defining a mathematical expression that 

includes one or more single features that exist in the feature list. FlowSight® files without the QI upgrade can utilize the 

combined feature option.

Some features, such as Area, depend on the boundary of a cell. These features require you to select a mask that defines 

the portion of the image to use for the calculation. Other features, such as Max Pixel, depend on pixel intensity meas-

urements and require you to select an image. Other features require you to select a mask and one or more images. 
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You can add and remove features from the feature list. The feature definitions are stored in templates, so the definitions 

are available when you analyze multiple data files. The default template used for ImageStream® data or QI FlowSight 

data includes most of the base features for each channel image and channel mask that the feature list contains. Certain 

features, such as Similarity and Spot, require extensive calculations so the default template does not include them. The 

reason is to save time when you load files. However, you can add these features to the feature list. 

Viewing feature definitions

To view existing features:

1.   Click Analysis > Features or select Features from a graph panel context menu. The Feature Manager window 

appears.

2.    Choose an icon to sort the features:

Table 11. Sorting Features

Feature 

Icon
Definition

Sorts features alphabetically.

Sorts features based on the images used. 

Sorts features based on the masks used. 

Sorts features by category, such as size, location, shape, texture, signal strength, and sys-

tem.

Sorts by base features, such as area, aspect ratio, intensity, and object number. 

3.    Click a feature in the Features list to view its definition in the right side of the window.
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Creating New Features with the Feature Manager

To create a new single feature:

A single feature uses the definitions of a base feature along with a mask and/or an image.

1.   Click New in the Feature Manager. The right-hand area of the Feature Manager is enabled.

2.    Select Single as the Feature Typeand choose the base feature in the drop-down menu. The Mask and Image lists 

become visible depending on the single feature selected.

3.    Select the mask and/or image that you want.

4.    Click Set Default Name. The default name is the name of the base feature followed by the name of the mask and 

name(s) of the image(s). 

5.    Click OK to add the new feature. It appears in the Features list on the left side of the Feature Manager.

6.    Click Close.

NOTE: When you close the Feature Manager, the IDEAS® application calculates values for the new features. These 

calculations may take several minutes, depending on the number and complexity of the new features and the size 

of the image file.

To create multiple features:

1.   Click Add Multiple Features in the Feature Manager.

2.    Sort the feature list alphabetically or categorically. 

3.    Select multiple base features and masks.
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4.    Select image(s) or check the box to create for all channels using default masks and images.

5.    Any list can be cleared by clicking the Clear Selected button.

6.    When finished click Add Features to add the new features to the list.
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7.    Confirm the features in the next window.

8.    Delete any features you do not want to calculate.

9.    Click OK when finished. The new features are added to the list in the feature manager.

10.   Close the Add Features window.

11.    Close the Feature Manager. The new features are calculated when the feature manager closes.

To create a new combined feature:

1.   A combined feature uses one or more single features created by a mathematical expression. 

2.    Click New in the Feature Manager.

3.    The right hand area of the Feature Manager is enabled.

4.    Select Combined as the Feature Type. The editing interface appears.
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5.    Enter the feature name in the Name box or use Set Default Name after you have created your expression. The 

default name is the name of the definition created. 

6.    Use the toolbar to build a definition (mathematical expression) of features and operators: 

Table 12. Combined Feature Tasks and Toolbar

Task Toolbar

Add a feature to the definition.

Double-click the feature in the Features list. 

Or, single click the feature in the Features list and select click the leftmost down-

arrow button on the toolbar.

Add an operator or a parenthesis 

to the definition.

Click the corresponding button on the toolbar.

Add a number to the definition.

Enter the number in the box and then click the corresponding down-arrow button. 

If the area is greyed-out, an operator must be selected first. 

Add a function to the definition.

Select the function in the list and then click the corresponding down-arrow button.

The available functions are ABS (absolute), COS (cosine), SIN (sine), 

SQR (square), and SQRT (square root).

If the area is greyed-out, an operator must be selected first. 

Remove an item from the end of 

the definition.

Click the left-arrow button on the toolbar.

7.    Click OK.

8.    Click Close.

NOTE: When you close the Feature Manager, the IDEAS® application calculates values for the new features. These 

calculations may take several minutes, depending on the number and complexity of the new features and the size 

of the image file.

To delete a feature:

1.   Select one or more features in the Features list by clicking them. To select more than one feature, use the Ctrl key.

2.    Click Delete. A warning message will confirm or cancel deletion.
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NOTE: Deleting a feature also deletes any populations that are dependent on that feature. Your feature list may 

become large and unwieldy. You can narrow down the list without deletions by sorting the list. For more information, 

see Using the Feature Manager. for more information. 

Creating Multiple Features and Ranking Features by Discriminating 
Power

With the IDEAS® application you are able to create an unlimited set of features by using the Mask manager to define loc-

ation and the Feature manager to choose a mathematical expression that uses the image pixel data and/or the mask. 

This can make it challenging to choose a feature that provides good statistical separation of populations of cells that 

have different appearances from each other. 

IDEAS 6 includes the 'Feature Finder' wizard which creates a set of masks and features automatically and determines 

the features with the most discriminating power for the chosen truth populations. It may be useful for certain applic-

ations to create new masks and features that are not created by the wizard. Once features are created using this 

manual method the Feature Finder wizard will test all features in the data file. For more information, see Feature Finder Wiz-

ard.

A general description of the steps is followed by a specific example.

General

1.   Set image display and draw preliminary regions to include cells of interest (i.e., single, focused, positive cells).

2.    Visually inspect overall quality of images and experiment to determine whether to proceed or redo the experiment.

3.    Create two tagged ‘truth’ populations of cells that represent the phenotypes you wish to discriminate. Perform the 

discrimination on one characteristic difference at a time.

4.    Create any additional masks and features you think may help differentiate the truth populations.

5.    Calculate the statistical discrimination (RD) between the two populations afforded by features in 1 category at a 

time. Pick the top feature for each category. Alternatively, use the Feature Finder wizard which measures the RD 

but only keeps the 3 features per category with the highest RD.

6.    Plot the features with the highest RD for the truth populations for each category

7.    Validate by applying the feature to the base population, independent controls if available and on multiple files and 

experiments.

Example

Treatment-induced actin polarization. The data file is available for practice. Log in to your account on the Luminex web-

site and look in the folder ‘Training data files’.

 l Cells were incubated with inducing compound for 1 hour.

 l The nucleus was probed with DAPI and actin stained with FITC.

 l Large event image files were collected on the ImageStream®.

 l Compensation and analysis was done in IDEAS®.

The following steps find the best features that distinguish changes in actin distribution.

1.   Gate single, focused, actin-positive cells. View cells of interest.

108

IDEAS® Image Data Exploration and Analysis Software User's Manual



2.    Create the truth populations from within the cells of interest using the tagging tool.

NOTE: If truth populations are in different files, merge them together before beginning. When selecting truth pop-

ulations, choose images that represent the full phenotypic range of each truth. In this example case, note that the 

‘uniform actin’ truth population contains cells of varying shape and intensity that all have uniform actin distribution. 

Bias introduced during the selection of truth populations will likely also bias the outcome during statistical ranking.

The following figure shows the truth populations chosen to find a feature to discriminate uniform versus polarized 

actin:

3.    Create the Morphology and one or more Threshold masks for the actin image.

4.    Create features from the Size, Shape, and Texture categories using the Morphology, Threshold and Default actin 

channel masks.

a.   Choose Features from the Analysis menu and click Add Multiple Features.
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b.   In the Add Features window select Category as the ‘Sort Order’. 

c.   Check Size, Shape and Texture base feature boxes.

d.   Select the actin masks (Morphology, Object, Threshold, M02)

e.   Select the actin image (FITC).

f.   Click Add Features to display the list of features to add.

g.   In the next window, click OK to add the features. Features that already exist will not be recalculated. 

h.   Click OK and click Close.

i.   Close the Feature Manager by clicking Close and the features will be calculated.

5.    Add the feature statistics to the population statistics table. Do this one category at a time. Multiple statistics tables 

can be added to the analysis area, one for each category of features.

6.    Alternative: Go to the Feature Finder wizard to continue with the RD calculation and ranking.

Once the features are calculated you can use the RD, (Fischer's Discriminant Ratio) to a statistics table. The RD meas-

ures the separation between 2 populations. In this case, the 2 truth populations picked in step 2. In order to get the stat-

istic for 1 category at a time, select all of the features for the image and then deselect categories, to leave 1 category for 

the channel selected.

a.   Click on  to add a statistics table to the analysis area.

b.   Right-click in the table and choose Edit Statistics Table.

c.   Delete any statistics from the list.

d.   Select the statistic ‘RD –Mean’.
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e.   Select one of the truth populations in the Reference population box.

f.   Sort by Images Used by clicking on the icon .

g.   Check the box for the Ch02/Actin image.

h.   Sort the features by Category .

i.   De-select all but 1 category by checking and unchecking the box for the categories you want to de-select. Note 

that the box next to the category will be checked only if all of the features (all channels) in the category are 

selected.

j.   Click Add Statistics.

k.   Click Close.

l.   Repeat until each statistics table contains 1 category of features for Ch02(Actin).

7.    Launch Excel and then Copy and Paste the statistics into the excel spreadsheet.

a.   Select the row of statistics for the 2nd truth population (the one not chosen above). 

b.   Right-click in the statistics table and choose Copy Statistics - Transposed. 

c.   Paste into an Excel spreadsheet.
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d.   Keep all of the features and values selected and sort the data set on the values column (heading may be the 

population name) largest to smallest. The feature with the largest RD will be at the top. 

NOTE: You may have NaN values for some of the features. This means Not a Number and occurs in some 

cases when there is a division by 0. These can be ignored.

8.    Validate the features in IDEAS. Plot the features with the highest RD for the truth populations and draw regions to 

discriminate.

9.    Apply regions to the base population, independent controls if available and on multiple files and experiments.

10.   Look for false negative and positive cells.

11.    Repeat process if necessary by refining/creating new truth populations.

NOTE: NOTES ON EVALUATING THE FEATURES: Consider the features that produce the highest Rd. If there are any 

intensity based features make sure that the staining was not uneven due to technical issues. If it is a size feature, 

does it make sense with what you know about the cells and biology of your experimental system? Since the feature 

value ranges vary between features this is an approximate comparison and the result should be validated by viewing 

images across the feature range from the whole population.

Using the Population Manager

A population is a group of objects. You create populations by drawing regions on graphs, by hand-selecting (tagging) 

objects in the Image Gallery or on plots, or by combining existing populations. After a population has been defined, you 

can view it in the Image Gallery or on a plot and you can use it to calculate statistics.

The Population Manager provides a central place for maintaining the display properties of existing populations and for 

creating new combined populations.

To open the Population Manager and view the population definitions:

1.   Select Analysis > Populations or right click a graph and select Populations. The Population Manager window dis-

plays. 

NOTE: The list of populations is presented as a hierarchy that shows the dependencies of the populations on each 

other. The icon associated with a population indicates how the population is defined.
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Icon Defined by

Tagging

Region

Combined

The definition of a selected population is shown in the Definition area.

To edit the display properties of a population:

1.   Within the Population Manager, click a population in the Populations list.

2.    Change the name in the Name box.

3.    Click a Color square to select a new color on the color palette and click OK.

4.    Click a display symbol in the Symbol drop-down menu.

5.    Click Close to save the population changes.

6.    Click Revert to reject the changes.

To delete a population:

1.   Within the Population Manager, click a population in the Populations list. 

2.    Click Delete. 

3.    A confirmation warning message appears indicating all the dependent populations that will also be deleted.

4.    Click Yes to confirm.

To create a new combined population:

1.   Within the Population Manager (Analysis > Populations), click New. The right side of the Population Manager win-

dow changes to allow you to define a new population.
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2.    Enter a unique population name in the Name box.

3.    Click a Color square to select a new color on the color palette and click OK.

4.    Click a display symbol in the Symbol drop-down menu.

5.    Use the toolbar to build the population definition as described in the table and click OK when done: 
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Table 13. Population Tasks and Toolbar

Task Toolbar

Add a population to the definition. Select the population from the drop-down menu. 

Combine two populations.

Use the Boolean AND or OR operator. 

Use the AND operator to include only the objects that are in both of the 

original populations. 

Use the OR operator to include the objects that are in either one of the ori-

ginal populations.

Select objects that are not in the ori-

ginal population. 

Use the Boolean NOT operator. 

The NOT operator specifies which population will not be used. Note: you 

must use AND before NOT.

Affect the order of operations.
Use the parentheses toolbar buttons. 

Remove an item from the end of the 

definition.

Click the left-arrow button on the toolbar.

For more information, see Creating Tagged Populations.

Creating Tagged Populations

You can hand-select objects from either the Image Gallery or a graph and group them into a population.
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To create a hand-selected population

1.   Click the Tagging Mode toolbar button to begin.  The Tagged Population window displays.

2.    Select either Update existing or Create New.

 l To Create New,  double-click images within the Image Gallery and select Save. Enter a new population name. 

Each population is given a new color and the symbol solid diamond for ease of viewing in plots.

3.    If you selected Update existing, choose a population to update in the drop-down menu.

4.    In the Image viewing mode list, choose the mode that you want from the drop-down menu. For more information, see 

Setting the Image Gallery Properties.

5.    To add or remove an image from the tagged population, double-click either the image in the Image Gallery or a dot 

in a bivariate plot. The selected channel image for each tagged cell is displayed in the viewing area of the Tagged 

Populations window. In the Image Gallery, a small smiley-face icon appears on the left side of each tagged image. 

Each tagged object is also displayed as a yellow star in a graph in the Analysis Area. The number of objects in the 

tagged population is updated in the bottom, left corner.

6.    If you are updating an existing population, click the Update button in the Tagged Populations window.

7.    When you are finished updating, click Close in the Tagged Populations window.

NOTE: The tagging mode remains open until you click Close, and as long as the Image Gallery is in tagging mode, 

you cannot create, resize, or move any regions on the graphs. 

Creating a tagged population from a file of object numbers

You can  use a comma-separated text file of object numbers to create a tagged population.
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1.   Select Create Tagged Population from File under the Tools menu.

2.    Browse for the file.

3.    Name the population, select the color, symbol and click OK.

Using the Region Manager

The Region Manager provides a central place for defining the display properties, names, and positions of existing 

regions. Regions can be deleted in the Region Manager tool. 

If a file is going to be used as a template and you do not wish to change certain regions in the new daf files you may 

check the box 'When used as a template, do not overwrite this region' and the specific regions will be preserved in the 

new daf files. 

Regions are drawn on graphs to create new populations, based on the physical location of objects on a graph, and to 

compute statistics. Tools for drawing regions are found on the Analysis Area toolbar. For more information, see Creating 

Regions on Graphs.
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To open the Region Manager and view the region definitions:

1.   Select Analysis > Regions or right click a graph and select Regions. The Region Manager window appears. Click on 

the region in the list you want to view.

To edit a region:

1.   Within the Region Manager, click a region in the Regions list.

2.    Change the name in the Name box.

3.    Click a Color square to select a new color on the color palette and click OK.

4.    Change the X or Y position of the vertices in the Vertices box.

5.    Select or de-select the Use for statistics only box.

6.    Click Delete to delete a region.

7.    Click Revert to reject the changes.

8.    Click Close when finished.

NOTE: When a region is deleted, all populations that are defined by that region will be deleted. A warning dialog 

box appears listing the populations that will be deleted. 

Creating Reports and Exporting Data

The following six-page sample report was created by copying data from IDEAS®, the ImageStream® Data Acquisition 

forms and excel into a MS word document. This template can be found in the customer documents in your training 

materials or in the knowledge-base of your account on the Luminex® website.
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Once you have finished analyzing an experiment you will want to report the results into third party applications. To 

streamline the process the first step is to define your application defaults, image gallery settings and statistics report 

definitions. This section covers the following topics that will help you to create reports.

 l see Viewing and Changing the Application Defaults

 l see Setting the Image Gallery Properties

 l see Prepare the Image Gallery and Analysis Area for Reporting

 l see Copy Full or Partial Screens

 l see Copy Images to the Clipboard or Save Images to Files

 l see Copy Graphs to the Clipboard or Save Graphs to a File

 l see Reporting Statistics

 l see Exporting Data into other analysis applications

 l see Printing Data

Viewing and Changing the Application Defaults

1.   To view or change these defaults, choose Application Defaults from the Options menu. Each tab allows you to view 

or change the default settings.
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 l The Directories tab contains the default Data, Template, Batch or Compensation Matrix file directories.

 l The Populations tab contains the default color or symbol for populations. To change the default settings, click 

on the color to or choose a default symbol from the list. 

 l The Masks tab contains the default mask color. To change the color of the mask click on the color button.
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 l The Graph Display tab contains the default settings for graphs in the analysis area including graph size, font 

sizes and the default list of statistics shown for a graph. Check the box next to the statistic to have it show 

below the graphs when statistics are shown for a graph.  The settings may be updated on all or selected graphs 

in the analysis area.
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 l The Graph Export tab contains the default settings  for exporting graphs including the graph size, font size, 

options to include legend, cursor sample name and statistics. Select the Defaults button to use the graph 

export settings when exporting graphs or select the Graph button to use the settings as they appear in the ana-

lysis area for the graph.
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 l The Image Export tab contains the default settings  for image export when copying and pasting from IDEAS® 

for reporting into other programs.

 l The Colors tab contains the mapping of dark and light mode colors.
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Setting the Image Gallery Properties

When a new data file opens in the default template, you might find it difficult to clearly see cell morphology because the 

Image Gallery display properties have not yet been properly adjusted for the data set. 

To optimize the display you may use the wizard, see Display Properties Wizard  to set the pixel intensity mapping to the dis-

play range. Manual adjustment and other settings are described below.

Clicking the Image Gallery Properties toolbar button opens the Image Gallery Properties window, which contains the fol-

lowing tabs:

 

 l Display Properties—Allows you to define the name, color, and display intensity mapping for each image. 

Allows adjustment of the image size for the image gallery.

 l Views—Allows you to customize the views for the Image Gallery. 

 l Composites—Allows you to create composites and adjust the amount of color from a channel that is included 

in a composite image.

To customize the Image Gallery display properties:

1.   Click the Image Gallery Properties toolbar button to begin. 

The Image Gallery Properties window appears with the Display Properties tab displayed. 
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To change the size of the panels in the image gallery:

 l Display Width and Display Height can be specified or changed to Auto Fit in the lower left section of this win-

dow.

To change the name or color for each image:

1.   Select an image in the list of images on the Display Properties tab of the Image Gallery Properties window. 

2.    On the right side of the window you can type a new, unique name for the selected image. Note that each image is 

provided with a default name and the image names appear near the top of the Image Gallery.

3.    Click the colored square for the selected image. 

4.    Click the color that you want in the color palette.

5.    Click OK to close the palette.

NOTE: The grayscale image in each channel is assigned a default color for image display in the gallery. Setting the 

color to white is equivalent to using the original grayscale image. The colors are also used to build composite 

images.

To fine-tune the image display intensity for an image:

1.   On the Display Properties tab of the Image Gallery Properties window, select an image by clicking the image name 

in the list. The graph for the currently selected image is shown in the window and updates as the changes are 

made. Select and image in the image gallery that has intensities for the image channel you are adjusting.

NOTE: You will adjust the Display Intensity settings on the graph (the Y Axis), the value of the display to (the X 

axis), the range of pixel intensities. The range of pixel intensities will depend on the instrument and the collection 

mode set during acquisition. The display range is 0–255; the range of intensities from the camera is 0-4095 for the 

ImageStream®X or 0-32,767 for EDF mode collection. The IS100 first generation instrument has a 10 bit camera 

and therefore the range of pixel intensities is  0–1023. The limits of the graph enable you to use the full dynamic 

range of the display to map the pixel intensities of the image.

 l At each intensity on the X Axis of the graph, the gray histogram shows the number of pixels in the image. This 

histogram provides you with a general sense of the range of pixel intensities in the image. The dotted green 
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line maps the pixel intensities to the display intensities, which are in the 0–255 range.

Manual setting is done by Click-dragging the vertical green line on the left side (crossing the X Axis at 0) 

allows you to set the display pixel intensity to 0 for all intensities that appear to the left of that line. Doing so 

removes background noise from the image.

Click-dragging the vertical green line on the right side allows you to set the display pixel intensity to 255 for all 

intensities that appear to the right of that line.

2.    From the Image Gallery window, select the object to use for setting the mapping. It appears in the Image Gallery 

Properties window. 

NOTE: You might need to select different objects for different channels because an object might not fluoresce in all 

channels.

3.    To adjust the pixel mapping for display, click-drag the vertical green line by clicking near it (but not near the yellow 

cross). 

NOTE: For fluorescence channels, set the vertical green line that appears on the left side to the right of the large 

peak of background pixel intensities as shown above and set the right vertical green line to the right of the brightest 

pixel intensities. Click 'Set Linear Curve' to make the transformation linear. For the brightfield channel, set the ver-

tical lines to about 50 counts to the right and left of the histogram to produce an image with crisp brightfield con-

trast.

 l To change the mapping curve to be logarithmic or exponential, click-drag the yellow cross.

 l To restore the mapping to a linear curve, Click Set Linear Curve.

 l To see the full scale for the X Axis Click Full Scale.

 l To set the display mapping of the X Axis to the lowest and highest values for a selected object, Click Set Range 

to Pixel Data.

 l To set the scale of the X Axis to the range of the vertical green lines or of all the pixel intensities for the selec-

ted object—whichever is larger—Click Autoscale.

 l You may enter values manually by selecting the Manual tab.

4.    If you want to preview the changes in the Image Gallery, click Preview Changes in Gallery.

5.    Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.
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To customize the Image Gallery views images and masks:

1.   Within the Image Gallery Properties window, click the Views tab.

NOTE: The Image Gallery view can be customized to view any combination of channel images or composites. The 

default view All Channels is a view that displays all image channels that were included during acquisition of the file 

with their associated default masks. This mask may be changed for the default view however, the images in this 

view cannot be changed. The list of existing views is shown on the left.

2.    To create a new view, Click New. The new view is automatically added to the list on the left.

3.    In the right section of the window, type in a name for the view.

4.    Click Add Column.

5.    Define the column by selecting an image and a mask or a composite from the drop-down menu.

6.    To show a feature value on an image check the box and choose the  feature.

7.    Repeat the previous 2 steps until finished adding columns to the view. A column will be added under the column cur-

rently selected. To insert a column click on the image above insertion point.

8.    Columns may be removed by clicking on Remove Column.

9.    A view may be edited at any time by selecting the view and following the same procedures. 

10.   If you want to delete a view, click the view to select it, and then click Delete.

A confirmation window appears. 

11.    If you want to preview any new changes in the Image Gallery, return to the Image Gallery and choose your new 

view in the View drop-down menu. Then return to the Image Gallery Properties window and click Preview Changes 

in Gallery.

12.   Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.
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To create a composite:

1.   Within the Image Gallery Properties window, click the Composites tab. The list of existing composites is shown on 

the left.

2.    In the right section of the window, type a name for the composite or leave blank to allow the name to be built auto-

matically from the image names added to the composite.

3.    Click Add Image. The selected image appears in the Object box. Change the Percent if desired. The percent spe-

cifies the percentage of  the image to include in the composite.

NOTE: As you make the changes, the image in the Object box updates accordingly. If you want to preview any new 

changes in the Image Gallery, return to the Image Gallery and select the View drop-down menu to your new view. 

Then return to the Image Gallery Properties window and click Preview Changes in Gallery.

4.    Continue to add images as desired.

5.    To remove and image from the composite, click Remove Image.

6.    The composite is automatically added to the list on the left.

7.    A composite can be removed from the list by clicking Delete. 

8.    Continue customizing the Image Gallery display properties with another procedure in this section, or click OK to fin-

ish and save changes or Cancel to finish and discard changes.

Reporting Images and Graphs

The IDEAS® application allows users to copy and print images and graphs, export statistics, feature data, pixel data, or 

TIF files for separate analyses. 

Prepare the Image Gallery and Analysis Area for Reporting

1.   Before you print or copy images, see Setting the Image Gallery Properties to optimize the image display.
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2.    In addition to formatting the graphs and statistics in the Analysis area (see Overview of the Analysis Area), the 

IDEAS® application provides color mapping from the dark mode that you see in the Analysis Area to a light mode 

that has a white background for the printing and exporting of data. Because the population colors might not show 

on a white background, you can change the colors when using the light mode.

To use light background graphs in the Analysis Area:

 l Click the graph background tool to switch between light or dark mode. 

To map the dark mode colors to light mode colors:

1.   See the Application Defaults-Colors tab.

 

2.    Click Update Populations in Open Files when done..

3.    Click OK to save the changes or Cancel to exit.

Copy Full or Partial Screens

To copy the entire screen to the Clipboard:

 l Press CTRL+PRINT SCREEN. It is then available for pasting into a third party application.
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To copy a window to the Clipboard:

 l Select the window and then press ALT+PRINT SCREEN.  It is then available for pasting into a third party applic-

ation.

Print the Analysis Area or Image Gallery Directly

To print the Analysis Area data:

 l Select Reports > Print Analysis Area. The IDEAS® application prints all the graphs, statistics, text panels, and 

images that are displayed in the Analysis Area.

To print the Image Gallery data:

 l Select Reports > Print Image Gallery. The IDEAS® application prints all the images that are visible in the Image 

Gallery.

Copy Images to the Clipboard or Save Images to Files

To copy or save Images: 

1.   Right-click anywhere in the Image Gallery and then choose one of the following options:

 l Copy/Save Image for a single image

 l Copy/Save Object Images for the row of images for one object

 l Copy/Save Gallery Column for the images of one channel in the current gallery

 l Copy/Save Gallery for all images in the current gallery

2.    A preview of the image(s) is shown. Changes from the default settings may be made to the following: 

 l Show Channel names 

 l Show Object number

 l Show Scale bar

 l Text color for channel names

 l Background

 l Number of rows and columns

 l Size and DPI settings
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 l Font sizes and clipboard format

3.    The settings may be Saved to the Default settings or Default settings may be loaded.

4.    Click Save to File or Copy to Clipboard when done. Files may be saved as .png, .bmp or .tif formats.

5.    If Copy to Clipboard was chosen, paste into third party application.

Copy Graphs to the Clipboard or Save Graphs to a File

To copy or save graphs:

1.   Right click anywhere in the graph and choose Copy/Save Graph and/or Statistic. 

2.    A preview of the graph is shown. Changes from the default settings may be made to the following: 

 l Include Graph

 l Include Legend

 l Include Statistics

 l Include Cursor

 l Show sample name in title

 l White background on/off

 l Graph size

 l Font sizes

3.    If changes are made they can be previewed by clicking Generate Preview. Otherwise they will be applied when 

Save to File or Copy to Clipboard is chosen.

4.    Option: Settings may be saved to default settings or loaded from default settings.

5.    Click Save to File or Copy to Clipboard when done. Files may be saved as .png, .bmp or .tif formats.
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6.    If Copy to Clipboard was chosen, paste into third party application.

To export graph statistics to the Clipboard:

 l Right-click a graph and then click Export Statistics To Clipboard. They are then available for pasting into a third 

party application.

To copy population statistics from a Statistics Table:

 l Right-click the table and then click Copy Statistics or Copy Statistics - transposed. They are then available for 

pasting into a third party application.

Reporting Statistics

Define a Statistics Report

A statistics report definition can be saved in a .daf file or an .ast template file. It allows users to select specific statistics 

within a .daf file and open the data in Excel. 

A statistics report can be generated during batching if it is part of the template used. It may also be applied to pre-exist-

ing .daf files from the Reporting menu. In this case, the rest of the template is not processed—only the report. The stat-

istics report definition allows you to specify population percentages and feature statistics and the layout of the report is 

accessed from the reporting menu.
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To create a Statistics Report Definition:

1.   Select Reports > Define Statistics Report. The Statistics Report Definition appears.             

2.    Enter a Report title.

3.    Under the Statistic Columns clickAdd Columns. The Add Statistic Report Column window opens.

4.    Select the statistic(s) in the Statistics list.

 l Count - the absolute count of the populations

 l %Total - percentage of a population as a percentage of All

 l %Gated - the percent of one population as a percentage of another, but not used for tagged populations

 l % - the percentage of one population as a percentage of another, also is used for tagged populations

 l Objects/mL - the concentration of the population in the sample run.

 l CV - the coefficient variable

 l Geometric Mean - standard statistical definition

 l Maximum - standard statistical definition

 l Mean - standard statistical definition

 l Median - standard statistical definition

 l MAD - standard statistical definition

 l Minimum - standard statistical definition

 l Mode - standard statistical definition

 l RD - Median - the ratio discriminant (Fisher's discriminant) using the Median and MAD

 l RD - Mean - the ratio discriminant (Fisher's discriminant) using the Mean and StdDev

 l Standard Deviation - standard statistical definition

 l Variance - standard statistical definition

 l NaN - stands for not a number; the number of objects whose values are not valid numbers.

5.    Select a population to base on the selected statistic(s).

6.    Select a reference population if necessary. This is required for % and RD.

7.    Select a Feature. This is not necessary for the %-related statistics, Count, or Objects/ml.

8.    Click Add Statistics.The statistic is added to the list.
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9.    Click Close when finished.

10.   Select a statistic in the list to view the definition or edit any input.

11.    Change the name of the statistic by clearing Use default title and typing a new name if desired..

12.   Delete Columns removes a selected statistic.

13.   To reorder the list click-drag a statistic to it's new location.

14.   Click Generate Report when complete to generate a report for a current (opened) .daf file. A prompt appears to 

save the text file. This text file can be opened from Excel.

15.   If you do not want to generate a report, click OK to save your changes and exit the window.

16.   The saved template can generate a statistics report for multiple data files by selecting Generate Statistics Report 

from the Reports menu or during batch processing.
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Generating a Statistics Report using .daf Files

Once a Statistics Definition has been created, the user can generate a statistics report from multiple .daf files. However, 

these files must use the same template. Batch Processing can also generate a statistics report where statistics for each 

data file will be generated either for .rif, .cif, or .daf files. Generating a statistics report under the Reports menu simply 

adds the statistics template to the specified .daf files.

To Generate a Statistics Report:

1.   Select Reports > Generate Statistics Report. The current .daf file appears in the window with the specified statistics 

columns.

2.    Pick a Report Definition. The definition may be obtained from a .daf or .ast file.

3.    Change the Report title if desired.

4.    Additional .daf files can be added or removed with the Add Files or Remove Files buttons.

5.    Reorder the files as desired by selecting files and then right-click the new location in the list and choose move here. 

You can Ctrl select multiple files in the desired order and then move all at once by right-clicking in the desired loc-

ation and choosing move here.

6.    Click OK.

7.    A prompt will confirm that the .daf file will be saved. The report title name will be used as the default file name for 

the report. In the above example, the file generated will be named “Report 1.txt”. If the report title contains illegal 

characters, such as “\/><“ the default filename will change to “Statistics Report.txt”. Tab delimited text format is 

used for the report.

8.    The report can be viewed in IDEAS by choosing View Statistics Reportt from the Reports menu. The report can be 

copied to the clipboard and pasted into a spreadsheet program or the .txt file can be opened using a spreadsheet 

program.
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Reporting Statistics from a Single Graph or Statistics Table

Statistics can also be reported directly from an open .daf from the graph or statistics tables in the analysis area.

To export graph statistics to the Clipboard:

 l Right-click a graph and then click Export Statistics To Clipboard. They are then available for pasting into a third 

party application.

To copy population statistics from a Statistics Table:

 l Right-click the table and then click Copy Statistics or Copy Statistics - transposed. They are then available for 

pasting into a third party application.

Exporting Data

You can export feature values for a population to the Clipboard, a text file, or a Flow Cytometry Standard (FCS) file. You 

can export pixel intensity values for an object to the Clipboard or a text file. Later, you can open or paste the FCS file into 

a spreadsheet or other programs that uses the FCS file format. Keep in mind, however, that limitations might exist on the 

number of values that these programs can import.
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Exporting Feature Data

Exporting feature data is useful if you want to create an fcs file or graph the feature data in a third party graphing applic-

ation.

To export feature data:

1.   On the Tools menu, click Export Feature Values. The Export Feature Data window appears.

2.    Add files to the list on the left to export values for multiple files.

3.    In the Select a population drop-down menu, select the population that you want. If you haven’t defined any pop-

ulations, All is the default. To make a new population, see Creating Tagged Populations. 

4.    In the Select feature values to export area, select features by clicking items in the list or hold down the Ctrl while 

clicking to select multiple items.

5.    Select the Export to option that you want. 

NOTE: Data exported to the Clipboard can be pasted directly into a spreadsheet program.

6.    Select the Order by option that you want. 

NOTE: Ordering by object causes the values to be listed in a column, whereas ordering by feature causes the val-

ues to be listed in a row.

7.    Click OK. 
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Exporting Pixel Data

Exporting pixel data is useful when importing the data into third-party programs where you would need to graph the indi-

vidual pixels. 

To export pixel data:

1.   On the Tools menu, click Export Image Pixel Values. The Export Image Pixel Values window appears. 

2.    Select the object to export in the drop-down menu.

3.    Select to Export to either the Clipboard or File.

4.    Click OK.

5.    Paste into desired application.

Creating TIFs From Population for Export

The IDEAS® application allows users to create separate TIF files for channel images for every event in that population. 

The exported TIF files can be opened in image viewing applications that support 8 bit tif format for display or 16 bit tif 

format for analysis.
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To create TIFs From Population for Export:

1.   On the Tools menu, click Export .tif Images. The Create TIFs From Population window displays.

2.    Select the population and channels. 

3.    Type a prefix for the TIF file name. 

4.    Select the bit depth.

5.    Select padded or raw.

6.    Click OK. A TIF file is created for every selected channel within the selected population. 

Printing Data

The IDEAS® application provides color mapping from the dark mode that you see in the Analysis Area to a light mode 

that has a white background for the printing and exporting of data. Because the population colors might not show on a 

white background, you can change the colors when using the light mode. See Application Defaults for more information.

To use light background graphs in the Analysis Area:

 l Click the graph background tool to switch between light or dark mode. 

 l For more information, see Viewing and Changing the Application Defaults. - colors tab to set the color mapping 

desired.

139

IDEAS® Image Data Exploration and Analysis Software User's Manual



To print the Analysis Area data:

 l Select Reports > Print Analysis Report. 

The IDEAS application prints all the graphs, statistics, text panels, and images that are displayed in the Ana-

lysis Area. In version 6.2 and later additional information has been added to the printed report to assist users 

in tracking changes that may have been made in the files. This includes laser information, compensation matrix 

and region coordinates.

To print the Image Gallery data:

 l Select Reports > Print Image Gallery. The IDEAS application prints all the images that are visible in the Image 

Gallery.

To print an individual graph:

1.   Right-click the graph and then select Print Graph on the graph context menu. The Print Graph window displays.

2.    Select the check boxes Graph, Statistics, Legend, Cursor, Show Sample Name in Title to include the elements in the 

report. 

3.    If necessary, adjust the size scaling factor. Recommended setting is 100%.

4.    Click OK to print the graph.
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Chapter 4: Features and Masks

Understanding the IDEAS® Features and Masks

This section contains the following subsections, which describe the features that the IDEAS® application uses for data 

analysis:

See the following lists of base features:

 l For more information, see Base Features- by Category .

 l For more information, see Base Features- by Category .For more information, see Table of Basic Features available for 

FlowSight® without QI. 

 l For more information, see Understanding the Size Features.

 l For more information, see Understanding the Location Features.

 l For more information, see Understanding the Shape Features.

 l For more information, see Understanding the Texture Features.

 l For more information, see Understanding the Signal Strength Features.

 l For more information, see Understanding the System Features.

 l For more information, see Understanding the Comparison Features.

 l For more information, see About Masks.
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Overview of the IDEAS® Features and Masks

Objects passing through an Amnis cell analysis system are illuminated in different directions by lasers and/or brightfield 

LEDs. Light emitted from the object is focused through an objective lens and relayed to a spectral decomposition ele-

ment, which divides the light into six spectral bands located side-by-side across a charge-coupled detector (CCD), as 

shown in the following diagram. Therefore, each object has six images that can be individually analyzed or, because they 

are in spatial register with respect to one another, reconstructed. Each of the separate bands is called a channel. Below 

is an example of collecting 6 images. The ImageStream®x system has a second camera option which enables collection 

of up to 12 images per object. The FlowSight® system has 12 channels collection on 1 camera.

About Features

The IDEAS® application provides a large selection of criteria, or features, for analyzing images. A feature is described by 

a mathematical expression that contains quantitative and positional information about the image. A feature is applied to 

specific locations of an image by the use of a mask that identifies pixels within the region of interest of the image. A few 

system features, such as Object Number, Camera Background and Flow Speed, do not require calculations, masks, or 

image intensity information. 

There is a slight difference in features created during data acquisition and those in IDEAS. During acquisition features 

are created with the INSPIRE™ mask. Features and masks are calculated in IDEAS for files collected with the 

ImageStream® or a FlowSight® with the Quantitative Imaging (QI) upgrade.

New masks and features can be created in files from an ImageStream or FlowSight® with the QI upgrade using the Mask 

and Feature Manager tools. Features are created in IDEAS using base feature algorithms, such as Area or Intensity 

along with a mask and/or a channel image for files created with an ImageStream or with the QI upgraded FlowSight 

machine. The default masks are recomputed in IDEAS for ImageStream or QI enabled files. Combined features can be 

created using existing features in mathematical expressions in the Feature Manager.

IDEAS groups the features into eight categories: size, location, shape, texture, signal strength, comparison, system and 

combined. 

For more information, see Overview of the Mask Manager.
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To calculate the value of a feature, the IDEAS application maps the channel image to X and Y coordinates, as illustrated 

by the following diagram. Each box in the diagram represents a pixel.

The pixel size and field of view per channel is dependent on the magnification used. See your INSPIRE™ Users Manual 

for more information.

Features Categories

Size

Size features are in microns and include Area, Diameter, Length, Major Axis, Minor Axis, Major Axis Intensity, Minor 

Axis Intensity, Perimeter, Thickness Max and Min, Spot Area Min, Width and Height.

Location

Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X Intensity, Centroid Y Intensity, Delta 

Centroid X, Delta Centroid Y, Delta Centroid XY, Max Contour position, Spot Distance Min, Valley X and Valley Y.

Shape

Shape features define the mask shape and have units that vary with the feature. They include the Aspect Ratio, Aspect 

Ratio Intensity, Compactness, Elongatedness, Lobe Count, and Symmetry 2,3,4. 

Texture

The Texture features determine local intensity variations in images and include Bright Detail Intensity R3 and Bright 

Detail Intensity R7, Contrast, Gradient Max, Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, 

H-Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev. 

Contrast, Gradient Max and Gradient RMS are generally used to determine best focus.
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Comparison

The Comparison features describe the difference of intensity measurements between masks or pixels in different 

images or the same image with different masks. These include Bright Detail Colocalization 3, Bright Detail Similarity R3, 

Intensity Concentration Ratio, Internalization, and Similarity.

System

The system features do not require a mask.

Base Features - Alphabetical 

Table 14. Table of Base Features - Alphabetical
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Feature Name Category

For more information, see Angle Feature. Location

For more information, see Angle Feature. Location

For more information, see Area Feature. Size

For more information, see Aspect Ratio Feature. Shape

For more information, see Aspect Ratio Intensity Feature. Shape

For more information, see Bkgd Mean Feature. Signal Strength

For more information, see Bkgd StdDev Feature. Signal Strength

  Comparison

For more information, see Bright Detail Intensity R3 and Bright detail Intensity R7 Features. Signal Strength

For more information, see Bright Detail Similarity R3 Feature. Comparison

For more information, see Camera Line Number Feature. System

For more information, see Camera Timer Feature. System

For more information, see Centroid Features. Location

For more information, see Centroid Features. Location

For more information, see Circularity Feature. Shape

For more information, see Compactness Feature. Shape

For more information, see Contrast Feature. Texture

For more information, see Centroid Features. Location

For more information, see Centroid Features. Location

For more information, see Diameter Feature. Size

For more information, see Elongatedness Feature. Shape

For more information, see Elongatedness Feature. Texture

For more information, see Flow Speed Feature. System

For more information, see Gradient Max Feature. Texture

For more information, see Gradient RMS Feature. Texture

For more information, see Height Feature. Size

For more information, see H Texture Features. Texture

For more information, see Intensity Concentration Ratio Feature. Comparison

For more information, see Intensity Feature. Signal Strength

For more information, see Internalization Feature. Comparison

For more information, see Length Feature. Size

For more information, see Lobe Count Feature. Shape

For more information, see Major Axis and Minor Axis Features. Size

For more information, see Major Axis Intensity and Minor Axis Intensity Features. Size

For more information, see Max Contour Position Feature. Location

For more information, see Max Pixel Feature. Signal Strength
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Feature Name Category

For more information, see Mean Pixel Feature. Signal Strength

For more information, see Median Pixel Feature. Signal Strength

For more information, see Min Pixel Feature. Signal Strength

Minor Axis: see For more information, see Major Axis Intensity and Minor Axis Intensity Features. Size

For more information, see Modulation Feature. Texture

For more information, see Object Number Feature. System

For more information, see Objects/mL Feature. System

For more information, see Objects/sec Feature. System

For more information, see Perimeter Feature. Size

For more information, see Spot Intensity Min and Spot Intensity Max Features. Location

For more information, see Raw Intensity Feature. Signal Strength

For more information, see Raw Max Pixel Feature. Signal Strength

For more information, see Raw Mean Pixel Feature. Signal Strength

For more information, see Raw Min Pixel Feature. Signal Strength

For more information, see Raw Median Pixel Feature. Signal Strength

For more information, see Saturation Count Feature. Signal Strength

For more information, see Saturation Percent Features. Signal Strength

For more information, see Shape Ratio Feature. Shape

For more information, see Similarity Feature. Comparison

For more information, see Similarity Feature. Comparison

For more information, see Spot Area Min Feature. Size

For more information, see Spot Count Feature. Texture

For more information, see Spot Distance Min Feature. Location

For more information, see Spot Intensity Min and Spot Intensity Max Features. Signal Strength

For more information, see Std Dev Feature. Texture

For more information, see Symmetry 2, 3, 4 Features. Texture

For more information, see Thickness Max Feature. Size

For more information, see Thickness Min Feature. Size

For more information, see Time Feature. System

For more information, see Valley X and Valley Y Features. Location

For more information, see Width Feature. Size

For more information, see XCorr Feature. Comparison
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Feature Name Category

For more information, see Angle Feature. Location

For more information, see Angle Feature. Location

For more information, see Area Feature. Size

For more information, see Aspect Ratio Feature. Shape

For more information, see Aspect Ratio Intensity Feature. Shape

For more information, see Bkgd Mean Feature. Signal Strength

For more information, see Bkgd StdDev Feature. Signal Strength

  Comparison

For more information, see Bright Detail Intensity R3 and Bright detail Intensity R7 Features. Signal Strength

For more information, see Bright Detail Similarity R3 Feature. Comparison

For more information, see Camera Line Number Feature. System

For more information, see Camera Timer Feature. System

For more information, see Centroid Features. Location

For more information, see Centroid Features. Location

For more information, see Circularity Feature. Shape

For more information, see Compactness Feature. Shape

For more information, see Contrast Feature. Texture

For more information, see Centroid Features. Location

For more information, see Centroid Features. Location

For more information, see Diameter Feature. Size

For more information, see Elongatedness Feature. Shape

For more information, see Elongatedness Feature. Texture

For more information, see Flow Speed Feature. System

For more information, see Gradient Max Feature. Texture

For more information, see Gradient RMS Feature. Texture

For more information, see Height Feature. Size

For more information, see H Texture Features. Texture

For more information, see Intensity Concentration Ratio Feature. Comparison

For more information, see Intensity Feature. Signal Strength

For more information, see Internalization Feature. Comparison

For more information, see Length Feature. Size

For more information, see Lobe Count Feature. Shape

For more information, see Major Axis and Minor Axis Features. Size

For more information, see Major Axis Intensity and Minor Axis Intensity Features. Size

For more information, see Max Contour Position Feature. Location

For more information, see Max Pixel Feature. Signal Strength
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Feature Name Category

For more information, see Mean Pixel Feature. Signal Strength

For more information, see Median Pixel Feature. Signal Strength

For more information, see Min Pixel Feature. Signal Strength

Minor Axis: see For more information, see Major Axis Intensity and Minor Axis Intensity Features. Size

For more information, see Modulation Feature. Texture

For more information, see Object Number Feature. System

For more information, see Objects/mL Feature. System

For more information, see Objects/sec Feature. System

For more information, see Perimeter Feature. Size

For more information, see Spot Intensity Min and Spot Intensity Max Features. Location

For more information, see Raw Intensity Feature. Signal Strength

For more information, see Raw Max Pixel Feature. Signal Strength

For more information, see Raw Mean Pixel Feature. Signal Strength

For more information, see Raw Min Pixel Feature. Signal Strength

For more information, see Raw Median Pixel Feature. Signal Strength

For more information, see Saturation Count Feature. Signal Strength

For more information, see Saturation Percent Features. Signal Strength

For more information, see Shape Ratio Feature. Shape

For more information, see Similarity Feature. Comparison

For more information, see Similarity Feature. Comparison

For more information, see Spot Area Min Feature. Size

For more information, see Spot Count Feature. Texture

For more information, see Spot Distance Min Feature. Location

For more information, see Spot Intensity Min and Spot Intensity Max Features. Signal Strength

For more information, see Std Dev Feature. Texture

For more information, see Symmetry 2, 3, 4 Features. Texture

For more information, see Thickness Max Feature. Size

For more information, see Thickness Min Feature. Size

For more information, see Time Feature. System

For more information, see Valley X and Valley Y Features. Location

For more information, see Width Feature. Size

For more information, see XCorr Feature. Comparison

Base Features- by Category 

Table 15. List of Features by category
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

Size Size-based Features are in microns.      

 

For more information, see Area Feature.

The size of the mask in square microns.

Yes Yes
M01-

M12,MC

 

For more information, see Diameter Feature.

Estimates the diameter of the mask based on Area.

No Yes M01-M12

 

For more information, see Height Feature.

Based on a bounding rectangle, the Width is the smaller side and the 

Height is the longer side of the rectangle.

Yes Yes M01-M12

 

For more information, see Length Feature.

Measures the longest part of the mask.

Yes Yes M01-M12

 

For more information, see Major Axis and Minor Axis Features.

Describes the widest part of the mask and the narrowest part of the 

mask, respectively.

No Yes M01-M12

 

For more information, see Major Axis Intensity and Minor Axis Intensity 

Features.

Based on a bounding ellipse, the Minor Axis is the narrow part and the 

Major Axis is the widest part.

No Yes
M01_Ch01-

M12_Ch12

  Minor Axis:For more information, see Major Axis and Minor Axis Features. No Yes M01-M12

 

For more information, see Perimeter Feature.

Describes circumference of the mask.

No Yes M01-M12

 

For more information, see Spot Area Min Feature.

The Area of the smallest spot in the mask. (See also For more inform-

ation, see Spot Distance Min Feature., For more information, see Spot 

Intensity Min and Spot Intensity Max Features. and For more information, 

see Spot Count Feature..

No No  

 

For more information, see Thickness Max Feature.

Describes the longest width of the mask.

No Yes M01-M12
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 
For more information, see Thickness Min Feature.

Describes the shortest width of the mask.

No Yes M01-M12

 

For more information, see Width Feature.

Based on a bounding rectangle, the Width is the smaller side and the 

Height is the longer side of the rectangle.

Yes Yes M01-M12

Location
Location Features are in X,Y pixel coordinates from an origin in the 

upper left corner, pixels or contour 
     

 

For more information, see Angle Feature.

The angle of the major axis from a horizontal plane in radians.

No No  

 

For more information, see Angle Feature.

The angle of the major axis intensity from a horizontal plane in radi-

ans.

No No  

 

For more information, see Centroid Features.

The central tendency of the pixels along the X Axis and Y Axis, respect-

ively.

No Yes M01-M12

 

For more information, see Centroid Features.

The central tendency of the pixels along the X Axis and Y Axis, respect-

ively, with the pixel intensities weighted.

No Yes
M01_Ch01-

M12_Ch12

 

For more information, see Centroid Features.

The distance between the X or Y Centroids of two images.

No No  

 

For more information, see Centroid Features.

The distance between the Centroids of two images.

No No  

 

For more information, see Max Contour Position Feature.

The location of the contour in the cell that has the highest intensity con-

centration.

No No  
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 

For more information, see Spot Distance Min Feature.

The shortest distance between two components (spots). See also For 

more information, see Spot Area Min Feature., For more information, see 

Spot Intensity Min and Spot Intensity Max Features. and For more inform-

ation, see Spot Count Feature..

Yes No  

 

For more information, see Valley X and Valley Y Features.

The (X,Y) coordinates of the minimum intensity within the skeletal 

lines that are used when creating the Valley Mask.

No No  

Shape
Shape Features define the mask shape and have units that vary with 

the feature. 
     

 

For more information, see Aspect Ratio Feature.

The ratio of the Minor Axis divided by the Major Axis.

Yes Yes M01-M12

 

For more information, see Aspect Ratio Intensity Feature.

The ratio of the Minor Axis Intensity divided by the Major Axis Intens-

ity.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see Circularity Feature.

The degree of the mask’s deviation from a circle.

No No  

 

 

Describes the density of intensities within the object.

No No  

 

For more information, see Elongatedness Feature.

The ratio of the Height/Width which use the bounding box.

No Yes M01-M12

 

For more information, see Lobe Count Feature.

The number of lobes in a cell. (Also see Symmetry)

No No  

 

For more information, see Shape Ratio Feature.

The ratio of Thickness Min/Length features.

No Yes M01-M12
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 

For more information, see Symmetry 2, 3, 4 Features.

These three features measure the tendency of the object to have a 

single axis of elongation, a three-fold and a four-fold variation of the 

shapes. See also For more information, see Lobe Count Feature.. 

No No  

Texture
Texture features measure pixel or regional variation and indicate the 

granularity or complexity of the image. 
     

 

For more information, see Bright Detail Intensity R3 and Bright detail Intens-

ity R7 Features.

The Intensity of the pixels in the bright detail image using a 3 or 7 pixel 

structuring element. Also, see For more information, see Spot Mask. for a 

description of the bright detail image.

Yes 

(R3)

No 

(R7)

Yes
MC_Ch1-

MC_Ch6

 

For more information, see Contrast Feature.

Enumerates changes of pixel values in the image to measure the 

focus quality of an image.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see Gradient Max Feature.

The maximum slope of the pixel value changes in the image to meas-

ure focus quality of an image.

No Yes
M01_Ch01-

M12_Ch12

 

For more information, see Gradient RMS Feature.

Enumerates changes of pixel values in the image to measure the 

focus quality of an image.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see H Texture Features.

Measures Haralick texture features.

No Yes 

M01_Ch01_

5-M12_

Ch12_5

 

For more information, see Modulation Feature.

Measures the intensity range of an image, normalized between 0 and 

1.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see Spot Count Feature.

Enumerates the number of spots. 

See also For more information, see Spot Distance Min Feature., For more 

information, see Spot Area Min Feature., and For more information, see 

Spot Intensity Min and Spot Intensity Max Features..

No No  
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 

For more information, see Std Dev Feature.

Describes the overall distribution of pixel intensities. 

No Yes
M01_Ch01-

M12_Ch12

Signal 

Strength
Signal Strength Features are measured in pixel values.      

 

For more information, see Bkgd Mean Feature.

The average intensity of the camera background.

Yes Yes
Ch01-

Ch12

 

For more information, see Bkgd StdDev Feature.

The standard deviation of the background intensities.

No Yes Ch01-Ch12

 

For more information, see Intensity Feature.

The sum of the pixel intensities in the mask, background subtracted.

Yes Yes
MC_Ch01-

MC_Ch12

 

For more information, see Max Pixel Feature.

The largest pixel value within the mask, background subtracted.

Yes Yes
MC_Ch01-

MC_Ch12

 

For more information, see Mean Pixel Feature.

The average pixel value within the mask, background subtracted.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see Median Pixel Feature.

The median pixel value within the mask, background subtracted.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see Min Pixel Feature.

The smallest pixel value within the mask, background subtracted.

No No  

 

For more information, see Raw Intensity Feature.

The sum of the pixel intensities within the mask.

No No  

 

For more information, see Raw Max Pixel Feature.

The largest pixel intensity. 

Yes Yes
MC_Ch01-
MC_Ch12
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 

For more information, see Raw Mean Pixel Feature.

The average pixel intensity: Raw does not have background sub-
tracted. 

No No  

 

For more information, see Raw Median Pixel Feature.

The median pixel intensity. 

No No  

 

For more information, see Raw Min Pixel Feature.

The lowest pixel value within the mask.

Yes Yes
MC_Ch01-

MC_Ch12

 

For more information, see Saturation Count Feature.

The number of pixels in the mask that are saturated.

Yes Yes
M01_Ch01-

M12_Ch12

 

For more information, see Saturation Percent Features.

The Percentage of pixels in the mask that are saturated.

Yes Yes  

 

For more information, see Spot Intensity Min and Spot Intensity Max 

Features.

The raw intensity (not background subtracted) of the dimmest com-

ponent (spot).

See also For more information, see Spot Count Feature., For more inform-

ation, see Spot Distance Min Feature., and For more information, see Spot 

Area Min Feature..

No No  

Comparison Difference of intensity measurements between masks or pixels.      

 

Bright Detail Colocalization 3

Measures the colocalization of 3 image channels

No No  

 

For more information, see Bright Detail Similarity R3 Feature.

Measures the correlation of the bright details between image pairs.

No No  

 

For more information, see Intensity Concentration Ratio Feature.

Given two masks, the ratio of the intensity in one mask to the total 

intensity in both masks.

No No  
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 

For more information, see Internalization Feature.

The ratio of the intensity inside the cell to the intensity of the entire 

cell.

No No  

 

For more information, see Similarity Feature.

The Similarity is a measure of the degree to which two images are lin-

early correlated pixel by pixel within a masked region.

No No  

 

For more information, see XCorr Feature.

The XCorr is a measure of the degree to which two images fre-

quencies are cross correlated.

No No  

System
System features do not require a mask and tend to deal with system 

wide metrics. 
     

 

For more information, see Camera Line Number Feature.

An incremental count of objects. 

No Yes  

 

For more information, see Camera Timer Feature.

The clock rate in KHz. This is relative time. 

No Yes  

 

For more information, see Flow Speed Feature.

The calculated flow speed in mm/sec. 

Yes Yes  

 

For more information, see Object Number Feature.

The sequence of objects.

Yes Yes  

 

For more information, see Objects/mL Feature.

A local concentration of all objects per ml. 

Note: to get objects per ml of a population, use the statistic ‘Con-

centration’.

No Yes  

 

For more information, see Objects/sec Feature.

A local concentration of number of objects per second. Note: to get 

objects per ml of a population, use the statistic ‘Concentration’

No Yes  
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Feature 

Name
Category

In 

Defau-

lt Tem-

plate?

In 

Expan-

ded 

Defau-

lt Tem-

plate?

Mask_

Image 

Used in 

Default 

Tem-

plate                     

 

For more information, see Time Feature.

The camera timer feature, converted to seconds.

Yes Yes  

Combined Any combined feature will be listed under Combined No No  

Table of Basic Features available for FlowSight® without QI

The default masks used for FlowSight® Basic (non-QI) files is the INSPIRE™ mask.

Table 16. FlowSight® Basic Features 

Feature 
Mask_Chan-

nel
Brief definition

Area M01-GM, MC The size of the mask in square microns.

Aspect Ratio M01-M12 The ratio of the Minor Axis divided by the Major Axis.

Bkgd Mean Ch01-Ch12 The average intensity of the camera background.

Bkgd StdDev Ch01-Ch12 The standard deviation of the background intensities.

Camera Line Num-

ber
none An incremental count of objects.

Gradient RMS
M01_Ch01- M12_

Ch12

Enumerates changes of pixel values in the image to measure the focus quality 

of an image.

Intensity
MC_Ch01 - MC_

Ch12
The sum of the pixel intensities in the mask, background subtracted.

Minor Axis M01-M12 Describes the narrowest part of the mask.

Object Number none The sequence of objects.

Raw Centroid X

Raw Centroid Y

none The central tendency of the pixels along the X Axis and Y axis respectively

Raw Max Pixel
MC_Ch01- MC_

Ch12
The largest pixel value.

Raw Min Pixel
MC_Ch01 - MC_

Ch12
The lowest pixel value.

Uncompensated 

Intensity

MC_Ch01- MC_

Ch12

The sum of the pixel intensities in the mask, background subtracted, no com-

pensation applied.
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Understanding the Size Features

Size features are in microns and include Area, Diameter, Length, Major Axis, Minor Asix, Major Axis Intensity, Minor 

Axis Intensity, Perimeter, Thickness Max and Min, Spot Area Min, Width and Height.

Area Feature

The number of microns squared in a mask is equal to the Area. In the following figure, a 1 symbolizes whether the area 

is included in the mask. The number of pixels is converted to µm2. Note that 1 pixel = 0.25 µm2. As an example, a cell 

with a mask that includes 2000 pixels is therefore equal to 500 µm2.

Application Examples:

 l Quantify and compare cell size.

 l Identify single cells.

 l Calculate the radius, diameter and volume of the cell.

 l Identify apoptosis using the Area of the 30% threshold mask of a nuclear dye.

 l Create a pseudo FSC va. SSC plot for comparing with flow cytometry.
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Diameter Feature

The Diameter feature provides the diameter of the circle that has the same area as the object. The accuracy of the dia-

meter is highly dependent on a close fitting mask and roundness of the cell. 

The images below depicts beads with a uniform diameter of 9 microns.

In the next figure, note that images with longer shapes that have the same area will have the same diameter value.

Application Example:  

 l Used to obtain approximate size of the cell.
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Height Feature

Using the bounding rectangle, Height is the number of microns of the longer side and Width the shorter side. For more 

information, see Elongatedness Feature.

Application Example:

 l These features can be used to separate rectangular shaped objects. For curved objects, measurement is more 

accurately obtained using the thickness features.

Length Feature

Length measures the longest part of an object. Unlike the Major Axis feature, Length can measure the object's length 

even if it folds to form a cashew, banana, or doughnut shape, where in many of these cases the major or minor axis fea-

tures would not be able to differentiate these with true circular shaped objects with no hole.

This feature is based on an input mask and is sensitive to the variation of the input mask shape. Selecting an input mask 

that can accurately capture the object shape is important. For more information, see Shape Ratio Feature., see Base Features- 

by Category , and see Thickness Max Feature.
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Major Axis and Minor Axis Features

The Major Axis is the longest dimension of an ellipse of best fit. The Minor Axis is the narrowest dimension of the ellipse 

of best fit. For more information, see Aspect Ratio Feature.

Application Examples:

 l Quantify and compare cell shape.

 l Identify small, medium, and large cells.

Major Axis Intensity and Minor Axis Intensity Features

The Major Axis Intensity is the longest dimension of an ellipse of best fit and is intensity weighted. The Minor Axis Intens-

ity is the narrowest dimension of the ellipse of best fit and is intensity weighted. 
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The figure below illustrates the difference between intensity weighted and non-intensity weighted Major or Minor Axis 

and Aspect Ratio. For more information, see Aspect Ratio Intensity Feature.

Application Examples:

 l Quantify and compare the image fluorescence shape.

 l Identify single cells.

Perimeter Feature

The perimeter feature measures the boundary length of the mask in the number of microns. 

This example uses a 1-pixel wide mask created to illustrate how a perimeter would appear.
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Application Examples:

 l Quantify and compare cell circumference.

 l Identify cells with highly irregular surfaces from smooth cells.

 l Perimeter of the morphology or threshold masks can identify cells with or without dendrites.

Spot Area Min Feature

The Spot Area Min feature provides the area of the smallest spot (connected component) in a spot or peak mask. 

This is one of four features that can be used to identify objects with spots that are close together, dim, bright or small 

when counting spots in an image. To use these features, the spots need to be individually masked, such as using the Spot 

or Peak Mask. The Spot Area Min, Spot Distance Min, and Spot Intensity Min or Max features measure properties of dif-

ferent spots in an image and are often used with the Spot Count feature (under Texture).  For more information, see Spot 

Distance Min Feature.For more information, see Spot Count Feature.For more information, see Spot Intensity Min and Spot Intens-

ity Max Features.

 

 l Spot Area Min is the Area of spot 1

 l Spot Distance Min is distance 2 in microns

 l Spot Intensity Max is the Raw Mean Pixel of spot 2

 l Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

 l In FISH Spot Counting, these features are used to identify objects with ambiguous spots that are located too 

close together, are too dim to count or are too small in order to remove these objects from the analysis.
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Thickness Max Feature

Thickness Max measures the largest width of an object. This feature is based on an input mask and therefore sensitive 

to the variation of the input mask shape. Selecting an input mask that can accurately capture the object shape is import-

ant. For more information, see Base Features- by Category . see Shape Ratio Feature.

Thickness Min Feature

Thickness Min measures the smallest width of an object. This feature is based on an input mask and therefore sensitive 

to the variation of the input mask shape. Selecting an input mask that can accurately capture the object shape is import-

ant. For more information, see Shape Ratio Feature.

Width Feature

Using the bounding rectangle, Width is the number of microns of the smaller side and Height the longer side. For more 

information, see Elongatedness Feature.

Application Example:

 l These features can be used to separate rectangular shaped objects. For curved objects, measurement is more 

accurately obtained using the thickness features.
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Understanding the Location Features

Location features include Angle, Angle Intensity, Centroid X, Centroid Y, Centroid X Intensity, Centroid Y Intensity, Delta 

Centroid X, Delta Centroid Y, Delta Centroid XY, Max Contour position, Spot Distance Min, Valley X and Valley Y.

Angle Feature

Angle is the angle of the major axis from a horizontal plane in radians.

Application Example: 

 l Identify the orientation of an image relative to the image frame.

Angle Intensity Feature

Angle Intensity is the angle of the major axis intensity from a horizontal plane in radians.

Application Example:

 l Identify the orientation of an image relative to the image frame.
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Centroid Features

Centroid X and Centroid Y Features

Centroid X is the number of pixels in the horizontal axis from the upper, left corner of the image to the center of the 

mask. Centroid Y is the number of pixels in the vertical axis from the upper, left corner of the image to the center of the 

mask. 

In this example, the Centroid X=54 and the Centroid Y=32.

Application Examples:

 l Identify the center of the mask.

 l Calculate the Delta Centroid or the distance between two fluorescent markers.

 l Used by IDEAS® to calculate the Delta Centroid X, Y, or XY.
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Centroid X Intensity and Centroid Y Intensity Features

Centroid X Intensity is the intensity weighted X centroid and is shifted from the center of the mask toward the center of 

fluorescence. The Centroid Y Intensity is the intensity weighted Y centroid.  X and Y pixel coordinates are calculated from 

an origin in the upper left corner.

Application Examples:

 l Identify the center of peak fluorescence.

 l Calculate the distance between two fluorescent markers.

 l Used by IDEAS® to calculate the intensity weighted Delta Centroid X, Y or XY.

Delta Centroid X and Delta Centroid Y Features

Both the Delta Centroid X and Y features measure the distance between the Centroids X or Centroids Y, respectively, of 

two images using the user-provided masks for each image. Either one or both the centroids of the images may be intens-

ity-weighted. X and Y pixel coordinates are calculated from an origin in the upper left corner to obtain the centroid pos-

itions and the distance between the centroids is converted to microns.
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An example is shown below.

 

The graph below illustrates using the Delta Centroid X versus Delta Centroid Y to identify cells with a variation of loc-

ation of a protein with respect to the nucleus.

Cells with no spatial shift of signal between the nuclear stain(Ch6) and protein of interest(Ch4) have a low Delta Cen-

troid X and Y and are found in the lower left corner. Cells with a large shift between the images in both the X and Y dir-

ection are found in the upper, right section and those with a large shift in X but not Y are found in the lower, right. 

Similarly a cell with a large shift in the Y direction and not X are found in the upper, left.  For more information, see Delta Cen-

troid XY Feature.
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Application Example:

 l Used to identify capped versus not capped cells.

 l Used to measure shifts in X or Y direction between two images.

Delta Centroid XY Feature

The Delta Centroid XY feature measures the distance between the Centroid feature of two images using the user-

provided masks for each image. Either one or both the centroids of the images may be intensity-weighted. X and Y pixel 

coordinates are calculated from an origin in the upper left corner to obtain the centroid positions and the distance 

between the centroids is converted to microns. In the example, below an image pair is shown stained with the nuclear 

dye Draq 5 and a PE labeled antibody that is differentially expressed two cells, either uniformly or in the pseudopod. The 

two cells are identified by their different Delta Centroid XY values.
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Below is an example of using the Delta Centroid XY. A bivariate graph of a shape ratio versus Delta Centroid XY can 

identify cells with caps as shown here:

Application Examples:

 l Quantify the spatial relationship between two fluorescent probes.

 l Identify false apoptotic positive cells in the TUNEL and Annexin V assays.

 l Quantify shape change.

 l Quantify capping of cell surface antigens.

Raw Centroid X  and Raw Centroid Y Features

The centroid X and Y of the original position of the image during acquisition before it was centered IDEAS®. Data ana-

lyzed in IDEAS versions 4.0 or later cut and center objects that were collected as one image in INSPIRE™.

Max Contour Position Feature

The Max Contour Position is defined as the location of the contour in the cell that has the highest intensity concentration. 

It is invariant to object size and can accommodate localized intensity concentrations. The actual location in the object is 

mapped to a number between 0 and 1, with 0 being the object center and 1 being the object perimeter, which allows one 

to compare the results across cells of different sizes. An example is shown below. 
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Application Example:

 l Used in conjunction with the Internalization feature to determine the distribution of intensity within a cell.

Shift X and Shift Y Features

The Shift X or Shift Y feature is the location of the highest cross-correlation of a pair of images. When two identical 

images are aligned perfectly the cross-correlation is at it's maximum. The shift X or Shift Y is the shift required to get the 

highest cross-correlation value for the 2 images. This feature is used mainly for troubleshooting cross-camera align-

ment.

Spot Distance Min Feature

The Spot Distance Min feature provides the shortest distance in microns between two spots (connected components) in 

a spot or peak mask. 

This is one of four features that can be used to identify objects with spots that are close together, dim, bright or small 

when counting spots in an image. To use these features, the spots need to be individually masked, such as using the Spot 

or Peak Mask. The Spot Area, Distance, and Spot Intensity Min or Max features measure properties of different spots in 

an image and are often used with the Spot Count feature (under Texture).  For more information, see Spot Area Min Feature. 

For more information, see Spot Count Feature. For more information, see Spot Intensity Min and Spot Intensity Max Features.
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 l Spot Area Min is the Area of spot 1

 l Spot Distance Min is distance 2 in microns

 l Spot Intensity Max is the Raw Mean Pixel of spot 2

 l Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

 l In FISH Spot Counting, these features are used to identify ambiguous spots that are located too close together, 

too dim, to bright or too small to count  and can be eliminated from the analysis.

Valley X and Valley Y Features

The Valley X and Y are the exact X,Y coordinates of the minimum intensity within the skeletal lines of the input mask. 

The objects condensed shape, typically 1-pixel wide skeletal line is determined from the starting mask. This is also the ori-

gin of the Valley mask. For more information, see Valley Mask.For more information, see Skeleton Mask.
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In the figure below, the Valley X and Valley Y position of the 7AAD image is shown. In this example a protein of interest 

in the PE image localizes to the synapse between two cells.

These features define the origin of the Valley mask.

Application Example:

 l Measure the exact center of where a synapse between two cells is located.
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Understanding the Shape Features

Shape features define the mask shape and have units that vary with the feature. They include the Aspect Ratio, Aspect 

Ratio Intensity, Compactness, Elongatedness, Lobe Count, and Symmetry 2,3,4. 

Aspect Ratio Feature

Aspect Ratio is the Minor Axis divided by the Major Axis and describes how round or oblong an object is. For more inform-

ation, see Major Axis and Minor Axis Features.

For more information, see Elongatedness Feature. and see Shape Ratio Feature for other shape ratios.

173

IDEAS® Image Data Exploration and Analysis Software User's Manual



Application Examples:

 l Quantify the roundness of the mask.

 l Identify single cells vs. doublets.

 l Cell classification based on shape change.

 l Identify recently divided cells in mitosis.

Aspect Ratio Intensity Feature

Aspect Ratio Intensity is the Minor Axis Intensity divided by the Major Axis Intensity. For more information, see Major Axis 

Intensity and Minor Axis Intensity Features..

The figure below illustrates the difference between Aspect Ratio Intensity and Aspect Ratio. For more information, see 

Aspect Ratio Feature..

Application Examples:

 l Quantify the roundness of the fluorescent image.

 l Better resolution for identifying single cells vs. doublets in experiments using a DNA dye.

 l Cell classification based on fluorescent morphology.
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Circularity Feature

This feature measures the degree of the mask’s deviation from a circle. Its measurement is based on the average dis-

tance of the object boundary from its center divided by the variation of this distance. Thus, the closer the object to a 

circle, the smaller the variation and therefore the feature value will be high. Vice versa, the more the shape deviates 

from a circle, the higher the variation and therefore the Circularity value will be low.  

Below is an example using Circularity and Compactness to characterize the shape of peripheral blood mononuclear cells 

stained with the DNA dye Draq 5.

 l Distinguish singlets and doublets.

 l Separate circular and non circular shapes.

 l  For more information, see Shape Change Wizard.
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Compactness Feature

Compactness measures the degree of how well the object is packed together. This feature is similar to the Circularity 

feature but unlike Circularity, this feature includes all of the pixels within the mask and is intensity weighted. The higher 

the value, the more condensed the object. 

Below is an example using Circularity and Compactness to characterize the shape of peripheral blood mononuclear cells 

stained with the DNA dye Draq 5.

Application Example: 

 l Differentiate between rounded objects with smooth boundary to less regular objects.
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Elongatedness Feature

Elongatedness is the ratio of the Height over Width of the object’s bounding box. For more information, see Width Feature.

For more information, see Aspect Ratio Feature. and see Shape Ratio Feature for other shape ratios.

Application Examples:

 l Measure object shape properties to differentiate between long and narrow versus short and thick objects.

 l Quantify the roundness of the morphology mask.

 l Identify single cells and doublets.

 l Cell classification based on shape change.

 l Identify recently divided cells in mitosis.
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Lobe Count Feature

The Lobe Count feature counts the number of lobes in a cell. It is determined based on the maxima of the weighted Sym-

metry features. The feature reports the values 1,2,3 or 4. If an object does not have a high value for Symmetry 2, Sym-

metry 3, or Symmetry 4 it is reported as 1 for no lobes. An example is shown below.  For more information, see Symmetry 2, 

3, 4 Features.

Application Example:

 l Used in cell classification studies. Also used to differentiate small round cells from small square cells of similar 

area.

Shape Ratio Feature

The Shape Ratio is Thickness Min divided by Length. 
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The Shape Ratio feature is based on an input mask and is sensitive to the variation of the input mask shape. Selecting an 

input mask that can accurately capture the object shape is important.

For more information, see Aspect Ratio Feature. and see Elongatedness Feature for other shape ratios.

Application Example: 

 l Measure object's elongatedness to provide shape classification.

Symmetry 2, 3, 4 Features

The Symmetry 2 feature measures the tendency of the object to have a single axis of elongation and therefore 2 lobes. 

The Symmetry 3 feature measures the tendency of the object to have a three-fold axis of symmetry and likewise, Sym-

metry 4 a four-fold axis. The absolute value of these features are dependent on the number of lobes. For example an 

image that has high 4 lobe symmetry will also have high 2 lobe symmetry.  For more information, see Lobe Count Feature.
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Application Example:

 l Classify different white blood cells based on the morphology of the nuclear image.

Understanding the Texture Features

The Texture features determine local intensity variations in images and include Bright Detail Intensity R3 and Bright 

Detail Intensity R7, Contrast, Gradient Max, Gradient RMS, H Texture (H-Contrast, H-Correlation, H-Energy, H-Entropy, 

H-Homogeneity, and H-Variance), Modulation, Spot Count, and Std Dev. 

Contrast, Gradient Max and Gradient RMS are generally used to determine best focus.

Bright Detail Intensity R3 and Bright detail Intensity R7 Features

The Bright Detail Intensity R3 and Bright Detail Intensity R7 features compute the intensity of localized bright spots 

within the masked area in the image. Bright Detail Intensity R3 computes the intensity of bright spots that are 3 pixels in 

radius or less, while Bright Detail Intensity R7 computes the intensity of bright spots in the image that are 7 pixels in 

radius or less. In each case, the local background around the spots is removed before the intensity computation.

The figure below shows the process of obtaining the localized bright spots in the image.

180

IDEAS® Image Data Exploration and Analysis Software User's Manual



The graph below illustrates the use of the Bright Detail Intensity R3 feature on a nuclear image to separate apoptotic 

cells from non-apoptotic cells.

Application Example: 

 l Identify cells that have bright specks such as Apoptotic cells.

 l Used in the Cell Cycle - Mitosis Wizard.
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Contrast Feature

The Contrast feature measures the sharpness quality of an image by detecting large changes of pixel values in the 

image and is useful for the selection of focused objects or apoptotic brightfield images. For every pixel, the slopes of the 

pixel intensities are computed using the 3x3 block around the pixel. This is similar to the Gradient RMS calculation with 

different weighted assignments to the pixel arrays with no background subtraction. Example images are shown in the fig-

ure below. 

Application Examples:

 l Find apoptotic images with high contrast in brightfield imagery.

 l Determine overall focus quality of images. 

 l Use with Gradient RMS to determine focus quality.

 l Characterize texture. 

For more information, see Gradient Max Feature. and see Gradient RMS Feature

Ensquared Energy Feature

The Ensquared Energy feature is a measure of image quality. Computes the intensity of the square block around the 

brightest pixel using the diameter input as the side for the square divided by the intensity of the total intensity. The closer 

this ratio is to 1.0 the better focused the image. This feature is mainly used for single, uniform particles such as beads.

The figure below shows the image quality test using the Ensquared Energy feature.

Gradient Max Feature

The Gradient Max feature measures the sharpness quality of an image by detecting largest change of pixel values in the 

image and is useful for the selection of focused objects. 
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This figure shows the change in intensity across the red line. The top image has a larger slope change than the lower 

image.

Application Example:

 l Determine peak focus quality of images. 

 l Also used to characterize texture. However, the Gradient RMS and Contrast feature are more robust for these 

applications.

For more information, see Gradient RMS Feature. and see Contrast Feature. 
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Gradient RMS Feature

The Gradient RMS feature measures the sharpness quality of an image by detecting large changes of pixel values in the 

image and is useful for the selection of focused objects. The Gradient RMS feature is computed using the average gradi-

ent of a pixel normalized for variations in intensity levels. This is similar to the Contrast calculation with different 

weighted assignments to the pixel arrays and with background subtracted. Example images are shown in the figure 

below.

Application Examples:

 l Determine overall focus quality of images. 

 l Used with Contrast to determine focus quality.

 l Characterize texture. 

For more information, see Gradient Max Feature. and see Contrast Feature. 

H Texture Features

H Texture features include the following: H Energy Mean and Std, H Entropy Mean and Std, H Contrast Mean and Std, H 

Homogeneity Mean and Std, H Correlation Mean and Std, H Variance Mean and Std Features.

The user defines the texture grain by assigning a granularity value. For very fine textures, this value is small (1-3 pixels), 

while for very coarse textures, it is large (>10). In the IDEAS® default template, the granularity value is 5. 

While these features have value for distinguishing cellular texture when used individually, images often contain a mix-

ture of different textures at different grains. Therefore, these features are most powerful when combined. 
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Texture features are used to determine if pixel values in an image follow a pattern or are randomly distributed. An 

image with random grayscale values might look like a gray color swatch with individual pixel values ranging from the min 

to the max centering on a mean. If light and/or dark patterns are visible, it means the pixel values are not randomly dis-

tributed and some texture has emerged.  So texture features can be thought of as measuring the presence or absence of 

randomness.  If pixel values are non-random, then defined patterns are likely to be present in the image. Patterns in the 

image may be biologically significant, such as the clustering of LC3 proteins from a random distribution in the cytoplasm 

as cells enter autophagy, or formation of H2AX clusters in DNA damage and repair studies.

The Haralick texture features are a set of texture features based on the 2nd order statistics computed from the joint 2-D 

probability distribution of pixel intensities in the image. This distribution is referred to as the Gray Level Co-occurrence 

Matrix (GLCM).  To understand how this matrix works, consider the outcome of two dice thrown on a table. The prob-

ability matrix in this case is 6 possible outcomes from the first die and 6 from the second, or 36 possible combinations.  

There are 6 possible doubles and the odds of rolling them are 6/36 or 16.7%. To analyze the texture of images, a sim-

ilar probability matrix can be used to determine if pixels in a given neighborhood occur randomly or (like the toss of two 

dice) are somewhat predictable.  If pixels in an image have a high level of co-occurrence, then there is likely some sort of 

detectable pattern.

Texture features in IDEAS are calculated in a four step process by first converting the pixel data to 8 bits, then applying 

the granularity to calculate the GLCM, next computing the 6 Haralick texture features and finally outputting the mean 

and standard deviation for each of the 6 texture features.

The first step in the three step process is to convert the raw 12 bit image under the bounding mask into a 4 bit image. 

This is done so that the GLCM does not have too many 0 entries which will ensure a more robust estimate of the texture 

and reduce the noise. This effectively bins the raw data into 2^4 or 16 bins with resulting values between 0 and 15. For 

full range images that have pixel values between 0 and 4096 this would bin pixels by 16/4096 or 256 counts, such that 

pixels between 4096 and 3840 would be assigned a value of 15, pixels between 3840 and 3584 would be assigned 14, 

and so on.

Second the granularity is applied to the feature to calculate the GLCM. In IDEAS the granularity defines the distance 

from the anchor pixel to the pixel array used to calculate the texture features. A granularity of 1 would pair the anchor 

pixel with those 1 pixel above, below, right, left and on the angles. The default granularity in IDEAS is set to 5 and for 40x 

imagery this would mean the texture features are comparing pixel pairs 2.5 um away from the anchor pixel
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Next the GLCM is calculated by comparing neighboring pixel values and calculating how uniform or variant those values 

are. The GLCM is a function of the texture granularity d and orientation, q.  The entry pij in the ith row and jth column of 

the GLCM matrix is defined as the probability of having pixel pairs in the image with intensities {i,j} at a distance d from 

each other along an orientation q. Thus, the GLCM is an N x N matrix, where N is determined by the range of intensities 

in the cell. For very fine textures, granularity d is typically very small – about 1-2 pixels. For medium textures, d is about 4-

8. For very coarse textures, d can be very large, about 12-16 pixels. The specific value of the orientation q is less import-

ant in our applications since we are not interested in the actual orientation of the texture, but only if orientation exists. 

For this reason, we compute the GLCM for a number of orientations {0, 45, 90, 135, 180, 225, 270, 315 degrees}. Assum-

ing symmetry in orientation, we combine the orientations (0,180), (90,270), (45,225) and (135,315) to obtain 4 separate 

matrices.

Finally the mean and standard deviation (std) of each texture feature are calculated where the mean is the average 

value at each of the four orientations theta, and the standard deviation is the variation of those values. The mean texture 

values are good indicators of the average texture in the cell, while the standard deviations are good indicators of ori-

entation in the texture. Large standard deviation values indicate that some directions have very different textures from 

other directions.

Texture features have been useful for analyzing changes in staining patters for applications like LC3 clustering in cells 

progressing through autophagy, H2Ax foci formation in DNA damage and repair studies, nuclear condensation and frag-

mentation in apoptotic assays, changes in mitochondrial membrane potential and other applications where a given treat-

ment induces changes in a fluorochromes pattern of staining. For a more detailed description of the Haralick features 

see the paper referenced below.

1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Classification", IEEE Transactions on Sys-

tems, Man, and Cybernetics, Vol. SMC-3, 1973, pp. 610-621.
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Contrast measures the intensity variation in a cell. A high mean value indicates that neighboring pixels tend to have very 

different intensity values, and would describe an image with lots of adjacent light and dark areas. Contrast will range 

between 0 and 1.
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Correlation measures how similar pixel pairs are, and is the opposite of contrast.  Images with high correlation will be 

very uniform and lack variant texture.
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Energy is a measure of intensity concentration in the cell. At one extreme is the case where we have a uniform dis-

tribution with all probabilities being equal. This image likely has several intensity variations with no noticeable con-

centration of high intensity and thus has low energy. At the other extreme is the case where we have a very narrow 

distribution with a few elements having high values. This image will have notable intensity concentrations and thus, has 

high energy.
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Entropy is also a measure of high intensity concentration in the cell. However, this feature relates to the randomness of 

the intensities in the image. Images that have distinct areas of intensity concentration are less random and thus, have 

low entropy. Images that have a range of equally likely intensity pairings have less distinct intensity concentrations, and 

correspondingly, have higher entropy. Entropy is the opposite of energy.
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Homogeneity is a measure of how close pixels value are, if pixel pairs are the same or similar then a high homogeneity 

value is given. If there are very few pixels with the same value, then a lower homogeneity score is generated. Images 

with high homogeneity would look very uniform and lack texture. Homogeneity is the inverse of contrast and very similar 

to correlation.
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Variance measures the spread of pixel values within the granularity. Images with high variance values will have a large 

spread in pixel intensities visually identified by very dark and very bright spots throughout the image.

Application Example:

 l Quantify texture in cells.

1Haralick, R.M., K. Shanmugan, and I. Dinstein, "Textural Features for Image Classification", IEEE Transactions on Systems, 

Man, and Cybernetics, Vol. SMC-3, 1973, pp. 610-621.
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Modulation Feature

The Modulation feature measures the intensity range of an image, normalized between 0 and 1. 

The formula is: Modulation = Max Pixel - Min Pixel / Max Pixel + Min Pixel

The following example illustrates Modulation on brightfield images and Intensity of scatter in channel 1. 

High Modulation

 

Low Modulation

Application Example: 

 l Quantify image quality and characterize contrast and texture in cells.
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Spot Count Feature

The Spot Count feature provides the number of connected components in an image. The connected component 

algorithm examines the connectivity of each pixel based on whether this pixel is connected to a particular spot or the 

background. In order to count the number of connected components the mask input is very important. For more inform-

ation, see Spot Mask. For more information, see Peak Mask. and For more information, see Range Mask. for information on 

masking spots. For more information, see Spot Area Min Feature. For more information, see Spot Distance Min Feature. and For 

more information, see Spot Intensity Min and Spot Intensity Max Features. 

The following figure illustrates the application of Spot Counting to quantify parasitic infection of Babesia in erythrocytes 

by staining nuclei with YOYO (green).

Connectivity Option

The spot count feature offers a choice of 4 or 8 connectivity for the connected components algorithm. This option 

determines how a component is defined based on connected pixels. 
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The default selection, 4-connectivity (left), only considers neighbor pixels oriented vertically or horizontally from the 

pixel of interest. Pixels are included in the component if the are touching on the diagonal when the option eight is chosen.

Application Examples:

 l Counting parasites.

 l Counting phagocytosed particles.

 l FISH spot counting.

 l Counting punctate spots in images.

 l For more information, see Spot Wizard.

Std Dev Feature

The Std Dev feature describes the overall distribution of pixel intensities.

The Std Dev is the standard deviation of the pixel intensity values in the mask. The Std Dev value provides an indication 

of the texture or complexity of an object.
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The following illustrates that apoptotic cells (AnxnV positive) exhibit higher Std Dev values in the darkfield channel (scat-

ter) and higher brightfield Modulation values than non-apoptotic cells (AnxnV negative). 

Application Example: 

 l Quantify intensity variation within a mask.

 l Distinguish apoptotic and necrotic cells.

Understanding the Signal Strength Features

Signal Strength features include the following: 

 l Bkgd Mean and Bkgd StdDev features describe the background of the image.

 l Intensity and Raw Intensity features quantify the intensities in the region of interest. 

 l Raw Max, Raw Min, Raw Mean and Raw Median Pixel report single pixel values in an image.

 l Max, Min, Mean and Median Pixel report background subtracted single pixel values in an image. 
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 l Saturation Count and Saturation Percent quantify the saturated pixels.

 l Spot Intensity Min is used when counting spots.

NOTE: When the name includes ‘Raw’, this means that there is no background subtraction.

Bkgd Mean Feature

The Bkgd Mean feature estimates the average camera background level in an image by taking the mean of the back-

ground pixels. 

Application Examples:

 l Obtain estimate of the mean camera background level. 

 l Compute background-subtracted pixel values in other feature computations.

Bkgd StdDev Feature

The Bkgd Std Dev feature estimates the standard deviation of the camera background level in an image computed using 

the background pixels.

Application Example: 

 l Obtain estimate of the camera background noise. 
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Intensity Feature

The Intensity feature is the sum of the background subtracted pixel values within the masked area of the image.

Application Examples:

 l Quantify relative levels of fluorescence between cells and within different regions of the same cell.

 l Immunophenotyping.

 l Cell cycle analysis.

 l Protein expression.

 l Protein activation.

Max Pixel Feature

The Max Pixel feature is the largest value of the background-subtracted pixels contained in the input mask. An example 

plot is shown below that demonstrates the advantage of using this feature over the Intensity feature for identifying true 

positive events. For a concentrated signal, Max Pixel is more sensitive than Intensity as shown in the figure below.
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The relationship of Max, Mean, Median, and Min Pixel is shown in the figure below:

Application Examples:

 l Used to estimate the true peak fluorescence activity. Is preferred over the Raw Max Pixel for this application. 

 l Max Pixel to Mean Pixel ratio identifies bright punctate staining vs. uniform staining.

Mean Pixel Feature

The Mean Pixel feature is the mean of the background-subtracted pixels contained in the input mask. This is computed 

as Intensity/number of pixels. 
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The relationship of Max, Mean, Median and Min Pixel is shown in the figure below:

Application Examples:

 l Estimate the average fluorescence activity. This feature is preferred over the Raw Mean Pixel feature.

 l Quantify relative levels of mean fluorescence between cells.

 l Identify bright punctate spots by calculating the max to mean pixel ratio.

 l Track internalization of surface bound antibodies.

Median Pixel Feature

The Median Pixel feature is the median of the background-subtracted pixels contained in the input mask. It is more 

robust than the mean as an estimate of the average fluorescence since it is less influenced by outliers. 

201

IDEAS® Image Data Exploration and Analysis Software User's Manual



The relationship of Max, Mean, Median and Min Pixel is shown in the figure below:

Application Example:

 l Estimate the average fluorescence activity. This feature is preferred over the Raw Median Pixel feature.
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Min Pixel Feature

The Min Pixel feature is the smallest value of the background-subtracted pixels contained in the input mask. There will 

be some negative numbers due to the background subtraction, therefore the Raw Min Pixel feature is preferred.

Application Examples:

 l Obtain the minimum value in an image after background subtraction. Very likely to be negative in brightfield 

imagery.

 l Quantify spectral absorbance using the brightfield image.

 l Identify over compensated images.

Raw Intensity Feature

The Raw Intensity feature is the sum of the pixel values within the mask including camera background. 

Application Example:

 l Estimate raw fluorescence activity. This feature is less relevant than the Intensity feature because it includes 

camera background intensity.
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Raw Max Pixel Feature

The Raw Max Pixel feature is the largest value of the pixels contained in the input mask. 

 

Application Examples:

 l Determine the presence of saturated events. 

 l May also be used to estimate the peak fluorescence activity, though the Max Pixel feature is recommended for 

this application. 

 l Measure the maximum pixel value within the mask.

 l Identify cells that saturate the CCD, Saturation Count feature can also be used for this application.

Raw Mean Pixel Feature

The Raw Mean Pixel feature is the mean of the pixels contained in the input mask. This is computed as Raw Intensity of 

pixels. 

Application Example:

 l Estimate the raw average fluorescence activity. This feature is less relevant that the Mean Pixel feature.
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Raw Median Pixel Feature

The Raw Median Pixel feature is the median of the pixels contained in the input mask. 

Application Example:

 l Estimate the raw average fluorescence activity that is robust to outliers. This feature is less relevant than the 

Median Pixel feature. 

Raw Min Pixel Feature

The Raw Min Pixel feature is the smallest value of the pixels contained in the input mask. The example below illustrates 

quantifying the level of malarial infected cells by using Min Pixel values of brightfield imagery.

Application Example:

 l Quantify spectral absorbance using the brightfield image.

 l Identify over compensated images.

 l Measure the level of malaria infection in RBCs.

Saturation Count Feature

The Saturation Count feature reports the number of saturated pixels in an object. For more information, see Saturation Per-

cent Features..
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In the figure below, objects with saturated pixels are lined up at the Raw Max Pixel value of 4095 and a selected image 

is shown with saturated pixels in red. 

Application Example: 

 l Measure the validity of the experiment setup. Saturated data may not produce useful information.

Saturation Percent Features

The Saturation Percent feature reports the percentage of saturated pixels in an image. Pixel intensities are measured on 

the camera pixels from 0 to 4095 (12 bit) and therefore become saturated and cannot be quantified after 4095. For more 

information, see Saturation Count Feature.

An object with saturated pixels shown in red: 

Application Example: 

 l Measure the validity of the experiment setup. Saturated data may not produce useful information.
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Spot Intensity Min and Spot Intensity Max Features

Spot Intensity Min provides the smallest Raw Mean Pixel value (not background subtracted) of the dimmest spot (con-

nected component). The Raw Mean Pixel values for each spot is computed and the smallest value is reported. 

Spot Intensity Max provides the largest Raw Mean Pixel value (not background subtracted) of the brightest spot (con-

nected component). The Raw Mean Pixel values for each spot is computed and the largest value is reported. 

These are two of four features that can be used to identify objects with spots that are  close together, dim, bright or small 

when counting spots in an image. To use these features, the spots need to be individually masked, such as using the Spot 

or Peak Mask. The Spot Area, Distance, and Intensity Min or Max features measure properties of different spots in an 

image and are often used with the Spot Count feature (under Texture). Spot Area Min (Size) provides the area of the 

smallest spot. Spot Distance Min (Location) provides the shortest distance between two spots. For more information, see 

Spot Area Min Feature., see Spot Distance Min Feature, and see Spot Count Feature.

The following diagram illustrates these features:

 l Spot Area Min is the Area of spot 1

 l Spot Distance Min is distance 2 in microns

 l Spot Intensity Max is the Raw Mean Pixel value of spot 2

 l Spot Intensity Min is the Raw Mean Pixel value of spot 3

Application Example:

 l In FISH Spot Counting, these features are used to identify ambiguous spots that are located too close together, 

too dim, to bright or too small to count and can be eliminated from the analysis.

Uncompensated Intensity

The Uncompensated Intensity feature is the sum of the background subtracted pixel values within the masked area of 

the image with no compensation applied. This is the Intensity of the uncompensated image. This feature is calculated in 

INSPIRE™ during acquisition.

Understanding the Comparison Features
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The Comparison features describe the difference of intensity measurements between masks or pixels in different 

images or the same image with different masks. These include Bright Detail Similarity R3, Intensity Concentration Ratio, 

Internalization, and Similarity.

Bright Detail Similarity R3 Feature

The Bright Detail Similarity R3 feature is designed to specifically to compare the small bright image detail of two images 

and can be used to quantify the co-localization of two probes in a defined region, such as that of endosomes. The Bright 

Detail Similarity R3 feature is the log transformed Pearson’s correlation coefficient of the localized bright spots with a 

radius of 3 pixels or less within the masked area in the two input images. Since the bright spots in the two images are 

either correlated (in the same spatial location) or uncorrelated (in different spatial locations), the correlation coefficient 

varies between 0 (uncorrelated) and 1 (perfect correlation), and does not assume negative values. The coefficient is log 

transformed to increase the dynamic range between {0, inf}.

The following figure shows the Bright Detail Similarity R3 graph of two populations, one that has colocalization and one 

that has no colocalization.

The figure below illustrates the process of obtaining the localized bright spots. The bright areas are eroded from the ori-

ginal image and the detail eroded image is subtracted from the original image resulting in the bright detail image.
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The figure below shows the correlation analysis between an image pair.

Application Examples: 

 l Quantify the degree of colocalization between two probes.

 l Track internalization and intracellular trafficking of antibody drug conjugates to either the endosomes or the 

lysosomes.

 l Colocalization of Rituxan and compliment C3b.

 l For more information, see Co-localization Wizard.

Intensity Concentration Ratio Feature

The intensity concentration ratio is defined as the ratio of the intensity inside the first input mask to the intensity of the 

union of the two masks - the higher the score, the greater the concentration of intensity inside the first mask. All pixels 

are background-subtracted. The ratio is invariant to cell size and can accommodate concentrated bright regions and 

small dim spots. The ratio is mapped to a log scale to increase the dynamic range to values between {-inf, inf}. This fea-

ture is a generalization of the Internalization feature.  For more information, see Internalization Feature.
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Application Example:

 l Quantify relative intensity concentrations between different cellular compartments. Internalization is a special 

case of this where the first mask is the internal compartment and the second is the membrane region.

Internalization Feature

The Internalization feature is defined as the ratio of the intensity inside the cell to the intensity of the entire cell. The 

higher the score, the greater the concentration of intensity inside the cell. All pixels are background-subtracted. The user 

must create a mask to define the inside of the cell for this feature. The feature is invariant to cell size and can accom-

modate concentrated bright regions and small dim spots. The ratio is mapped to a log scale to increase the dynamic 

range to values between {-inf, inf}. Internalized cells typically have positive scores while cells with little internalization 

have negative scores. Cells with scores around 0 have a mix of internalization and membrane intensity. 

Composite Images of brightfield and channel 6 are shown for High, Medium, and Low Internalization values.

Application Examples:

 l Quantify internalization when supplied with the internal mask.

 l Quantify the intensity ratio of a region of interest to the whole cell.

 l For more information, see Internalization Wizard.

Similarity Feature

The Similarity feature is the log transformed Pearson’s Correlation Coefficient and is a measure of the degree to which 

two images are linearly correlated within a masked region. 
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The following figure shows two image pairs that are in spatial registry to one another. On the left the NF-kB (green) is 

predominantly located in the cytoplasm of the cell and has a dissimilar distribution compared to the 7-AAD image (red). 

When the intensity of the green is high, the intensity of the red is low and vice versa. The Similarity value for this cell is -

2.067 indicating that the image pair has a high degree of dissimilarity. Analysis of the image pair on the right shows that 

when the intensity of the green is high, the intensity of the red is high and the Similarity value is a high positive number.

Below are examples of cells with varying amounts of similarity between the NFkB image in green and 7-AAD image in 

red shown here as a composite image. The most dissimilar image pairs in the upper left to the most similar image pairs 

in the upper right.

Application Examples: 

 l Quantify translocation.

 l Identify co-polarization of two probes.

 l For more information, see Nuclear Localization Wizard.

XCorr Feature

The XCorr feature is a measure of similarity or 'sameness' between two images - the higher the value, the more similar 

the images. It is robust to intensity variations and relative shifts between the images and is typically used with the com-

bined mask MC.  It is computed using the normalized cross correlation between the two input images. 
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Application Examples:  

 l Used as a mask-independent measure of similarity between two images.

Understanding the System Features

The system features do not require a mask.

Camera Line Number Feature

The Camera Line Number feature returns the camera line number values. This feature is obtained from INSPIRE™.

Application Example:

 l Used in objects per mL feature. 

Camera Timer Feature

The Camera Timer feature returns the camera timer values that are in ticks. This feature is obtained from INSPIRE™.

Application Example:

 l Used in Time feature. 

Flow Speed Feature

The Flow Speed is the calculated flow speed, in mm/sec, of the object. 

The Flow Speed feature is the speed of flow of the cells. It is obtained from INSPIRE™. It should be very consistent across 

all cells in a file.

Application Example:

 l Determine consistency of flow. 

Object Number Feature

The Object Number feature denotes the serial number of a cell in a file. 

Application Example:

 l Reference an object in a file.

Objects/mL Feature

The Objects per mL feature returns the object concentration with respect to local volume. 

Application Example:

 l Monitor the object flow during the run. 

NOTE: Use the statistic Concentration to obtain objects/mL of a population.
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Objects/sec Feature

The Objects per sec feature returns the local  object concentration with respect to time. 

Application Example:

 l Monitor the throughput during a run. 

NOTE: Use the statistic Concentration to obtain objects/ml of a population.

Time Feature

The Time feature returns the camera timer values that are in ticks, converted to secs with a formula. 

Application Example:

 l Obtain the time taken to collect a sample

About Masks

The set of pixels that contains the region of interest is called the mask. In the following picture, the mask consists of the 

set of pixels on the right image that are colored cyan. The cell is represented in the greyscale image on the left. Cal-

culating some feature values, such as the Area value, requires only a mask. Calculating others, such as Intensity value, 

requires a mask and a channel image.

There are three types of masks: Default masks, Combined Masks and Function Masks:

 l Default masks named M01 through M12 are either created in INSPIRE™ during acquisition or created in 

IDEAS® when a .rif file is opened. The default mask used by INSPIRE™ during acquisition (Inspire) is different 

than the default mask created in IDEAS (Default Object) when a .rif file is opened with QI or from an 

ImageStreamX. These masks are stored in the .cif file and cannot be changed by the user. 

Conversion note: Versions of IDEAS prior to 3.0 were using the System function mask with  weight of 5 for the 

default masks which was more permissive and resulted in larger masks. 

Below is an example of the difference between the default masks.

 l Combined masks are created using Boolean logic to combine and subtract masks. For example, the cyto-

plasmic mask is created by taking the brightfield mask and not the morphology mask of the nuclear image.

You can use the Mask Manager to combine masks of different regions or images. The IDEAS application 
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default template provides a combined mask named MC that is the union of the pixels from all channel masks 

and a NMC mask that is everything outside of MC. The following illustration shows two channel masks that are 

combined into one mask, which is shown in the right most panel. 

Below is an example of making a membrane mask using Boolean Logic

 l Function masks are created with user input. There are fourteen types of function masks, Dilate; Erode; Fill; 

Inspire; Intensity; Interface; Morphology; Threshold; Spot; System; Object; Peak; Range; Skeleton; and Valley. 

Each of the functions masks are defined here. 

AdaptiveErode Mask

The AdaptiveErode mask identifies pixels that will form a circle that touch the input boundary with at least a prescribed 

radius threshold. The radius threshold is inversely proportional to the user input. Therefore the larger the input 

threshold value, the smaller the circle radius which will include more pixels and vise versa. The result is an adaptive 

erosion that takes shape into account instead of a strict pixel number erosion.

Application examples:

 l Can be used to identify the head of sperm.

 l Can be used in combination with the default channel mask to mask the cell membrane.

 l Can be used in applications where it is critical to erode a mask based on the shape of the input mask.

Component Mask

Given an input mask with multiple pieces, each piece can be identified as a component based on a selected feature. The 

components can be sorted in ascending or descending order and each ranked order can be chosen as a separate com-

ponent mask. 

Example 1: This object's mask has multiple pieces defined by a LevelSet mask. 
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In this example the area feature is used to define the largest component. The ranking feature is area, sorted descending 

(highest to lowest/ largest to smallest) and the first ranked object is shown, therefore the largest piece. 

 

Example 2: Here is the image that has a mask with multiple pieces. The mask is shown in blue, on the right side image.

Choosing area as the ranking feature, if the “ascending” sorting order is selected, then the components of the mask will 

be sorted from smallest to largest.

 

Selecting rank 1 in conjunction with an ascending sort order and the area ranking feature will return the smallest com-

ponent, as seen on the left side image. Selecting the “descending” sorting order will return the largest component, as 

seen on the right side image.

 

Application Examples
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 l Can be used to identify separate components within a mask

 l Can be used in combination with the Watershed mask to identify an individual cell in a conjugate or dividing 

cell

 l Features may be calculated on individual components, for example analysis of each daughter cell can be used 

to measure asymmetric cell division

From left to right, no mask, watershed mask, component largest area, component second largest area. This is a jurkat 

cell in telophase.

Dilate Mask

The Dilate mask adds the selected number of pixels to all edges of the starting mask. 

Erode Mask

The Erode mask removes the selected number of pixels from all edges of the starting mask.

Fill Mask

The Fill mask fills in any holes in the starting mask.

Inspire Mask

The Inspire mask masks pixels above background and is the mask used during data acquisition in INSPIRE™. This mask 

is available to understand what is being masked during collection and is not generally used for feature calculations. 

NOTE: This mask is new in IDEAS® versions 4.0 or later.
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Intensity Mask

The Intensity mask masks pixels between the lower and upper raw intensity thresholds not background subtracted.  For 

more information, see Threshold Mask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Threshold mask is similar for both images 

whereas the Intensity mask 250+ is quite different, since only a few pixels in the dim image are greater than 250 counts, 

while most of the metaphase plates in the bright image are masked. 

Interface Mask

The interface mask identifies pixels in an object where the object is in contact with a second object. Three input para-

meters are defined. First, the mask of one of the objects (cell of interest). Next, the mask that covers both objects (con-

jugate). A close fitting mask using another function mask such as Object (tight) can be used for the cell of interest mask. 

A brightfield mask can be used for the conjugate. Finally, the width of the interface mask from the contact point towards 

the cell of interest is entered.

Examples are shown below:
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Application Example: 

 l Used to quantify synapses in T cell APC (antigen presenting cell) conjugates.

LevelSet Mask

The LevelSet mask is an extension of the Morphology mask that identifies pixel in non-homogeneous regions into three 

different levels: dim, middle and bright and the combination of all three.  Contour detailed level can be adjusted such that 

the smaller the scale, the finer the image structure identified by the individual levels. This mask is particularly helpful for 

masking complex brightfield images.

Application examples

 l Used to mask bright, medium or dim areas of an object

 l Can be used to get a closely fitting mask (combined option) in lieu of object or morphology masks
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 l Can be used on brightfield and fluorescent channels

Example 1: From left to right, no mask, LevelSet (Bright), LevelSet (Middle), LevelSet (Dim), Level Set (Combined). This is 

an image of a protein aggregate.

Example 2: The mask on the left is showing the LevelSet mask set to Dim with a contour level of 6. On the right, we are 

showing a middle level with a contour detail of 2. 
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Example 3: Image shows the use of LevelSet Mask with dim (first column), middle level (second column), bright (third 

column), and combined masks (forth column) for each cell.

Morphology Mask

The Morphology mask includes all pixels within the outermost image contour. This mask, which is used in fluorescence 

images, is best used for calculating the values of overall shape-based features.
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Object Mask

The Object mask segments images to closely identify the area corresponding to the cell. It is based on the assumption 

that background pixels exhibit high uniformity to each other. This helps distinguish the background from the cell pixels. 

The mask characterizes the background pixels using a set of features and then segments the image by determining all 

the pixels that deviate from the background feature set. The default option is used for the default segmentation masks. 

The tight option uses a different set of features to characterize the background which results in a tighter fit around the 

cell.

Examples are shown below: 

Image       
Object

(default)

Object

(tight)

Application Examples

 l Used to get a close fit around the cellular area (tight option). 

 l Can be used in lieu of the morph mask for applications where the morph is so tight that it provides incomplete 

masking, sometimes splitting cells into two regions, such as a nuclear dye image of cells in anaphase or telo-

phase. 

 l Can be used in lieu of the morphology mask with the Similarity feature when measuring nuclear translocation 

for better separation between untranslocated and translocated cells (tight option). 

 l Used as the default segmentation masks (default option).

Peak Mask

The Peak mask identifies intensity areas from an image that have local maxima (bright) or minima (dark). Initially, the 

peak mask will identify all peaks in the image. To select peaks which have certain brightness, the spot to cell background 

ratio is used. This is the ratio between the spot pixel value to the mean camera background value in the original image. 

Below is an example of the Peak, bright option.
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Application Examples

 l Used with the Spot Count feature to quantify the speckleness of cells.

 l Separate connected spots in a Spot Mask into individual components.

Range Mask

The Range mask provides a capability to select components in an image within a selected size and/or aspect ratio by set-

ting a minimum and maximum area and minimum and maximum aspect ratio. 

To select pixels within a range of intensity values, see Intensity Mask.

Application Examples

 l Use with a Spot Mask to constrain the Spot Count feature to round spots.

 l Use on any other mask that has multiple components to define unwanted objects such as debris, objects that 

are too small or whose shapes are not circular.
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Skeleton Mask

The skeleton mask provides the barebone structure of the object from the starting mask. Two options are available: thin 

or thick skeletons. The thin option produces the condensed shape of the object and typically takes a form of 1-pixel wide 

skeletal line. The thick option is intensity weighted. The thin option is dependent on the shape of starting mask; thick uses 

the pixel intensities and is less sensitive to the shape of the starting mask. The user will need to pay careful attention to 

the starting mask. In the example below the Morphology mask of the image was used as the starting mask for creating 

the skeleton.

Application Examples

 l Thick skeletons can be used with shape-based features such as symmetry to accentuate the shape of an 

object, and provide greater separations.

 l Separate singlets and doublets by computing the area of the thin skeleton mask. We have used the object

(tight) for this case.

 l Nuclear morphology measurements with lobe count feature for cell classification cells.
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Spot Mask

The Spot Mask has two options: bright or dark. The bright option obtains bright regions from an image regardless of the 

intensity differences from one spot to another. The ability to extract bright objects is achieved using an image processing 

step that erodes the image and leaves only the bright areas. The dark option obtains dark regions. The spot to cell back-

ground ratio and minimum and maximum radius are specified by the user. The spot to cell background ratio is the spot 

pixel value divided by the background in the bright detail image. A maximum radius of x and a minimum radius of y 

implies the image contains spots with a thickness less than 2x+1 and greater than 2y+1 pixels.

The figure below illustrates the open residue process. The bright areas are eroded from the original image and the 

detail eroded image is subtracted from the original image resulting in the bright detail image.
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The image pairs below show objects in grayscale next to their corresponding Spot Masks in cyan. Spot masks can be fur-

ther refined using the Peak and/or Range masks. For more information, see Peak Mask. and For more information, see Range 

Mask.

Application Examples

 l Used with the Spot Count feature to enumerate spots in images such as for FISHIS®.

 l Used with Intensity features to quantify intensity in spots.

 l Dark spot finds valleys in images such as the low intensity between 2 stained nuclei and is useful for finding 

immune synapses.

 l Identifies the dark areas in red blood cells or parasitic infections in brightfield imagery.

System Mask

The System mask segments objects in an image based on a probability model of how pixels should be grouped together. 

The user sets a weight value that defines a loose or tight grouping. A low weight value groups in a more permissive man-

ner.

Shown is an example of a cell with a apoptotic bleb that is not masked with the System mask weight set at 5 but is 

masked with the System mask weight set at 2.

Application Example 

 l Used on brightfield images to capture a low contrast areas such as cells that undergo a blebbing process, tails 

of sperm or other low contrast type of structures.
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Threshold Mask

The Threshold mask is used to exclude pixels, based on a percentage of the range of intensity values as defined by the 

starting mask. The user chooses the starting mask when creating the Threshold mask. For more information, see Intensity 

Mask.

In the example below, cell #10678 is bright and cell #11992 is dim. The 50% Threshold mask is similar for both images 

whereas the Intensity mask 250+ is quite different, since only a few pixels in the dim image are greater than 250 counts, 

while most of the metaphase plates in the bright image are masked.

Application Example: 

 l Used with the Area feature to define apoptotic cells in the Apoptosis Wizard.
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Valley Mask

The Valley mask is a rectangular mask that sits between two bright regions in a starting mask, such as between two nuc-

lei. It is constructed by finding the minimum intensity along the skeletal line between these two bright regions. The 

skeletal line is obtained internally using the skeleton (thin) masking, see Skeleton Mask. This minimum intensity identifies 

the intersection between the two objects. The mask is drawn perpendicular to this skeletal like. The length of the valley 

mask rectangle is equal to the minor axis of the object and the width of the mask is defined by the user in pixels.

Application example: 

 l Quantify the intensity of a probe in an immune synapse.
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Watershed Mask

The watershed mask is used to separate a single mask into multiple components. There are several user inputs to optim-

ize the mask. Here is the user interface and following is the detailed explanation with examples.

In image 4587 below, there are two components masked together as one. The watershed mask can be used to “erase” 

part of the mask in between the two components.
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If the “intensity weighted” option is selected, the mask will be computed based on the image intensity values.

The watershed algorithm works by treating the image as a surface map and filling it with “water” from the bottom. 

When the pools of water meet, a border is created. Choose “peaks” or “valleys” to set the orientation of bright and dark 

points. If “valleys” is chosen, low intensities will represent low points and high intensities will represent high points. As 

shown below, this results in poor segmentation for this image.

If “peaks” is chosen, then high intensities are used as the basins and low intensities represent high points. This results in 

much better segmentation for this example image.
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The next adjustable parameter is smoothing. A low amount of smoothing can result in over-segmentation, as seen 

below.

A large smoothing value can also result in poor segmentation results.

A good smoothing value will result in the best segmentation results.
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The final parameter is Line Thickness. This sets the thickness of the dividing line between components.

 

Application Examples

 l Can be used to separate two attached cells based on DNA content, for example cell conjugates or dividing cells

 l Can be used in combination with the component mask to analyze individual cells in conjugates or dividing cells

From left to right, brightfield no mask, DAPI Ch7 no mask, brightfield watershed mask. This a jurkat cell in telophase.

Adding Text to the Analysis Area

To add text to the Analysis Area: 
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1.   Click the Text button on the Analysis Area toolbar.

A text panel is added to the analysis area.

2.    Enter a title and text.

© 2009 - 2019 Luminex Corporation. All rights reserved. No part of this publication may be reproduced, transmitted, 

transcribed, or translated into any language or computer language, in any form or by any means without prior express, 

written consent of Luminex Corporation.

Luminex Corporation (Luminex) reserves the right to modify its products and services at any time. This guide is subject 
to change without notice. Although prepared to ensure accuracy, Luminex assumes no liability for errors or omissions, or 
for any damages resulting from the application or use of this information.

Amnis, FlowSight IDEAS, ImageStream, INSPIRE, and Luminex are trademarks of Luminex Corporation, registered in the 

U.S. and other countries. INSPIRE is a trademark of Luminex Corporation.

All other trademarks, Microsoft and Windows, are trademarks of their respective companies.

 

This product, or use thereof, is covered, in whole or in part, or made by processes covered by one or more patents: 

www.luminexcorp.com/patents.
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